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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 1997-2008 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel®, Intel® Itanium®, Intel® Xeon™, and Pentium® are trademarks or registered trademarks of Intel Corporation 
or its subsidiaries in the United States and other countries.

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, and Windows® XP are U.S. registered trademarks of Microsoft Corporation.

Microsoft Vista® is either a registered trademark or trademark of Microsoft Corporation in the United States and/or 
other countries.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

Software version number, which indicates the software version

Document release date, which changes each time the document is updated

Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to: 
h20230.www2.hp.com/selfsolve/manuals.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.
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Support

You can visit the HP Software Support Web site at hp.com/go/hpsoftwaresupport.

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests

Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: h20230.www2.hp.com/new_access_levels.jsp.

To register for an HP Passport ID, go to: h20229.www2.hp.com/passport-registration.html.
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1 Getting Started with Managing Application 
Change
HP Managing Application Change (MAC) software is a solution for 
supporting Change Management and Release Management within your 
organization. The MAC software provides PPM Center entities that support 
standard Information Technology Infrastructure Library (ITIL) processes and 
that can be configured to meet your business needs. 

MAC software enables you to integrate PPM Center with:

Service desk applications, including:

o HP Service Manager

o HP ServiceCenter

o BMC Remedy Action Request System (referred to as Remedy in this 
guide)

HP Quality Center

HP Release Control

HP Change Control Management

Mercury Application Mapping

You can also integrate PPM Center with HP Universal Configuration 
Management Database (HP Universal CMDB), without installing the MAC 
software. 

These integrations help your IT organization standardize and enforce processes 
that manage application changes throughout the entire software development 
life cycle, including development, testing, and deployment.
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The versions of these products that are supported for integration with PPM 
Center are described in Summary of Supported Integrations and Versions 
on page 20.

Installing MAC provides all of the entities that are used by any combination of 
the integrations you choose to configure and use. 

For information about how to obtain the MAC software and view or print this 
guide, see Overview of Installation and Configuration on page 31.

Introduction to ITIL and HP Managing Application Change

The Information Technology Infrastructure Library (ITIL) offers the world’s 
most widely accepted approach to IT Service Management (ITSM), furthering 
the goal of aligning IT with business goals and priorities. ITIL provides 
frameworks for both the organization of ITSM as well as a cohesive set of 
industry best practices.

ITIL is a process framework, and HP Project and Portfolio Management 
Center (PPM Center) is unique in its ability to customize, automate, and 
digitize processes, simplifying repeatability, enforcement, and measurement.

ITIL defines the Service Support discipline. Building on this advanced-process 
model, HP Managing Application Change (MAC) uses predefined request 
types (forms), workflows, and special commands to automate processes and 
information gathering, and it uses portlets and reports to track key performance 
indicators (KPIs). 

MAC supports the following ITIL processes:

Change Management. Overview of ITIL Change Management on page 17 
provides an overview of the ITIL Change Management process and how 
MAC supports it. Chapter 3, Using MAC Entities, on page 39 describes the 
entities provided by MAC for ITIL Change Management.

Release Management. Overview of ITIL Release Management on page 18 
provides an overview of the ITIL Release Management process and how 
MAC supports it. Chapter 3, Using MAC Entities, on page 39 describes the 
entities provided by MAC for ITIL Release Management.
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MAC can be used as a starting point, and then extended to support the process 
requirements that meet the specific needs of your organization. Using these 
tools, MAC helps enforce repeatable ITIL processes to reduce their operating 
cost and risk.

Chapter 2, Installing and Setting Up MAC Software, on page 31 provides 
instructions for installing MAC and configuring PPM Center to ensure that 
MAC functions properly.

Chapter 3, Using MAC Entities, on page 39 provides information about the 
MAC entities, except for a few that are used only for integration of PPM 
Center with HP Quality Center. 

MAC enables integration of PPM Center with the HP Service Manager, HP 
ServiceCenter, and Remedy service desk applications. Using these 
integrations, service desk application changes can be automatically converted 
to MAC requests for change and imported into PPM Center. In addition, fields 
in PPM Center can be configured to send updates back to the originating 
changes in Service Manager or ServiceCenter. For more information, see:

Versions of Service Desk Applications Supported for Integration with PPM 
Center on page 20

Integration of PPM Center with Service Desk Applications on page 22

Chapter 4, Integration of PPM Center with Service Manager or 
ServiceCenter, on page 99

Chapter 5, Integration of PPM Center with Remedy, on page 147

For additional Change Management and Release Management functionality, 
MAC provides the ability to integrate PPM Center with Mercury Application 
Mapping, with HP Quality Center, and with HP Change Control Management 
or its successor product, HP Release Control. (Also, even without using the 
MAC software, PPM Center can be integrated with HP Universal CMDB, the 
successor product to Mercury Application Mapping.) 

Using these integrations and appropriate approvals throughout the process, the 
MAC - Request for Change workflow (and the MAC subworkflows it calls) 
can:

Use Mercury Application Mapping to perform preliminary impact analysis 
on a proposed change.
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Automatically create HP Quality Center requirements or defects based on 
associated PPM Center requests and keep their fields synchronized, 
providing data visibility in both applications and ensuring that QA 
personnel create and execute appropriate test plans.

When adding a package to a release, provide links in a MAC portlet to 
HP Release Control or HP Change Control Management for that release. 
HP Release Control or HP Change Control Management displays impact 
and collision analysis for the release that is poised for deployment to a 
production (live) system.

For more information about integration of PPM Center with HP Universal 
CMDB, see:

Version of HP Universal CMDB Supported for Integration with PPM 
Center on page 20

Integration of PPM Center with HP Universal CMDB and/or Mercury 
Application Mapping on page 24

Appendix A, Integration of PPM Center with Universal CMDB, 
on page 269 

For more information about integration of PPM Center with Mercury 
Application Mapping, see:

Versions of Mercury Application Mapping Supported for Integration with 
PPM Center on page 21

Integration of PPM Center with HP Universal CMDB and/or Mercury 
Application Mapping on page 24

Chapter 6, Integration of PPM Center with Mercury Application Mapping, 
on page 169

For more information about integration of PPM Center with HP Quality 
Center, see:

Versions of HP Quality Center Supported for Integration with PPM Center 
on page 21

Integration of PPM Center with HP Quality Center on page 25

Chapter 7, Integration of PPM Center with Quality Center, on page 189
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For more information about integration of PPM Center with HP Release 
Control or HP Change Control Management, see:

Versions of HP Release Control and HP Change Control Management 
Supported for Integration with PPM Center on page 21

Integration of PPM Center with HP Release Control or HP Change 
Control Management on page 26

Chapter 8, Integration of PPM Center with Release Control or Change 
Control Management, on page 263

Overview of ITIL Change Management

ITIL defines a change as the addition, modification, or removal of an 
approved, supported, or baselined hardware component, network, software, 
application, environment, system, or desktop build, or associated 
documentation. The primary goal of the ITIL Change Management process is 
to ensure that standardized methods and procedures are used for efficient and 
prompt handling of all changes, in order to minimize the impact of 
change-related incidents upon service quality. Although changes often arise as 
a result of unexpected problems, most changes result from planned requests for 
change (RFCs) from the business or IT organization.

MAC allows users to submit RFCs along a predefined Request For Change 
process toward resolution. Portlets provided with MAC can be added to a 
user’s PPM Dashboard to monitor key performance indicators (KPIs) related 
to the submitted RFCs. Additionally, reports can be run to obtain summaries 
and scheduling details.

Chapter 3, Using MAC Entities, on page 39 discusses the PPM Center entities 
that MAC provides for use in the ITIL Change Management process, 
including:

The Change Management request type, named MAC - Request For Change 
(RFC)

The associated Change Management workflow, named MAC - Request For 
Change 
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Associated Change Management portlets

Associated Change Management reports

These MAC entities simplify each of the supported integrations with PPM 
Center, as introduced in Optional Integrations with PPM Center Enabled by 
MAC on page 20.

Change Management Roles

The following roles play an active part in the ITIL Change Management 
process:

System Owner

Change Manager

CAB group (Change Advisory Board) or CAB/EC group (Change 
Advisory Board – Emergency Committee)

o Change Manager 

o Customer(s) 

o Applications Development Manager

o QA Manager

o Operations Manager (or maintainers where appropriate) 

Change Builder

Independent Tester

Applications Development Manager

In addition to being valuable divisions of responsibility, these roles are used to 
designate user security for the default MAC - Request For Change workflow 
(see MAC - Request For Change Workflow on page 49).
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Overview of ITIL Release Management

ITIL defines a release as a collection of new and/or changed components that 
are tested and introduced into the live (production) environment together. The 
ITIL Release Management process helps to design and implement efficient 
procedures for the distribution and installation of changes. This process 
includes coordinating build and testing activities to help ensure that only the 
authorized and tested versions of changes are implemented in production. 
Ultimately, releasing a change requires:

Developing the change

Designing the change

Testing the change for functionality, quality, and performance

Pushing the change into production

MAC makes it easier for users to collect information for a release using a 
release form, which is submitted along a predefined release management 
process (see MAC - Release Request Workflow on page 83). After the initial 
release process steps have been completed, the release is created and the RFCs 
that are being processed along the MAC - Request For Change workflow (see 
MAC - Request For Change Workflow on page 49) can be added to the release 
in preparation for its deployment to the test and live environments. The release 
management process then moves through testing and deployment steps toward 
completion. Portlets provided with MAC can be added to a user’s PPM 
Dashboard to monitor the status of releases. Additionally, reports can be run to 
obtain release summaries and scheduling details.

Chapter 3, Using MAC Entities, on page 39 discusses the PPM Center entities 
that MAC provides for use in the ITIL Release Management process, 
including:

The Release Management request type, named MAC - Release 
Management

The associated Release Management workflow, named MAC - Release 
Request 

Associated Release Management portlets

Associated Release Management reports
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Release Management Roles

The following roles play an active part in the ITIL Release Management 
process:

Release Manager

Test Manager

Applications Development Manager

Operations Manager

Change Manager

CAB group (Change Advisory Board)

In addition to being valuable divisions of responsibility, these roles are used to 
designate user security for the default MAC - Release Request workflow (see 
MAC - Release Request Workflow on page 83).

Optional Integrations with PPM Center Enabled by MAC

As described in the following sections, PPM Center version 7.5 can be 
integrated with various products to enhance the functionality of PPM Center 
and those products.

Summary of Supported Integrations and Versions

PPM Center version 7.5 SP2 or later can be integrated with various products at 
the versions or releases described in the following sections.

HP strongly recommends that you consult with HP Professional Services before 
implementing any of these integrations.
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Versions of Service Desk Applications Supported for Integration with PPM Center

MAC supports integration of PPM Center with the following service desk 
applications at the following versions:

HP Service Manager 7.00

HP ServiceCenter 6.2.4.1 or later

BMC Remedy Action Request System 5.0 (hereafter referred to as 
Remedy) with Remedy Help Desk

For more information, see Integration of PPM Center with Service Desk 
Applications on page 22.

Version of HP Universal CMDB Supported for Integration with PPM Center

Without installing MAC software, integration of PPM Center with HP 
Universal CMDB is supported for HP Universal CMDB version 7.50.

For more information, see Integration of PPM Center with HP Universal 
CMDB and/or Mercury Application Mapping on page 24.

Versions of Mercury Application Mapping Supported for Integration with PPM Center

MAC supports integration of PPM Center with Mercury Application Mapping 
at the following versions:

6.5

6.6

For more information, see Integration of PPM Center with HP Universal 
CMDB and/or Mercury Application Mapping on page 24.

HP does not support integrating both HP Service Manager and HP ServiceCenter 
with one PPM Center instance. HP does support integrating one PPM Center 
instance with multiple HP Service Manager instances at the same version, or with 
multiple HP ServiceCenter instances at the same version.

Integration of PPM Center with Remedy is supported only when PPM Center and 
Remedy are running on Windows®. For information on the Windows versions that 
PPM Center can use, see the System Requirements and Compatibility Matrix. 
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Versions of HP Quality Center Supported for Integration with PPM Center

MAC supports integration of PPM Center with HP Quality Center at the 
following versions:

9.0 patch 25 or later

9.2 patch 4 or later

For more information, see Integration of PPM Center with HP Quality Center 
on page 25.

Supported Version of the PPM Center-Quality Center Integration Tool

PPM Center-Quality Center Integration Tool version 1.5 is required to 
integrate PPM Center with Quality Center. It is provided with PPM Center 
software.

Versions of HP Release Control and HP Change Control Management Supported for 
Integration with PPM Center

MAC supports integration of PPM Center with:

HP Change Control Management version 3.0

Its successor product, HP Release Control version 4.00

For more information, see Integration of PPM Center with HP Release Control 
or HP Change Control Management on page 26.

Integration of PPM Center with Service Desk Applications 

The entities provided with MAC simplify the integration of PPM Center with 
the HP Service Manager and Remedy service desk applications. These 
integrations provide the following benefits:

Changes that originate in the service desk application can be automatically 
imported into PPM Center as requests that PPM Center manages.

Hereafter in this guide, references to HP Service Manager (the successor product to 
HP ServiceCenter) also apply to supported versions of HP ServiceCenter, except 
where distinctions between Service Manager and ServiceCenter are described as 
needed.
22 Chapter 1



Changes in the HP Service Manager service desk application can be 
automatically updated, based on revisions to requests in PPM Center.

PPM Center acts as a single, comprehensive repository of application 
change requests collected from throughout IT, including change records 
(tickets) from the service desk application.

The MAC software provides configurable adapter files that serve as the 
software interface between PPM Center and the HP Service Manager or 
Remedy service desk application. An adapter file includes filters and field 
mappings to convert changes from one data model to the other.

This guide assumes that one of the service desk applications has been installed 
and is available for integration. 

For a list of documents about the service desk integrations, see HP Service 
Manager Documentation on page 28, HP ServiceCenter Documentation 
on page 28, or Remedy Documentation on page 29.

For detailed information about configuring and using integration of PPM 
Center with a service desk application, including details about configuring 
parameters in the server.conf file, see one of the following chapters: 

Chapter 4, Integration of PPM Center with Service Manager or 
ServiceCenter, on page 99

Chapter 5, Integration of PPM Center with Remedy, on page 147

Any request type you use for a service desk integration must include the fields in the 
Service Desk System Info section of the MAC - Request For Change (RFC) request 
type, as shown in Table 3-2 on page 43, and those fields must be completed. For 
detailed request type field specifications, see the MAC - Request For Change (RFC) 
request type in the PPM Workbench.
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Using Integration of PPM Center with HP Quality Center To Enhance Integration of PPM 
Center with Service Desk Applications

Functionality of integration of PPM Center with a service desk application is 
enhanced if PPM Center and HP Quality Center are also integrated—you can 
see HP Quality Center statuses for an RFC in the service desk application and 
in PPM Center. 

See MAC - Request For Change (RFC) Request Type on page 40 for 
descriptions of the MAC - Request For Change (RFC) request type fields that 
are related to integration of PPM Center with HP Quality Center.

Integration of PPM Center with HP Universal CMDB and/or Mercury 
Application Mapping

PPM Center can be integrated with HP Universal CMDB (which does not 
require installation of the MAC software) and/or with Mercury Application 
Mapping, providing the following benefits:

The Change Advisory Board can use the integration to run an impact 
analysis in HP Universal CMDB or Mercury Application Mapping, and 
forecast the effects that each change request will have on the organization’s 
IT environment. 

The resulting report provides the Change Advisory Board with an 
indication of how the organization’s system will cope with each change if 
it is later developed and deployed, and thus assists the Change Advisory 
Board in deciding whether to approve certain changes for development.

Your system infrastructure, such as servers or applications, might get 
modified while the software change is being developed and evaluated for 
quality. As a result, the original impact analysis for the change might not 
be valid. After the change has been evaluated and approved for 
deployment, you can perform another impact analysis and use the Mercury 
Application Mapping comparison feature to compare the two impact 
analysis reports. You can then see whether the infrastructure change will 
adversely affect the software change that you plan to deploy.

For general information about the benefits of integrating PPM Center and HP Quality 
Center whether or not PPM Center and a service desk application are integrated, see 
Integration of PPM Center with HP Quality Center on page 25. 
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This guide assumes that HP Universal CMDB and Mercury Application 
Mapping have been installed and are available for integration. 

For a list of documents about HP Universal CMDB, see HP Universal CMDB 
Documentation on page 29. For a list of documents about Mercury Application 
Mapping, see Mercury Application Mapping Documentation on page 29. 

For detailed information about configuring and using integration of PPM 
Center with HP Universal CMDB, including details about configuring 
parameters in the server.conf file, see Appendix A, Integration of PPM 
Center with Universal CMDB, on page 269. 

For detailed information about configuring and using integration of PPM 
Center with Mercury Application Mapping, including details about 
configuring parameters in the server.conf file, see Chapter 6, Integration of 
PPM Center with Mercury Application Mapping, on page 169. 

Integration of PPM Center with HP Quality Center

PPM Center can be integrated with HP Quality Center to incorporate the 
quality assurance (QA) process into the change request development process, 
providing the following benefits:

Integration and enforcement of QA testing into the change process. The 
QA process can be initiated when the development process begins, and QA 
planning activities can proceed in parallel with development. The QA 
teams can then spend more time testing changes after development has 
been completed.

Management and tracking of test requirements, plans, and results in HP 
Quality Center, with visibility in PPM Center.

Data sharing between PPM Center and HP Quality Center.

Integrations of PPM Center with both Mercury Application Mapping and its successor 
product, HP Universal CMDB, can coexist without interfering with each other. Data 
obtained from the integration with Mercury Application Mapping is not migrated or 
converted for use by the integration with HP Universal CMDB.
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Automatic activation of HP Quality Center processes by PPM Center. 
Creating a request in PPM Center can create a requirement or defect in HP 
Quality Center.

Automatic ongoing synchronization of defects and requirements in Quality 
Center with requests in PPM Center, as well as hierarchical 
synchronization of requirements in HP Quality Center with requests in 
PPM Center. 

This guide assumes that HP Quality Center has been installed and is available 
for integration. 

For a list of documents about HP Quality Center, see HP Quality Center 
Documentation on page 30.

For detailed information about configuring and using integration of PPM 
Center with HP Quality Center, including details about configuring parameters 
in the server.conf file, see Chapter 7, Integration of PPM Center with 
Quality Center, on page 189. 

Integration of PPM Center with HP Release Control or HP Change Control 
Management 

PPM Center can be integrated with HP Release Control or HP Change Control 
Management to assist IT managers and the Change Advisory Board to:

Assess the business impact of changes that have been developed and tested, 
and decide whether to approve them for deployment. 

Provide information about the components in the organization’s IT 
environment that will be impacted by the developed changes. 

Proactively send notifications of the business risk involved in each change. 

Identify potential conflicts among concurrently scheduled changes. 

Improve visibility over the change deployment process. 
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During the impact analysis phase of the Request For Change lifecycle, if PPM 
Center is integrated with both HP Release Control (or HP Change Control 
Management) and Mercury Application Mapping, the Launch HP Release 
Control button (or the Launch HP Change Control Management button) appears 
on the request. When launched, HP Release Control (or HP Change Control 
Management) provides additional impact analysis that helps users assess and 
approve changes.

For each change request, the MAC - Releases portlet provides a link to log in 
to HP Release Control (or HP Change Control Management), where various 
tabs contain information about the change requests. 

This guide assumes that HP Release Control or HP Change Control 
Management has been installed and is available for integration. 

For a list of documents about HP Release Control, see HP Release Control 
Documentation on page 30. For a list of documents about HP Change Control 
Management, see HP Change Control Management Documentation 
on page 30. 

For detailed information about configuring and using integration of PPM 
Center with HP Release Control or HP Change Control Management, 
including details about configuring parameters in the server.conf file, see 
Chapter 8, Integration of PPM Center with Release Control or Change 
Control Management, on page 263. 
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Related Information

The following sections categorize documentation that may be useful for MAC 
deployments.

PPM Center Documentation

The following PPM Center documents provide information that may be useful 
to you: 

HP Demand Management User’s Guide 

HP Demand Management Configuration Guide (includes information 
about configuring request types and workflows)

Creating Portlets and Modules 

Reports Guide and Reference 

HP Deployment Management User’s Guide 

System Administration Guide and Reference 

HP Service Manager Documentation 

The following HP Service Manager documents are not directly related to PPM 
Center or integrations with it, but they may be useful to you: 

HP Service Manager Installation Guide 

Service Manager Help system

HP ServiceCenter Documentation

The following HP ServiceCenter documents are not directly related to PPM 
Center or integrations with it, but they may be useful to you: 

HP OpenView ServiceCenter Installation Guide 

ServiceCenter Help system
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Remedy Documentation

The following Remedy documents are not directly related to PPM Center or 
integrations with it, but they may be useful to you: 

Remedy Help Desk 5.0 User’s Guide 

HP Universal CMDB Documentation

The following HP Universal CMDB documents are not directly related to PPM 
Center or integrations with it, but they may be useful to you: 

HP Universal CMDB Deployment Guide 

HP Universal CMDB Database Guide 

HP Universal CMDB Discovery and Dependency Mapping 

HP Universal CMDB Model Management 

HP Universal CMDB CI Attribute Customization 

HP Universal CMDB Glossary 

HP Universal CMDB 7.50 Readme

Mercury Application Mapping Documentation

The following Mercury Application Mapping documents are not directly 
related to PPM Center or integrations with it, but they may be useful to you: 

Mercury Application Mapping Installation Guide 

Mercury Application Mapping User’s Guide 

Mercury Application Mapping Administrator’s Guide 
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HP Quality Center Documentation

The following HP Quality Center documents are not directly related to PPM 
Center or integrations with it, but they may be useful to you: 

HP Quality Center Installation Guide 

HP Quality Center User’s Guide 

HP Quality Center Administrator’s Guide 

HP Release Control Documentation

The following HP Release Control documents are not directly related to PPM 
Center or integrations with it, but they may be useful to you: 

HP Release Control Installation and Configuration Guide 

HP Release Control User Guide 

HP Change Control Management Documentation

The following HP Change Control Management documents are not directly 
related to PPM Center or integrations with it, but they may be useful to you: 

HP Change Control Management Installation and Configuration Guide 

HP Change Control Management User’s Guide 
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2 Installing and Setting Up MAC Software
Overview of Installation and Configuration

Installing and setting up MAC software includes the following procedures, as 
described in this chapter:

Installing the MAC software.

Configuring particular MAC-related entities in PPM Center.

Restarting the PPM Server.

Configuration activities that are unique to the integrations with service desk 
applications, HP Quality Center, HP Change Control Management, and 
Mercury Application Mapping are described in their respective chapters.

System Requirements
Before you can install and use HP Managing Application Change version 1.0, 
you must install PPM Center version 7.5.

To use the request types and workflows provided by MAC, verify that you 
have user licenses for PPM Center Demand Management. For information 
about permissions, configuration, and security, see the HP Demand 
Management Configuration Guide and the Security Model Guide and 
Reference. 

If you have upgraded or plan to upgrade PPM Center from version 6.0, 7.0, or 7.1, and 
if Application Change Lifecycle (ACL) products or the IT Service Management (ITSM) 
Accelerator or service desk adapters are also installed on your PPM Server, contact 
HP Professional Services for assistance in implementing MAC.
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Installing HP Managing Application Change

Install HP Managing Application Change as described in the following 
sections. 

General Preparations for Installation or Upgrade

To prepare for installation:

1. Obtain the MAC software.

2. Log on to the PPM Server.

3. Confirm that the system requirements have been met; see System 
Requirements on page 31.

4. Save the MAC installation file (mitg-750-MAC.jar) to the <PPM_Home> 
directory. <PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/PPMServer.

Perform Backup and Restart the PPM Server in Restricted Mode

The steps in this section are recommended but not required. 

Before installation:

1. Back up the database and file system for the PPM Server.

2. Stop the PPM Server and restart it in restricted mode (for more information 
about the steps in this procedure, see the System Administration Guide and 
Reference):

a. Stop the PPM Server.

b. Run the script: 

sh ./setServerMode.sh RESTRICTED

c. Start the PPM Server.

You do not need to unpack the installation file. The installation process 
automatically unpacks it.
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Run the Installation Script

To run the installation script to install the MAC software:

1. Navigate to the <PPM_Home>/bin directory.

2. Run the script:

sh ./kDeploy.sh -i MAC

3. As kDeploy.sh runs, respond to its prompts.

When the installation completes successfully, the following message is 
displayed:

Deployment MAC has been successfully installed.

The following sections in this chapter describe initial configuration of MAC.

Configuring MAC-Related Entities in PPM Center

After installing MAC software, perform the procedures described in the 
following sections.

Creating Contact User Data

You must create a global user data field of type Contact User Data, whether or 
not you will be establishing any of the integrations of PPM Center with other 
applications. Table 2-1 describes the important parameters for this field. 
Figure 2-1 shows the User Data Context window.

In the PPM Workbench, select Configuration > User Data and select Contact 
User Data to access this window. For more information about creating user 
data, see the HP Demand Management Configuration Guide. 
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Figure 2-1. Contact user data field

Table 2-1. Contact user data field parameters

Field Name Value

Prompt Location:

Token LOCATION

User Data Column USER_DATA1

Displayed Y

Component Type Text Field

Validation (any text field of reasonable length)
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Configuring the CRT - Priority - Enabled Validation

You must add the values listed in Table 2-2 to the CRT - Priority - Enabled 
validation, whether or not you will be establishing any of the integrations of 
PPM Center with other applications. Figure 2-2 shows the Validation window.

In the PPM Workbench, select Configuration > Validations and select 
CRT - Priority - Enabled to access this window. For more information about 
modifying validations, see the Commands, Tokens, and Validations Guide and 
Reference. 

Figure 2-2. CRT - Priority - Enabled validation

Table 2-2. Values to add to CRT - Priority - Enabled validation

Code Meaning

MEDIUM Medium

IMMEDIATE Immediate

PLANNING Planning
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Assigning Users to MAC Security Groups

MAC provides the following security groups:

MAC - Application Developer

MAC - Applications Development Manager

MAC - CAB group (Change Advisory Board)

MAC - Change Builder

MAC - Change Manager

MAC - Customer

MAC - IT Executive Board

MAC - Independent Tester

MAC - Operations Manager

MAC - QA Manager

MAC - Release Manager

MAC - SOX - System Owner

Users must belong to an appropriate security group to be able to see particular 
portlets. Add users to these security groups, whether or not you will be 
establishing any of the integrations of PPM Center with other applications. In 
the PPM Workbench, select Sys Admin > Users, open a user, and click the 
Security Groups tab. For more information about security groups, see the 
Security Model Guide and Reference. 
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Assigning Security Groups to MAC Workflows

MAC provides several workflows. The major ones are described in detail in 
this document. Assign security groups to each workflow step in the manner 
that best meets your business needs, whether or not you will be establishing 
any of the integrations of PPM Center with other applications. In the PPM 
Workbench, select Configuration > Workflows, open a workflow, and edit it. 
For more information about configuring security groups in workflows, see the 
HP Demand Management Configuration Guide. 

Restarting the PPM Server in Normal Mode

After you have completed all installation and configuration procedures, if you 
previously restarted the PPM Server in restricted mode, stop and restart it in 
normal mode (for more information about the steps in this procedure, see the 
System Administration Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./setServerMode.sh NORMAL

3. Start the PPM Server.

For More Information

MAC provides request types, workflows, portlets, and reports that can be 
configured to fit your business needs. For detailed information, see Chapter 3, 
Using MAC Entities, on page 39.

You can use the MAC entities whether or not you establish any of the 
supported integrations of PPM Center with other applications. You can 
configure those integrations at any time after you have installed and configured 
MAC as described in this chapter. For more information, see Optional 
Integrations with PPM Center Enabled by MAC on page 20 and the 
integration-related chapters to which that section refers.
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3 Using MAC Entities
Overview of MAC Entities

This chapter describes the request types, workflows, portlets, reports, and 
special commands (the “entities”) provided in MAC to facilitate 
implementation of ITIL processes. Some of these entities are also used by the 
integrations with external service desk applications and other HP products. 

The MAC entities provided for change management are described first, then 
the entities for release management are described, and then the special 
commands.

Several MAC entities that are used only for integrations of PPM Center with 
HP Quality Center are described in Chapter 7, Integration of PPM Center with 
Quality Center, on page 189.
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For More Information

The request types, workflows, portlets, reports, and special commands 
provided with MAC can be configured to fit your business needs. Table 3-1 
lists the types of entities and the associated PPM Center guides to which you 
should refer for configuration information. 

MAC - Request For Change (RFC) Request Type

In its implementation of the ITIL Change Management process, MAC uses the 
MAC - Request For Change (RFC) request type and sends an RFC request 
along the MAC - Request For Change workflow (see MAC - Request For 
Change Workflow on page 49).

Figure 3-1 and Figure 3-2 show the top and bottom of the Create New 
MAC - Request For Change (RFC) page that appears when you create a 
request and select the MAC - Request For Change (RFC) request type. 
Table 3-2 on page 43 describes the fields in the MAC - Request For Change 
(RFC) request, including some fields that do not appear until the request is 
created or until other conditions are met.

Table 3-1. PPM Center entities and associated configuration guides

Entity Configuration Guide

Request type HP Demand Management Configuration Guide 

Workflow HP Demand Management Configuration Guide 

Portlet Creating Portlets and Modules 

Report Reports Guide and Reference 

Special command Commands, Tokens, and Validations Guide and Reference 
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Figure 3-1. Top of MAC - Request For Change (RFC) request
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Figure 3-2. Bottom of MAC - Request For Change (RFC) request
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Table 3-2. MAC - Request For Change (RFC) request fields (page 1 of 6)

Field Name (*Required) Description

RFC Summary section

RFC ID (Added after the RFC is created.) The number of the 
RFC.

Created By The user who created the RFC.

Created On (Added after the RFC is created.) The date the RFC was 
created.

RFC Status The status of the RFC.

*Contact Name The name of the person proposing the change.

Contact Phone The telephone number of the person proposing the 
change.

RFC Priority The priority of the change request; determined by a 
combination of Urgency and Impact.

Contact Email The email address of the RFC contact person.

Contact Location The location of the person proposing the change.

*RFC Summary A summary description of the RFC request.

Expected Start Date
(Added after the RFC is created and assigned to a 
developer.) The expected start date for work on the 
RFC.

Expected Finish Date (Added after the RFC is created and assigned to a 
developer.) The expected end date for work on the RFC.

Assigned Developer
(Added after the RFC is created and assigned to a 
developer.) The developer assigned to work on the 
RFC.

Release ID (Added after the change is released.) The number of the 
release if the change was released.

MAM Impact Analysis section a

Last Impact Analysis 
Report Severity

The highest severity among the CIs in the most recent 
Impact Analysis Report.
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RFC Details section

*RFC Source The source of the RFC request (for example, from a 
problem or incident).

*Urgency The urgency of the change request (for example, from 
problem urgency)

*Impact The business impact of doing or not doing the change 
(for example, from problem impact).

*Reason For Change The reason for the change.

Category The change category; based on the scope of the 
change. 

RFC Type The type of change being requested.

Service The IT service that needs this change.

Change Item

(Appears to be a separate section in the interface.)
Expand to display a table of change items.
If the RFC has been created, click the Modify Table 
button to add a change item. The table consolidates 
existing change items (CIs) with an automatically 
assigned sequence number (Seq), a CI Type 
(Software, Hardware, or Network), a CI Name, and a 
CI Description. 

*Effect of no change The effect of not implementing the change.

RFC Description The description of the change request.

Authorized By (Added after the RFC is created and assigned to a 
developer.) The person who authorized the change.

Authorization Date (Added after the RFC is created and assigned to a 
developer.) The date the developer was assigned.

Table 3-2. MAC - Request For Change (RFC) request fields (page 2 of 6)

Field Name (*Required) Description
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SOX Information section 

*System The system that is impacted by the change.

SOX - In Scope System
SOX requirement: SOX oversight is required for any 
application that directly or indirectly affects financial 
reporting.

SOX Risk

SOX requirement: Risk is determined as part of SOX 
oversight.
Note: A change to a non-SOX system could be high-risk 
based on possible infrastructure/network impact.

System Owner (Added after the RFC is created.) The owner of the 
system.

Impact & Resource Assessment section

Impact Assessment 
Summary

The risk assessment of the impact of the change on 
related components in the configuration management 
database (CMDB).

Impact Assessment 
Report

Enables the user to attach the impact assessment report 
directly to the RFC.

Expected Duration The expected duration for creation of the change.

Expected Effort The expected effort for creation of the change.

Expected Cost The expected cost of the change.

Backout Plan Enables the user to attach the backout plan document 
directly to the RFC.

CAB Recommendations CAB recommendations, where appropriate.

Users Impacted The users expected to be impacted by the change.

Table 3-2. MAC - Request For Change (RFC) request fields (page 3 of 6)

Field Name (*Required) Description
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Implementation Details section

Actual Start Date The actual start date for creation of the change.

Actual Finish Date The actual finish date for creation of the change.

Actual Duration The actual duration for creation of the change.

Actual Effort The actual effort expended during creation of the 
change.

Assigned Change 
Builder The details of the change builder/implementer.

Actual Cost The actual cost of the change.

Functional 
Specifications

Enables the user to attach the functional specification 
document directly to the RFC.

Design Specifications Enables the user to attach the design specification 
document directly to the RFC.

QA Details section

Assigned Tester The person assigned to test the change.

Test Plan Enables the user to attach the test plan directly to the 
RFC.

Detailed Test Results 
(SOX)

Enables the user to attach the detailed test results 
directly to the RFC.

Quality Center Info section b

Quality Center Instance The Quality Center instance that will receive the new 
PPM Center request.

Quality Center Domain The Quality Center domain of the working project.

Quality Center Project The Quality Center project that is linked with this 
request.

Quality Center Assigned 
To User The user assigned to the Quality Center requirement.

Table 3-2. MAC - Request For Change (RFC) request fields (page 4 of 6)

Field Name (*Required) Description
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Quality Center 
Requirement No. The Quality Center requirement number.

Quality Center Status The Quality Center requirement status.

Quality Center Message (Read only) Message indicating whether the last update 
to the request was successful in Quality Center.

Quality Center 
Attachments The URL of the attached requirement document.

Service Desk System Info section c

System Name The name of the service desk application.

Ticket Id The ticket ID in the service desk application.

Ticket Creation Date The ticket creation date in the service desk application.

Ticket Info The ticket info from the service desk application.

Ticket Priority The ticket priority in the service desk application.

Ticket Last Update The date the ticket was last updated in the service desk 
application.

Review Summary section

Review Date The review date for the change.

Review Summary The summary of the review for the change.

Impact Analysis d

Configuration Items 
Selection

Value in parentheses is the number of CIs selected after 
use of the CI Selection button.

CI Selection button

(Enabled when PPM Center and Application Mapping 
are integrated, and the request status is Ready for 
Impact Analysis.) 
Opens a window to select CIs.

Table 3-2. MAC - Request For Change (RFC) request fields (page 5 of 6)

Field Name (*Required) Description
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To submit a MAC - Request For Change (RFC) request:

1. Log on to PPM Center.

2. From the menu bar, select Demand Management > Create a Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
MAC - Request For Change (RFC) and click Create. 

The Create New MAC - Request For Change (RFC) page appears, 
displaying the appropriate RFC fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 

Launch HP Change 
Control Management 
button

(Appears if the CCM_MACHINE_URL parameter in the 
server.conf file is specified.) 
Opens the RFC in HP Change Control Management 
using the specified URL if PPM Center and HP Change 
Control Management are integrated.

a. The MAM Impact Analysis section (near the top of the request) is visible only if the MAM Impact 
Analysis field group is enabled in the request type. Data is presented for the MAM Impact Result 
field in this section only if PPM Center is integrated with Mercury Application Mapping.

b. Fields in the Quality Center Info section remain visible by default but are not used if PPM Center is 
not integrated with HP Quality Center.

c. Fields in the Service Desk System Info section remain visible by default but are not used if PPM 
Center is not integrated with a service desk system. However, when this request type (or any other 
request type) is used for a service desk integration, these fields are required.

d. Impact Analysis (near the bottom of the request) appears only if the MAM Impact Analysis field 
group is enabled in the request type and the request has been submitted. These fields are laid out 
as a section, however, unlike the other sections in the request type, they are not configurable in the 
PPM Workbench.

Table 3-2. MAC - Request For Change (RFC) request fields (page 6 of 6)

Field Name (*Required) Description

The administrator can remove the MAM Impact Analysis section or the Quality 
Center Info section from the request type by removing the MAM Impact Analysis field 
group or the Quality Center Info field group, respectively, from the MAC - Request for 
Change (RFC) Header request header type. 
See the HP Demand Management Configuration Guide for details about request 
header types and field groups.
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concerning a specific field, click the Help icon next to the field (if 
available). 

4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the RFC can be entered and stored. Typically, when creating an RFC, you 
do not need to add a note to it. However, add a note if you want to convey 
additional information to the reviewers and processors of the RFC.

In the References section, add any references to the request. It can be 
useful to reference a Web-accessible file or attach a document or file from 
a local machine to the RFC. Additionally, other entities such as packages, 
releases, or other related requests may be automatically referenced based 
on the workflow steps that have been executed. For more information 
about adding references, see the HP Demand Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The RFC is submitted. The Request Creation Confirmed page appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
see the detail page of the newly generated RFC. 

When the RFC is submitted, it is assigned an initial status, such as New. It 
is then routed along the MAC - Request For Change workflow (see 
MAC - Request For Change Workflow).

MAC - Request For Change Workflow
The MAC - Request For Change workflow is the sequence of approvals, 
decisions, or actions by which the RFC is processed. The RFC starts at the 
beginning of the workflow; when it reaches the end of the workflow, its 
lifecycle is complete. 

Upon creation, a MAC - Request For Change (RFC) request is automatically 
set to use the MAC - Request For Change workflow.

PPM Center can be configured to allow you to save the request before it is 
submitted. To have this feature enabled, see your application administrator.
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Figure 3-3 shows the workflow. Table 3-3 lists the important steps in the 
workflow and the user roles associated with each.

Figure 3-3. MAC - Request For Change workflow
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Table 3-3. MAC - Request For Change workflow steps (page 1 of 3)

Step User Security Description

1. Filter Request MAC - Change 
Manager

Initial review and classification of the 
change request; determine if this RFC is 
acceptable based on company policy.

4. SOX - In 
Scope System?

Fully automated 
step

SOX requires identification of key systems 
related to accurate financial reporting, 
directly or indirectly. This field is 
automatically determined based on the 
system selected.

3. SOX - Impact 
Assessment

MAC - SOX - 
System Owner

SOX requires additional impact assessment 
for any change that could affect financial 
reporting. The impact of not doing the 
change must be considered as well.

6. Allocate 
Priority

MAC - Change 
Manager

Validate RFC priority and determine if this is 
an Urgent Change request.

5. Urgent/
Emergency 
Changes

(None)

Call a subworkflow designed to handle 
urgent or emergency changes, described in 
MAC - RFC - Urgent Change Management 
Sub WF Subworkflow on page 55.

8. Change 
Review and 
Approval Sub WF

MAC - Change 
Manager

Call a subworkflow to manage the review 
and approval process for the RFC, 
described in MAC - Change Review and 
Approval Sub WF Subworkflow on page 56. 
(This subworkflow can, in turn, call the 
MAC - Impact & Resource Assessment 
Sub WF subworkflow.) 

7. Authorize & 
Schedule 
Change

MAC - Change 
Manager

Authorize the change request and schedule 
change for implementation.

11. Application 
Change ?

MAC - Change 
Manager Determine if this is an application change.

13. Infrastructure 
Changes Sub WF (None)

Call a subworkflow to handle 
non-application changes, described in 
MAC - Infrastructure Changes Sub WF 
Subworkflow on page 60. 
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12. Detailed 
Design

MAC - 
Application 
Developer

Create functional and design specification 
documents.

14. Build 
Application 
Change

MAC - 
Application 
Developer

Build application code for the change.

15. Create 
Package

MAC - 
Application 
Developer

Create a package with the code changes.
This step automatically creates a package 
and adds it as a reference to the RFC 
request. Figure 3-4 on page 54 illustrates a 
typical RFC package.

17. Plan Tests 
Sub WF (None)

Call a subworkflow to manage the test 
planning process for the RFC, described in 
MAC - Plan Tests Sub WF Subworkflow 
on page 61.

20. Build MAC - Change 
Builder

Build the change, in preparation for 
implementation. For an application change, 
add code components to the referenced 
package in the PPM Workbench (see the 
Create Package step).

21. Release 
Decision

MAC- Change 
Builder

Select whether this application change 
should be implemented as part of a release 
or independently.

22. Deploy and 
Test Changes 
Sub WF

(None)

Call a subworkflow for deploying and testing 
changes, described in MAC - Deploy and 
Test Changes Sub WF Subworkflow 
on page 63.

23. Non Release 
Sub WF (None)

Call a subworkflow for change deployment 
not involving a release, described in 
MAC - Non Release Sub WF Subworkflow 
on page 64.

24. Release 
Sub WF (None)

Call a subworkflow for change deployment 
involving a release, described in 
MAC - Release Sub WF Subworkflow 
on page 66.

Table 3-3. MAC - Request For Change workflow steps (page 2 of 3)

Step User Security Description
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25. Change 
Working?

MAC - Change 
Manager

Review whether the change was 
successfully implemented with no adverse 
impact.

26. Implement 
Backout Plans

MAC - 
Operations 
Manager

If the change is not working, implement 
backout plans to back out the change from 
the LIVE environment.

27. Requestor 
Sign-Off

MAC - Change 
Manager

Get sign-off from the requestor of the 
change to acknowledge that the change 
was implemented.

28. Post 
Implementation 
Review

MAC - Change 
Manager

Review the change after implementation to 
determine whether the change process was 
followed correctly.

29. Close 
(Immediate 
Success) - 100%

(None) Update status to Closed. 

31. Delete Impact 
Analysis RFC

MAC - Change 
Manager

Tell Mercury Application Mapping to delete 
the redundant RFCs it created in Mercury 
Application Mapping each time the status of 
the PPM Center request became Ready for 
Impact Analysis.

Table 3-3. MAC - Request For Change workflow steps (page 3 of 3)

Step User Security Description
Using MAC Entities 53



Step 15 in the MAC - Request for Change workflow creates a package to 
deploy and test changes, and it adds the package as a reference to the RFC 
request. This package requires specifying a workflow, and the default is the 
MAC - Change Migration workflow, as shown in the example in Figure 3-4. 
Step 22 in the MAC - Request for Change workflow calls the MAC - Deploy 
and Test Changes Sub WF subworkflow to deploy and test the package.

Figure 3-4. Package created for MAC - Request For Change workflow
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MAC - RFC - Urgent Change Management Sub WF Subworkflow
MAC provides an “Urgent Change” process. If a change is categorized as 
Urgent, the RFC is routed along the Urgent Change process. The 
MAC - RFC - Urgent Change Management Sub WF subworkflow is designed 
to efficiently handle impact assessment, prioritization, and creation of the 
change. Figure 3-5 shows the subworkflow.

Figure 3-5. MAC - RFC - Urgent Change Management Sub WF subworkflow
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MAC - Change Review and Approval Sub WF Subworkflow

The MAC - Change Review and Approval Sub WF subworkflow provides a 
modular review and approval process for the RFC. Figure 3-6 shows the 
subworkflow. Table 3-4 lists the important steps in the subworkflow and the 
user roles associated with each.

Figure 3-6. MAC - Change Review and Approval Sub WF subworkflow
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Table 3-4. MAC - Change Review and Approval Sub WF subworkflow steps

Step User Security Description

1. Categorize 
Change

MAC - Change 
Manager

Categorize the change to determine the next 
step in the workflow.

2. Create 
Project 
Proposal

MAC - CAB 
group (Change 
Advisory Board)

If the change is classified as “Major,” create a 
project proposal that includes impact.

3. IT 
Executive 
Board

MAC - IT 
Executive Board

If the change is classified as “Major,” an IT 
Executive Board is responsible for approving 
the change.

4. Impact & 
Resource 
Assessment 
Sub WF

(None)

If the change is classified as “Significant,” call a 
subworkflow to determine the impact on 
dependent infrastructure components and 
estimate the time and cost of resources, as 
described in MAC - Impact & Resource 
Assessment Sub WF Subworkflow on page 58.

5. CAB 
approval

MAC - CAB 
group (Change 
Advisory Board)

Iterative review by CAB members, resulting in 
an authorization go/no go decision (includes 
change priority, schedule, impact, and cost). 

6. Standard 
Sub WF (None) Call a subworkflow to track standard changes.
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MAC - Impact & Resource Assessment Sub WF Subworkflow

The MAC - Impact & Resource Assessment Sub WF subworkflow provides a 
modular process for assessing change impact and planning resource usage. 
Figure 3-7 shows the MAC - Impact & Resource Assessment Sub WF 
subworkflow. Table 3-5 lists the important steps in the subworkflow and the 
user roles associated with each.

Figure 3-7. MAC - Impact & Resource Assessment Sub WF subworkflow
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Table 3-5. MAC - Impact & Resource Assessment Sub WF subworkflow steps

Step User Security Description

1. Resource 
Assessment

MAC - Change 
Manager Estimate time and cost of resources.

2. Impact 
Analysis Mode

MAC - Change 
Manager

Determine the method of impact analysis, 
either automatic through Mercury Application 
Mapping or manual.

3. Select CIs MAC - Change 
Manager

The user selects the configuration items (CIs) 
that will be part of the change.

4. Run Impact 
Analysis

MAC - Change 
Manager

Run Impact Analysis on the CIs that were 
selected in the Select CIs step.

7. Impact 
Analysis 
Failure

MAC - Change 
Manager

Notes any error that occurs while submitting 
the Impact Analysis report in the Mercury 
Application Mapping server.

5. Review 
Impact 
Analysis

MAC - Change 
Manager

Review of the request, the list of selected CIs, 
and the Impact Analysis reports. The user can 
either finally approve the change based on the 
impact report or reject the change. In addition, 
the user can compare different Impact 
Analysis reports.

6. Impact 
Assessment

MAC - Change 
Manager

Manual impact analysis process for the 
requested change.
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MAC - Infrastructure Changes Sub WF Subworkflow

If an authorized request for change is not an application change, the 
MAC - Request for Change workflow calls the MAC - Infrastructure Changes 
Sub WF subworkflow to manage the approval and deployment of changes to 
TEST and LIVE environments. Figure 3-8 shows this subworkflow. 

Figure 3-8. MAC - Infrastructure Changes Sub WF subworkflow
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MAC - Plan Tests Sub WF Subworkflow

The MAC - Plan Tests Sub WF subworkflow provides a modular process for 
planning tests that can communicate automatically with Quality Center. If no 
integration exists, a manual process is also provided. Figure 3-9 shows the 
subworkflow. Table 3-6 lists the important steps in the subworkflow and the 
user roles associated with each.

Figure 3-9. MAC - Plan Tests Sub WF subworkflow
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Table 3-6. MAC - Plan Tests Sub WF subworkflow steps

Step Name User Security Description

1. Quality 
Process Mode

MAC - QA 
Manager

Determine the method of test planning, either 
automatic through Quality Center, or manual.

4. Quality 
Process Entry

MAC - QA 
Manager

The quality process entry needs to be 
approved for integration of PPM Center with 
Quality Center.

5. Generate 
Requirement in 
Quality Center

MAC - QA 
Manager

Automated step that generates a requirement 
in Quality Center.

7. Quality Center 
Requirements 
Setup

MAC - QA 
Manager

QA to complete requirement setup in Quality 
Center.

8. Quality Center 
Test Plan Setup

MAC - QA 
Manager

QA to complete test plan setup in Quality 
Center.

9. Quality Center 
Test Lab Setup

MAC - 
Independent 
Tester

QA to complete test lab setup in Quality 
Center.

2. QC 
Requirements

MAC - QA 
Manager Create test requirements in Quality Center.

3. Create Tests MAC - QA 
Manager Create test plans in Quality Center.
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MAC - Deploy and Test Changes Sub WF Subworkflow

The MAC - Deploy and Test Changes Sub WF subworkflow provides a 
modular process for deploying and testing changes. The process can 
communicate automatically with Quality Center. If no integration exists, a 
manual process is also provided. Figure 3-10 shows the subworkflow. 
Table 3-7 lists the important steps in the subworkflow and the user roles 
associated with each.

Figure 3-10. MAC - Deploy and Test Changes Sub WF subworkflow
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Table 3-7. MAC - Deploy and Test Changes Sub WF subworkflow steps

Step Name User Security Description

1. Approve 
changes to TEST

MAC - 
Change 
Manager

Approve deployment of changes to the TEST 
environment.

2. Deploy 
Changes to TEST

MAC - 
Change 
Manager

Deploy changes to the TEST environment.

3. Quality 
Process Mode

MAC - QA 
Manager

Determine the method of testing, either 
automatic through Quality Center or manual.

5. Quality Center 
Test Execution

MAC - 
Independent 
Tester

Quality Center tests the changes in a TEST 
environment.

7. Evaluate 
Quality

MAC - QA 
Manager

After test execution (manual or using Quality 
Center), evaluate quality.

8. Impact & 
Resource 
Assessment 
Sub WF

(None)

Call a subworkflow to determine the impact of 
the changes that will be deployed, as 
described in MAC - Impact & Resource 
Assessment Sub WF Subworkflow 
on page 58.

9. Approve 
changes to LIVE

MAC - 
Change 
Manager

Approve deployment of changes to the LIVE 
environment.

10. Deploy 
Changes to LIVE

MAC - 
Change 
Manager

Deploy changes to the LIVE environment.

11. Quality 
Process Mode

MAC - QA 
Manager Initiate sanity tests in Quality Center.

12. Running 
Sanity Tests in 
Quality Center

MAC - QA 
Manager Run sanity tests in Quality Center.
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MAC - Non Release Sub WF Subworkflow

The MAC - Non Release Sub WF subworkflow provides a modular process for 
change deployment that can communicate automatically with Quality Center. 
If no integration exists, a manual process is also provided. Figure 3-11 shows 
the subworkflow. Table 3-8 lists the important steps in the subworkflow and 
the user roles associated with each.

Figure 3-11. MAC - Non Release Sub WF subworkflow
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Table 3-8. MAC - Non Release Sub WF subworkflow steps

Step Name User Security Description

1. Approve 
Deployment to 
TEST

MAC - 
Change 
Manager

Coordinate the change implementation to the 
test environment.

4. Quality 
Process Mode

MAC - QA 
Manager

Determine the quality process mode, either 
automatic through Quality Center or manual.

5. Run Tests
MAC - 
Independent 
Tester

If manual mode is chosen in the Quality 
Process Mode step, the changes need to be 
manually tested based on test plans.

6. Quality Center 
Test Execution

MAC - 
Independent 
Tester

If Quality Center mode is chosen in the Quality 
Process Mode step, once QA signals through 
Quality Center that Test execution is complete, 
this step moves the workflow ahead.

8. Evaluate 
Quality

MAC - QA 
Manager

Approve/reject the quality of the change 
deployed to the test environment.

9. Impact & 
Resource 
Assessment 
Sub WF

(None)

Call a subworkflow to determine the impact on 
dependent infrastructure components and 
estimate the time and cost of resources, as 
described in MAC - Impact & Resource 
Assessment Sub WF Subworkflow 
on page 58.

15. Rework 
Change

MAC - 
Applications 
Development 
Manager

If the quality of the change deployed to the test 
environment is rejected, the change must be 
fixed.

10. Approve 
Deployment to 
LIVE

MAC - 
Change 
Manager

Coordinate the change implementation to the 
production environment. 

14. Running 
Sanity Tests in 
Quality Center

MAC - 
Independent 
Tester

Run sanity tests in Quality Center.
66 Chapter 3



MAC - Release Sub WF Subworkflow

The MAC - Release Sub WF subworkflow is called in order to add a change 
into an existing release. It can be called multiple times, once for each change to 
be added to the release. Once a release is specified as Completed, no new 
changes can be added to that release. (For information about creating a new 
release, see MAC - Release Management Request Type on page 77.)

Figure 3-12. MAC - Release Sub WF subworkflow

MAC - Defect Template with Quality Center Integration Request 
Type and Workflow

The MAC - Defect Template with Quality Center Integration request type and 
the associated MAC - Defect Template with Quality Center Integration 
workflow are the only MAC entities that can be used only when a particular 
integration (with Quality Center, in this case) is established. These MAC 
entities are described in Chapter 7, Integration of PPM Center with Quality 
Center, on page 189.
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MAC - Change Migration Workflow

The MAC - Change Migration workflow is used to migrate changes from the 
DEV environment to the TEST environment and from the TEST environment 
to the LIVE environment. It is the default workflow used in step 15 of the 
MAC - Request For Change workflow to create a package. See MAC - Request 
For Change Workflow on page 49.

Figure 3-13. MAC - Change Migration workflow
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Change Management Portlets to Display KPIs

MAC provides several portlets that can be added to your PPM Dashboard to 
provide real-time views into several key performance indicators (KPIs). 

For information about adding portlets to your PPM Dashboard, see the Getting 
Started guide.

MAC - My RFCs Portlet

The MAC - My RFCs portlet is provided to users with the role of Change 
Manager. It lists RFCs that have been created by or assigned to the logged-on 
user. 

Table 3-9 describes the filter fields for the portlet.

Figure 3-14 shows an example MAC - My RFCs portlet. 

Figure 3-14. MAC - My RFCs portlet

Table 3-9. MAC - My RFCs portlet filter fields

Field Name Description

Request Type (Read-only) Preset to MAC - Request For Change (RFC). 

Category The category of the RFC.
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MAC - Open RFCs Portlet

The MAC - Open RFCs portlet is provided to users with the role of Change 
Manager. It lists RFCs that are currently being worked on. 

Table 3-10 describes the filter fields for the portlet.

Figure 3-15 shows an example MAC - Open RFCs portlet. 

Figure 3-15. MAC - Open RFCs portlet

Table 3-10. MAC - Open RFCs portlet filter fields

Field Name Description

Request Type (Read-only) Preset to MAC - Request For Change (RFC). 

Assigned To The user the RFC is assigned to.

Category The category of the RFC.
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MAC - RFCs By Category Portlet

This portlet is provided to users with the role of Change Manager. It displays a 
pie chart showing the percentage of RFCs in each category. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
MAC - Request For Change (RFC). 

Figure 3-16 shows the MAC - RFCs By Category portlet.

Clicking the pie chart drills down to a list portlet.

Figure 3-16. MAC - RFCs By Category portlet
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MAC - RFCs By Reason for Change Portlet

The MAC - RFCs By Reason for Change portlet is provided to users with the 
role of Change Manager. It displays a pie chart showing the percentage of 
RFCs by each type of change being considered (for example, new feature, 
enhancement, or defect fix). 

Table 3-11 describes the filter fields for the portlet.

Figure 3-17 shows an example MAC - RFCs By Reason for Change portlet. 

Clicking the pie chart drills down to a list portlet.

Figure 3-17. MAC - RFCs By Reason for Change portlet

Table 3-11. MAC - RFCs By Reason for Change portlet filter fields

Field Name Description

Request Type (Read-only) Preset to MAC - Request For Change (RFC). 

Status The status of the RFC.
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MAC - RFCs By Status Portlet

The MAC - RFCs By Status portlet displays a pie chart showing the percentage 
of RFCs of each status. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
MAC - Request For Change (RFC). 

Figure 3-18 shows an example MAC - RFCs By Status portlet.

Clicking the pie chart drills down to the MAC - RFCs By Status - List portlet.

Figure 3-18. MAC - RFCs By Status portlet
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Change Management Reports

MAC provides several reports that can be run to provide summary data and 
scheduling information about RFCs in the system, as well as to process 
participant data for SOX auditing.

To generate a report, from the PPM Center menu bar, select Reports > Create 
a Report; on the Submit New Report page, in the Report Category field, select 
Demand Management; click the link for the desired report, complete all 
required and any optional filter fields, and click Submit. For more information 
about reports, see the Reports Guide and Reference. 

MAC - Change Summary Report

The MAC - Change Summary Report provides a list of RFCs that have been 
implemented, grouped by change category. 

Table 3-12 describes the filter fields for the report. 

Table 3-12. MAC - Change Summary Report filter fields

Field Name Description

Request Type (Read-only) Preset to MAC - Request For Change (RFC). 

Change Status The status of the change request.

Change Priority The priority of the change request.

Time Period From The earliest date the RFCs were created.

Time Period To The latest date the RFCs were created.
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Figure 3-19 shows sample output for the MAC - Change Summary Report.

Figure 3-19. MAC - Change Summary Report output

MAC - Forward Schedule of Changes for RFC Report

The MAC - Forward Schedule of Changes for RFC report is a key report used 
in the change management process. The output of this report is a list of all the 
RFCs that are scheduled to be implemented. 

Table 3-13 describes the filter fields for the report.
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Figure 3-20 shows sample output for the MAC - Forward Schedule of Changes 
for RFC report. 

Figure 3-20. MAC - Forward Schedule of Changes for RFC report output

Table 3-13. MAC - Forward Schedule of Changes for RFC report filter fields

Field Name Description

Report Title The title of the report.

Start FSC Period The earliest start date of the scheduled RFCs.

End FSC Period The latest start date of the scheduled RFCs.

Request Type (Read-only) Preset to MAC - Request For Change (RFC). 
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MAC - Release Management Request Type

The ITIL Release Management process as modeled by MAC sends a release 
request of the MAC - Release Management request type along the 
MAC - Release Request workflow (see MAC - Release Request Workflow 
on page 83) to be examined and resolved. 

Figure 3-21 shows the Create New MAC - Release Management page that 
appears when you create a request and select the MAC - Release Management 
request type. Table 3-14 describes the fields in the MAC - Release 
Management request, including some fields that do not appear until the request 
is created or until other conditions are met.
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Figure 3-21. MAC - Release Management request
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Table 3-14. MAC - Release Management request fields (page 1 of 4)

Field Name (*Required) Description

Summary section

Request Status (Read-only) The status of the release request. 
Preset to Logged. 

Request No. (Added after the request is created.) The number of 
the request.

*Release Category The release category, based on the scope of the 
release (number of changes in a release).

*Release Type The type of release.

*Expected Release Date
(Added and required after the request is created.)
The date the request is expected to be released.

Actual Release Date

(Added after the Expected Release Date, Release 
ID, and Release Policy Summary fields are 
specified, the request is approved, and release 
planning is complete.)
The actual date for the release.

*Release Summary The summary description of the release.

*Release ID
(Required only after the 
request is created.) 

The ID for the release.

Release Planning section

*Release Definition Summary A summary of the definition of this release.

Release Definition Enables the user to attach the release definition 
document directly to the release request.

*Release Policy Summary
(Required only after the 
request is created.)

A summary of the policy that governs this release.

Release Policy Enables the user to attach the release policy 
document directly to the release request.

Release Plans Summary A summary of rollout plans for this release.
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Release Plans

Enables the user to attach the rollout plans for this 
release (for example: a timetable of events, a 
resource plan, and who will do what and when) 
directly to the release request.

QA Information section

Release Test Plan Summary A summary of the test plan for this release.

Release Test Plan

Enables the user to attach the release test plan (the 
plan that describes tests to be performed on this 
release in the TEST environment) directly to the 
release request.

Release Acceptance Criteria 
Summary

A summary of the release acceptance criteria for 
this release.

Release Acceptance Criteria

Enables the user to attach the release acceptance 
criteria document (which details criteria that qualify 
the acceptance of this release before deployment 
to the LIVE environment) directly to the release 
request.

Test Results Enables the user to attach the test results directly to 
the release request.

Known Defects Summary A summary of known defects that will be carried 
forward into the LIVE environment.

Known Defects
Enables the user to specify RFCs relating to known 
defects that will be carried forward into the LIVE 
environment.

Quality Center Info section a

Quality Center Instance The Quality Center instance that will receive the 
new PPM Center request.

Quality Center Domain The Quality Center domain of the working project.

Quality Center Project The Quality Center project that is linked with this 
request.

Quality Center Assigned To 
User

The user assigned to the Quality Center 
requirement.

Table 3-14. MAC - Release Management request fields (page 2 of 4)

Field Name (*Required) Description
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Quality Center Requirement 
No. The Quality Center requirement number.

Quality Center Status The Quality Center requirement status.

Quality Center Message
(Read only) Message indicating whether the last 
update to the request was successful in Quality 
Center.

Quality Center Attachments The URL of the attached requirement document.

Release Preparation section

Communication Plan 
Summary

A summary of the communication plan for this 
release.

Communication Plan

Enables the user to attach the communication plan 
(the plan that describes the various notifications 
that need to be sent out prior to release deployment 
into the LIVE environment) directly to the release 
request.

Training Plan Summary A summary of the training plan for this release.

Training Plan

Enables the user to attach the training plan (the 
plan that describes the training that needs to be 
provided prior to release deployment into the LIVE 
environment) directly to the release request.

Release Backout Plans 
Summary A summary of the backout plans for this release.

Release Backout Plans

Enables the user to attach the backout plan (the 
release plan that describes procedures to back out 
the release to its original state) directly to the 
release request.

License Agreements
Enables the user to attach any license agreement 
documents for software licensed in this release 
directly to the release request.

Support Agreements
Enables the user to attach any support agreement 
documents for support policies of software licensed 
in this release directly to the release request.

Table 3-14. MAC - Release Management request fields (page 3 of 4)

Field Name (*Required) Description
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To submit a MAC - Release Management request:

1. Log on to PPM Center.

2. From the menu bar, select Demand Management > Create a Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
MAC - Release Management and click Create. 

The Create New MAC - Release Management page appears, displaying the 
appropriate release request fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

Service Level Agreements
Enables the user to attach any SLAs for ordering 
new equipment or software directly to the release 
request.

Leasing Agreements
Enables the user to attach any leasing agreement 
documents for software leased in this release 
directly to the release request.

a. Fields in the Quality Center Info section remain visible by default but are not used if PPM Center is 
not integrated with HP Quality Center.

Table 3-14. MAC - Release Management request fields (page 4 of 4)

Field Name (*Required) Description

The administrator can remove the Quality Center Info section from the request type 
by removing the Quality Center Info field group from the MAC - Release Request 
Header request header type. See the HP Demand Management Configuration Guide 
for details about request header types and field groups.
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4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the release can be entered and stored. Typically, when creating a release 
request, you do not need to add a note to it. However, add a note if you 
want to convey additional information to the reviewers and processors of 
the release request.

In the References section, add any references to the request. It can be 
useful to reference a Web-accessible file or attach a document or file from 
a local machine to the release request. For more information about adding 
references, see the HP Demand Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The release request is submitted. The Request Creation Confirmed page 
appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
see the detail page of the newly generated release request. 

When the release request is submitted, it is assigned an initial status, such 
as New. It is then routed along the MAC - Release Request workflow (see 
MAC - Release Request Workflow).

MAC - Release Request Workflow

The MAC - Release Request workflow is the sequence of approvals, decisions, 
or actions that the release request follows. The release request starts at the 
beginning of the MAC - Release Request workflow; when it reaches the end of 
the workflow, its lifecycle is complete. After the release request has been 
through initial planning, the release is created, and the packages for the RFCs 
can be aggregated into the release. The deployment steps in the release request 
workflow coordinate with the actual release to automate the deployment of all 
packages in the release into the TEST and LIVE environments.

PPM Center can be configured to allow you to save the request before it is 
submitted. To have this feature enabled, see your application administrator.
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Upon creation, a MAC - Release Management request is automatically set to 
use the MAC - Release Request workflow.

Figure 3-22 shows the MAC - Release Request workflow. Table 3-15 lists the 
important steps in the workflow and the user roles associated with each.

Figure 3-22. MAC - Release Request workflow
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Table 3-15. MAC - Release Request workflow steps (page 1 of 2)

Step Name User Security Description

1. Release Policy MAC - Release 
Manager

Define the release policy for this 
release (including release number and 
rules for accepting changes into the 
release).

2. Release 
Planning

MAC - Release 
Manager

Review and approval of the release 
policy and other planning documents 
(such as release acceptance criteria).

3. Integrate with 
Quality Center? MAC - QA Manager

Determine whether the user wants to 
use Quality Center integration, if 
enabled. See Integration of PPM 
Center with HP Quality Center 
on page 25.

4. Quality Process 
Entry MAC - QA Manager Secure approval for release entry into 

Quality Center-integrated process.

5. Create Release 
Requirement in 
Quality Center

MAC - QA Manager
Create a test requirement in Quality 
Center for the release if integration has 
been enabled.

7. Accept Changes 
into Release

MAC - Release 
Manager

Add RFC-related changes to the 
release. This can be done from the 
RFC workflow directly (for changes that 
qualify for this release).

8. Build and Deploy 
Release to TEST

MAC - Release 
Manager

Deploy the entire release into QA or 
staging environment and prepare for 
integration testing.
This step automatically migrates the 
release and related packages to the 
TEST environment.

10. Fit-for-Purpose 
Testing

MAC - Release 
Manager Fit-for-purpose testing of this release.

11. Evaluate 
Quality

MAC - Release 
Manager

Testing of this release; includes testing 
of backout plan.
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12. Release 
Acceptance

MAC - Release 
Manager

Based on test results and known 
defects, determine if this release is 
acceptable for LIVE deployment.

13. Rollout 
Planning

MAC - Release 
Manager

Plan the rollout into LIVE environment; 
the key document is the release plan 
(who does what and when).

14. Communication 
Preparation and 
Training

MAC - Release 
Manager

Prepare for LIVE rollout; determine 
logistics, training, and communication.

15. Deploy 
Release to LIVE

MAC - Release 
Manager

Distribute and install this release to the 
LIVE environment.
This step automatically migrates the 
release and related packages to the 
LIVE environment.
SOX Segregation of Duties prohibits 
developers and testers from being 
involved in deployment of code into 
production. It is important that users 
with either of these roles not be 
involved in this step.

16. Working? MAC - Release 
Manager

Determine if the release is working 
based on sanity check and testing.

17. Update All 
RFCs Status

MAC - Release 
Manager

Update the status of RFCs related to 
this release.

18. Close 
(Immediate 
success) - 100%

(None) Update status to Closed.

19. Implement 
Backout Plans

MAC - Release 
Manager

If the release is not working, implement 
the backout plan.

20. Update All 
RFCs Status

MAC - Release 
Manager

Update the status of RFCs related to 
this release.

Table 3-15. MAC - Release Request workflow steps (page 2 of 2)

Step Name User Security Description
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MAC - Release Distribution Workflow and Subworkflow

The MAC - Release Distribution workflow and the MAC - Release 
Distribution Sub WF subworkflow that it calls to migrate the release to TEST 
and then to LIVE environments are used to control distribution among 
environments of a release that consolidates multiple changes.

Figure 3-23 shows the MAC - Release Distribution workflow.

Figure 3-23. MAC - Release Distribution workflow

Release Management Portlets to Display KPIs

MAC provides several portlets that can be added to your PPM Dashboard to 
provide real-time views into several key performance indicators (KPIs).

For information about adding portlets to your PPM Dashboard, see the Getting 
Started guide.
Using MAC Entities 87



MAC - Deployed Releases Portlet

The MAC - Deployed Releases portlet is provided to users with the role of 
Release Manager. It displays a list of recently deployed releases. 

Table 3-16 describes the filter fields for the portlet.

Figure 3-24 shows an example MAC - Deployed Releases portlet.

Figure 3-24. MAC - Deployed Releases portlet

Table 3-16. MAC - Deployed Releases portlet filter fields

Field Name Description

Child RFC 
Request Type

Request types, at least one of which must be in the releases 
that are to be listed.

Status The status of the release.

Category The category of the release (Emergency, Major, or Minor).

Type The type of release (Full, Delta, or Package Release).

Request Type (Read-only) Preset to MAC - Release Management. 

In order for the portlet to display data, RFCs need to be added as child or related 
references to the release request.
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MAC - My Releases Portlet

The MAC - My Releases portlet is provided to users with the role of Release 
Manager and other roles involved in the release management process. It lists 
release requests that have been created by or assigned to the logged-on user. 

Table 3-17 describes the filter fields for the portlet.

Figure 3-25 shows an example MAC - My Releases portlet. 

Figure 3-25. MAC - My Releases portlet

Table 3-17. MAC - My Releases portlet filter fields

Field Name Description

Request Type (Read-only) Preset to MAC - Release Management. 

Category The category of the release (Emergency, Major, or Minor).
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MAC - Open Releases Portlet

The MAC - Open Releases portlet is provided to users with the role of Release 
Manager. It lists releases that do not have the status of Closed. 

Table 3-18 describes the filter fields for the portlet.

Figure 3-26 shows an example MAC - Open Releases portlet. 

Figure 3-26. MAC - Open Releases portlet

MAC - Releases Portlet

The MAC - Releases portlet displays a list of release requests. If PPM Center is 
integrated with HP Change Control Management, the portlet provides a Click 
to View link in the View Impact column for each request to log in to HP Change 
Control Management, where various tabs provide information about the 
request. 

Figure 3-27 shows an example MAC - Releases portlet.

Table 3-18. MAC - Open Releases portlet filter fields

Field Name Description

Request Type (Read-only) Preset to MAC - Release Management. 

Assigned to The user assigned to the release.

Category The category of the release (Emergency, Major, or Minor).
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Figure 3-27. MAC - Releases portlet

For more information about tabs in Change Control Management, see Using 
the Integration of PPM Center with Release Control on page 267.

MAC - Releases By Category Portlet

The MAC - Releases By Category portlet is provided to users with the role of 
Release Manager. It displays a pie chart showing the percentage of releases in 
each category. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
MAC - Release Management. 

Figure 3-28 shows an example MAC - Releases By Category portlet.

Figure 3-28. MAC - Releases By Category portlet

Clicking the pie chart drills down to the MAC - Releases By List portlet.
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MAC - Releases By Type Portlet

The MAC - Releases By Type portlet is provided to users with the role of 
Release Manager. It displays a pie chart showing the percentage of releases of 
each type. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
MAC - Release Management. 

Figure 3-29 shows an example MAC - Releases By Type portlet.

Figure 3-29. MAC - Releases By Type portlet

Clicking the pie chart drills down to the MAC - Releases By List portlet.
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MAC - RFCs per Release Portlet

The MAC - RFCs per Release portlet is provided to users with the role of 
Release Manager. It displays a list of RFCs that constitute a release. 

Table 3-19 describes the filter fields for the portlet.

Figure 3-30 shows an example MAC - RFCs per Release portlet.

Figure 3-30. MAC - RFCs per Release portlet

Release Management Reports

MAC provides several reports that can be run to provide summary data and 
scheduling information about releases in the system.

To generate a report, from the PPM Center menu bar, select Reports > Create 
a Report; on the Submit New Report page, in the Report Category field, select 
Demand Management; click the link for the desired report, complete all 
required and any optional filter fields, and click Submit. For more information 
about reports, see the Reports Guide and Reference. 

Table 3-19. MAC - RFCs per Release portlet filter fields

Field Name Description

Release Request The number of the release request.

Request Type The request types of the RFCs. Preset to MAC - Release For 
Change (RFC) by default.

Status The status of the release.

Priority The priority of the release.
Using MAC Entities 93



MAC - Forward Schedule of Releases Report

The MAC - Forward Schedule of Releases report is a key report used in the 
release management process. The output of this report is a list of all releases 
that are scheduled to be implemented into the LIVE environment. 

Table 3-20 describes the filter fields for the report.

Figure 3-31 shows sample output for the MAC - Forward Schedule of 
Releases report. 

Figure 3-31. MAC - Forward Schedule of Releases report output

Table 3-20. MAC - Forward Schedule of Releases report filter fields

Field Name Description

Report Title The title of the report.

Start FSC Period Searches for releases created after the specified FSC date.

End FSC Period Searches for releases created before the specified FSC date.

Request Type (Read-only) Preset to MAC - Release Management. 
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MAC - Release Content Report

The MAC - Release Content Report provides a list of RFCs that have been 
incorporated into a release. 

Table 3-21 describes the filter fields for the report.

Figure 3-32 shows sample output for the MAC - Release Content Report. 

Figure 3-32. MAC - Release Content Report output

Table 3-21. MAC - Release Content Report filter fields

Field Name (*Required) Description

Report Title The title of the report.

Request Type (Read-only) Preset to MAC - Release Management. 

*Release ID Specify the release whose contents you want to list.
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MAC - Release Summary Report

The MAC - Release Summary Report provides a list of releases that have been 
implemented. 

Table 3-22 describes the filter fields for the report.

Figure 3-33 shows sample output for the MAC - Release Summary Report 
report. 

Figure 3-33. MAC - Release Summary Report output

Table 3-22. MAC - Release Summary Report filter fields

Field Name Description

Request Type (Read-only) Preset to MAC - Release Management. 

Release Status Searches for releases with the specified statuses.

Release Type Searches for releases of a specific type.

Time Period From Searches for releases created after the specified date.

Time Period To Searches for releases created before the specified date.
96 Chapter 3



Special Commands

As described in the following sections, MAC provides special commands that 
are used for integration of PPM Center with Mercury Application Mapping 
and for integration of PPM Center with HP Quality Center.

Special Commands for Integration of PPM Center with Mercury Application 
Mapping

Table 3-23 describes the special commands provided by MAC to support 
integration of PPM Center with Mercury Application Mapping.

Special Commands for Integration of PPM Center with Quality Center

Table 3-24 describes the special commands provided by MAC to support 
integration of PPM Center with Quality Center.

Table 3-23. Special commands for integration of PPM Center with  
Mercury Application Mapping

Special Command Description

ksc_delete_MAM_RFC_id

Connects to Mercury Application Mapping to 
have it delete the redundant RFCs it created 
there each time the status of a PPM Center 
request became Ready for Impact Analysis.

ksc_run_MAM_impact_analysis
Connects to Mercury Application Mapping to 
perform impact analysis and generate an 
Impact Analysis Report.

Table 3-24. Special commands for integration of PPM Center with  
Quality Center

Special Command Description

ksc_create_defect_in_QC Creates an execution step that will create a 
defect in Quality Center.

ksc_create_requirement_in_QC Creates an execution step that will create a 
requirement in Quality Center.
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4 Integration of PPM Center with Service 
Manager or ServiceCenter 
Introduction to Integration of PPM Center with Service Manager 
or ServiceCenter 

For an overview of the integration of PPM Center with HP Service Manager 
(or HP ServiceCenter), see Integration of PPM Center with Service Desk 
Applications on page 22. 

The integration is enabled by a configurable Service Manager adapter file in 
PPM Center along with the request types and workflows provided by MAC, so 
that PPM Center acts as a single repository for application-related requests for 
change (RFCs). The adapter converts changes (tickets) in Service Manager to 
requests for change (RFCs), and then imports those RFCs into PPM Center for 
processing. 

Conversely, using a configurable PPM Center adapter file that also resides in 
PPM Center, the integration can optionally update Service Manager changes 
based on subsequent changes made in PPM Center to the RFCs. 

If the Service Manager adapter file and the associated PPM Center adapter file 
are both configured, such that data can be sent in both directions between 
Service Manager and PPM Center, the integration is said to be “bi-directional.” 

A separate adapter file is required for each mapping between a Service 
Manager change and a PPM Center request type.

In this chapter, references to HP Service Manager (the successor product to HP 
ServiceCenter) also apply to supported versions of HP ServiceCenter, except where 
distinctions between Service Manager and ServiceCenter are described as needed.
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MAC provides two default adapter files—a Service Manager adapter file and 
an associated default PPM Center adapter file.

The integration runs as a service in the PPM Server. As described later, the 
configuration of an adapter file controls various aspects of its import process. 

This chapter describes how to configure the adapters in PPM Center and the 
Service Manager application for integration. It is intended for Service Manager 
administrators or for PPM Center system administrators who are also familiar 
with Service Manager. 

For information about the supported versions of Service Manager and 
ServiceCenter, see Versions of Service Desk Applications Supported for 
Integration with PPM Center on page 21.

For information about the MAC - Request For Change (RFC) request type in 
PPM Center that is used to establish integration of PPM Center with Service 
Manager, see MAC - Request For Change (RFC) Request Type on page 40.

For references to more information about Service Manager or ServiceCenter, 
see HP Service Manager Documentation on page 28 or HP ServiceCenter 
Documentation on page 28.

No software needs to be installed on the Service Manager or ServiceCenter server for 
integration with PPM Center. However, see Versions of Service Desk Applications 
Supported for Integration with PPM Center on page 21.
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Conversion of Service Manager Changes to PPM Center RFCs

Figure 4-1 depicts the flow for converting a change in Service Manager to a 
MAC request for change (RFC), and importing the RFC into PPM Center.

Figure 4-1. Using the Service Manager adapter to import changes  
from Service Manager into PPM Center

The Service Manager adapter consists of the following three components:

Connector. Collects changes from the Service Manager system.

Converter. Uses field mapping to convert the changes from the Service 
Manager data model in which they were created to RFCs for the PPM 
Center data model.

The converter also contains two optional filters to control which changes 
are imported into PPM Center. The preFilter filters out categories of 
changes you specify in the Service Manager data model before they are 
converted. After the Service Manager changes are converted to RFCs, the 
postFilter filters out categories of requests you specify before they are 
presented to the sender.

Sender. Using the RFC data from the converter, creates the RFCs in PPM 
Center.
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Conversion of PPM Center RFCs to Service Manager Change Updates

Similar to the Service Manager adapter, the PPM Center adapter consists of 
connector, converter, and sender components. In this case, these components 
allow Service Manager to import updates from PPM Center. 

Figure 4-2 depicts the flow for converting a MAC RFC (request for change) in 
PPM Center to an update to a change in Service Manager, and importing the 
update into Service Manager. 

Figure 4-2. Using the PPM Center adapter to import change updates  
from PPM Center into Service Manager
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Overview of Configuring the Service Manager Integration

Before configuring the integration, you must identify the Service Manager data 
attributes that will be integrated with PPM Center, including which of the 
attributes of Service Manager changes to send to PPM Center, and, for 
bi-directional integration, which of the attributes to receive back from PPM 
Center.

Before you can begin importing changes from Service Manager into PPM 
Center, you must configure Service Manager and configure the Service 
Manager adapter in PPM Center to enable integration. The procedures are 
summarized as follows:

Configure HP Service Manager in the particular ways required for 
integration of PPM Center with HP Service Manager.

Generate Service Manager Web service stubs for Service Manager. PPM 
Center needs the Service Manager Web service stubs to connect to Service 
Manager. 

Configure the Service Manager adapter configuration file on the PPM 
Server, to support converting a change in Service Manager to a MAC 
request for change (RFC) and then importing the RFC into PPM Center. 
MAC provides a Service Manager default adapter configuration file.

If you want the integration to be bi-directional, that is, to also send updates 
that are made in PPM Center RFCs back to Service Manager as change 
updates, configure the PPM Center adapter configuration file on the PPM 
Server. MAC provides a default PPM Center adapter configuration file 
associated with Service Manager.

Configure the required server.conf parameters in PPM Center.

Restart the PPM Server in normal mode and verify that the MAC service 
has started.

Configure logging of errors and events.

In this section, references to HP Service Manager also apply to supported versions of 
HP ServiceCenter, except where distinctions between Service Manager and 
ServiceCenter are described as needed.
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Configuring HP Service Manager for Integration with PPM 
Center

Before starting these configuration procedures, make sure that the Service 
Manager server, Service Manager client, and Service Manager Webtier are 
installed and running.

Integration of HP Service Manager with PPM Center requires specific 
configuration of HP Service Manager, as described in the following sections.

Configuring the Change Management Module

To configure the Change Management module in Service Manager:

1. Enable Service Manager to provide PPM Center with the changes sorted by 
their last update times, as required by this integration:

a. Navigate to System Definition > Tables > cm3r > Keys and on that 
screen, click New. 

b. Add a "not null: <last updated field name>" key constraint to 
the database table of the changes for the sysmodtime field.

c. Add a "not null: <created date field name>" key constraint to 
the database table of the changes for the orig.date.entered field, for use 
in the initial load mode (for more information, see the initial-load-state 
adapter attribute in Table 4-1 on page 117).

In this section, references to HP Service Manager also apply to supported versions of 
HP ServiceCenter, except where distinctions between Service Manager and 
ServiceCenter are described as needed.

PPM Center can be integrated with multiple instances of Service Manager or with 
multiple instances of ServiceCenter, if those instances are at the same version. (See 
Versions of Service Desk Applications Supported for Integration with PPM Center 
on page 21.) However, the procedures in the following sections must be performed 
identically on the multiple Service Manager or ServiceCenter instances.
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d. Use either the Service Manager or ServiceCenter procedure in this step 
to make sure that the sysmodtime and orig.date.entered fields are 
exposed through the Change Management Web Services:

For Service Manager:

i. Select Menu Navigation > Tailoring > WSDL Configuration. 

ii. Type cm3r in the Name field and click Search. 

iii. Click the Fields tab to add fields to the table as described in the 
following steps.

iv. In the Field column, type sysmodtime. In the Caption column, type 
sysmodtime. In the Type column, select DateTimeType. 

v. In the Field column, type orig.date.entered. In the Caption 
column, type sysmodtime. In the Type column, select 
DateTimeType. 

For ServiceCenter:

i. Select the Include in API checkbox for both sysmodtime and 
orig.date.entered. 

ii. Configure the Web Services API properties for sysmodtime as 
follows:

iii. Configure the Web Services API properties for orig.date.entered as 
follows:

Property Name Value

Field name in API sysmodtime

Field data type in API DateTimeType

Property Name Value

Field name in API orig.date.entered

Field data type in API DateTimeType
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2. Import the unload file provided with PPM Center to set up Change 
Management Web service for the integration with PPM Center:

For Service Manager, the unload file is located at:

<PPM_Home>\conf\sdi\serviceManagerFiles\sm_operations

where <PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/PPMServer. 

For ServiceCenter, the unload file is located at:

<PPM_Home>\conf\sdi\serviceCenterFiles\sc_operations

Configuring the Change Management Service Manager Web Service

To configure the Change Management Service Manager or ServiceCenter Web 
service:

1. Associate a display action to the new processes:

a. Navigate to the Objects menu: 

For Service Manager, select 
Menu Navigation > Tailoring > Document Engine > Objects. 

For ServiceCenter, select 
Menu Navigation > Utilities > Tools > Document Engine > Objects. 

b. Type cm3r in the File name field and click Enter. 

c. Specify the default state. 

d. Add a new Display action associated with the process—associate the 
checkretract action with ccm.check.retract. 

e. Add a new Display action associated with the process—associate the 
checkapproval action with ccm.check.approval. 

f. Close the cm3r object.

g. Repeat step a through step f for the cm3t object.

2. To configure ChangeManagement WSDL:

a. Navigate to WSDL Configuration (at external access):
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b. In the Service Name field, type ChangeManagement and click Search. 

c. Add the following actions for table cm3r:

d. Repeat step c for table cm3t.

Configuring Browsing of Service Manager Changes from a URL

This optional procedure enables RFCs in PPM Center to be updated with URL 
links to the corresponding changes in Service Manager or ServiceCenter, so 
that PPM Center users can easily jump directly to those changes. To enable this 
capability, configure Service Manager or ServiceCenter as follows (otherwise 
go to Configuring for Bi-Directional Integration on page 111):

1. Configure the Web server URL in the Service Manager or ServiceCenter 
server:

a. Open the System Information Definition: 

For Service Manager, select 
Menu Navigation > System Administration > Base System 
Configuration > Miscellaneous > System Information Record. 

For ServiceCenter, select 
Menu Navigation > Utilities > Administration > Information > System 
Information Record. 

b. In the form, select the Active Integrations tab.

c. In the WebServer URL field in the WebServer Information pane, type 
the URL of the Service Manager or ServiceCenter Web server 
configured for Web access. For example:

http://<Host>:<Port>/sm/index.do

d. Click OK to save the System Information Definition and exit.

Allowed Action Action Name

checkapproval CanApprove

checkretract CanRetract
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2. Create and configure the record.url field in the cm3r table, as follows:

a. Create the record.url field in the cm3r table, using the following 
Service Manager or ServiceCenter Help topic:

“How do I add a field to a table?”

b. Configure the record.url field as follows:

c. For Service Manager only, in the SQL mapping section:

i. Type RECORD_URL in the SQL field name field. 

ii. Type VARCHAR in the SQL data type field. 

iii. Type 400 in the SQL data length field. 

d. Add record.url to the Change Management Web service: 

i. Select the Include in API checkbox for record.url. 

ii. Configure the Web Services API properties for record.url as 
follows:

e. The record.url field is populated in the cm3r.pre.add trigger. To 
configure this trigger

i. Navigate to System Definition > Tables > cm3r. 

ii. Open the list of triggers.

iii. Open the cm3r.pre.add trigger.

Section Name Field Name Value

General Properties Type
For Service Manager: Character
For ServiceCenter: Text

General Properties Caption Change URL

Property Name Value

Field name in API record.url

Field data type in API StringType
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iv. Copy the following JavaScript into the trigger:

_rec_number = record.number;
var _filename = "cm3r";
var _query = "number=\"" + _rec_number+ "\"";
var _title = "Change number " + _rec_number;
var _link=system.library.urlCreator.getURLFromQuery

(_filename, _query, _title);
record.record_url =_link;

v. Click Save to save the script.

vi. Click Compile to check for any errors and compile. No errors 
should occur. 

Now, any new record will have the record.url field populated. 
However, as described in the following steps, you will need to 
perform the Mass Update procedure to populate the record.url field 
for existing records.

f. Use either the Service Manager or ServiceCenter procedure in this step 
to prepare to perform the Mass Update procedure.

For Service Manager: 

i. Navigate to Navigation > Tailoring > Database Manager. 

ii. Click Change Management > Changes > Search Changes. 

iii. Use Search to display a list of change records.

iv. Select the records you want to update.

For ServiceCenter: 

i. Using System Navigator, open the form in Database Manager.

ii. Select the Administration mode checkbox.

iii. Open the cm3r form and click Search. 

A list of format names is displayed.

iv. Open any format.

A blank form is displayed.

v. To display the list of changes that match the search criteria, click 
Search. 
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g. Perform the Mass Update procedure:

i. Click Mass Update in the toolbar to start updating the listed records.

Database Manager displays the initial form again, but with different 
options (buttons).

ii. Do not specify values in any field. Click Complex Update. 

Database Manager displays the Mass Add/Update Instruction 
screen.

iii. Specify the following assignment statement in the Instructions for 
action on EACH RECORD input field:

record.url in $file = 
jscall("urlCreator.getURLFromQuery","cm3r",

"number=\"" + number in $file + "\"",
"Change number " + number in $file)

For each record updated, this step sets the record.url field based on 
the Web server URL entered in System Information Record. Then it 
returns terminal control to you and displays the message: 

<n> records updated in the cm3r file.

where <n> is the number of records updated.

h. To browse directly from the Web server using a URL that includes a 
ticket ID, disable the querysecurity parameter by using the 
instructions in the following Service Manager or ServiceCenter Help 
topic:

“Web parameter: sc.querysecurity”

i. Add the following line to the convertChange.js file:

ppmRFC.addURLReference(serviceCenterRFC.get
("record.url"), <display text for URL reference>);

where <display text for URL reference> represents the text to be 
displayed for the link to the URL.

For information about the addURLReference function, see ppmRFC 
Object on page 124.
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Configuring for Bi-Directional Integration

Perform this procedure only if you plan to configure the integration to be 
bi-directional.

To be able to verify later that bi-directional integration works, configure the 
fields that are required to map a PPM Center request to a Service Manager 
change. For example:

Create a structure called ppmFields in the cm3r table. See the Help topic:

“How do I add a structure to the Database Dictionary?”

Create fields in the ppmFields structure. If you want to use the 
convertRequest.js script provided with MAC as is, for Service Manager 
enter the fields:

o ppmURL with a Caption of ppmURL and select a Type of StringType. 

o requestModifiedDate with a Caption of reqModDate and select a 
Type of DateTimeType. 

For details of analogous procedures for Service Manager and 
ServiceCenter, see step d on page 104.

If you want to use a custom mapping, you may need to create additional fields 
and create entries for them using the WSDL configuration tool.
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Generating Web Service Stubs 

In Service Manager or ServiceCenter, you can modify which fields are 
available through Web services. Each time you modify these settings, a new 
Web Services Description Language (WSDL) descriptor is created. In the PPM 
Server, you must regenerate the Web service stubs from the new descriptor.

To generate the stubs:

1. Navigate to the <PPM_Home>/bin/sdi directory on the PPM Server.

where <PPM_Home> represents the path where the PPM Center instance is 
installed. For example: xyzserver/E/PPMServer. 

2. Run the following script:

./kGenerateServiceCenterStub.sh <wsdl-url> <PPM_Server_Name>

where

Perform this procedure for new installations of MAC and after any upgrade of PPM 
Center.

<wsdl-url> represents the Service Manager or ServiceCenter 
WSDL URL for Change Management

<PPM_Server_Name> represents the subdirectory of <PPM_Home>/
server specified during installation as the value 
for the KINTANA_SERVER_NAME parameter in the 
server.conf file. (It is not necessarily the actual 
host name of the server.) When generated, the 
stubs will be placed in this subdirectory. 
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The specific script depends on whether you are integrating with Service 
Manager or ServiceCenter.

For Service Manager, use:

./kGenerateServiceCenterStub.sh http://<Host>:<Port>/
sc62server/PWS/ChangeManagement?wsdl <PPM_Server_Name>

For example:

./kGenerateServiceCenterStub.sh http://ServManager:13080/
sc62server/PWS/ChangeManagement?wsdl kintana

For ServiceCenter, use:

./kGenerateServiceCenterStub.sh http://<Host>:<Port>/
sc61server/ws/ChangeManagement?wsdl <PPM_Server_Name>

For example:

./kGenerateServiceCenterStub.sh http://ServCenter:13080/
sc61server/ws/ChangeManagement?wsdl kintana

3. Verify that the stubs are now in the following directory:

<PPM_Home>/server/<PPM_Server_Name>/deploy/itg.war/WEB-INF/
classes/

Configuring the Service Manager Adapter Configuration File

The Service Manager adapter configuration file is an XML file in PPM Center 
that enables integration of PPM Center with Service Manager and converts 
Service Manager changes to PPM Center requests. The configuration file 
consists of the following components, each with its own attributes or properties 
(see Figure 4-1 on page 101):

The stub generation might fail if the host is not resolvable by name. To resolve the 
host by name, make an entry in the hosts file for the machine you want to connect. 
See the documentation for your operating system for the location of the hosts file.

In this section, references to HP Service Manager also apply to supported versions of 
HP ServiceCenter, except where distinctions between Service Manager and 
ServiceCenter are described as needed.
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General settings for the adapter itself, such as its name and the name of the 
Service Manager application in which the changes are created.

The connector between Service Manager and the adapter.

The converter of changes in the Service Manager data model to generic 
requests in the PPM Center data model. The converter calls the scripts that 
define the field mapping and filter functions.

The PPM Center sender, which sends the converted and filtered requests to 
PPM Center. 

The following sections describe how to configure the Service Manager adapter 
configuration file and the scripts called by its converter, and how to modify 
copies of the provided files while preserving the originals. 

Location, Naming, and Structure of Service Manager Adapter Configuration 
Files

Each Service Manager adapter configuration file must follow specific 
conventions for its location, naming, and structure, as described in the 
following sections.

Location and Naming of the Service Manager Adapter Configuration File

The adapter configuration files are located in the <PPM_Home>/conf/sdi 
directory of the PPM Server. This directory contains:

A configuration file for the adapter (or one for each adapter if there are 
multiple adapters). 

In this configuration file, you define a name for the adapter. The 
configuration file must have a .settings file extension.

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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A subdirectory (or one for each adapter configuration file if there are 
multiple files). 

The subdirectory contains the conversion scripts, which are called by the 
converter to map the fields between the changes and requests and to filter 
them. The name of the subdirectory must be the same as the <adapter 
name> (for a description, see Structure of the Service Manager Adapter 
Configuration File on page 115 and Table 4-1 on page 117) followed by 
.ext. 

For example, if the adapter name is serviceManager-adapter, the  
<PPM_Home>/conf/sdi directory must contain a subdirectory named 
serviceManager-adapter.ext to hold all the conversion script files for 
the adapter.

Structure of the Service Manager Adapter Configuration File

MAC provides, as a template, a default Service Manager adapter configuration 
file named serviceManager-adapter.settings1. The adapter file you 
configure and use must have a .settings file extension. 

Copy the default adapter file (to preserve the original), and rename the copy 
with a .settings file extension and, if desired, a different file name.

As detailed in subsequent sections, the adapter file has the following basic 
structure, including adapter attributes, and properties for its connector, 
converter, and sender:

<?xml version="1.0" encoding="UTF-8"?>
<settings>

<adapter adapter-name="<adapter name>">
<service-desk-application><SD application>

</service-desk-application>
<number-of-tickets><number of tickets>

</number-of-tickets>
<polling-schedules><schedule></polling-schedules>
<polling-frequency><frequency></polling-frequency>
<initial-load-state><date></initial-load-state>

<request-types>
<request-type level="1">
<polling-operation>
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<connector>
<connector-type>serviceManagerChange</connector-type>

<properties>
idProperty=
userQuery=
lastUpdatedPropertyForQuery=
creationDatePropertyForQuery=
lastUpdatedPropertyForResult=
creationDatePropertyForResult=
keyMethodName=
timeZone=
wsDateFormatPattern=
queryDateFormatPattern=
userName=
password=
serviceUrl=

</properties>
</connector>

<converter>
<converter-type>scriptConverter</converter-type>

<properties>
scripts=<convert1,convert2,...>

</properties>
</converter>

</polling-operation>
</request-type>
</request-types>

<sender>
<sender-type>PPMSender</sender-type>

<properties>
userName=
password=
requestType=
updateRequest=
ticketIdFieldName=
sdSystemFieldName=
staticFieldNames=

</properties>
</sender>

</adapter>

</settings>

Do not delete or change the values provided for <connector-type>, 
<converter-type>, or <sender-type>. 
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The following sections describe how to configure the adapter attributes, the 
connector properties, the converter property (scripts), and the sender 
properties.

Configuring the Service Manager Adapter Attributes

Specify the adapter attributes of the Service Manager adapter configuration 
file, such as the adapter name and the service desk application, as described in 
Table 4-1.

Table 4-1. Service Manager adapter attributes (page 1 of 2)

Attribute Name 
(*Required) Description Default Value

*adapter-name

A logical name that represents the 
adapter name on the client 
machine. For example:
serviceManager-adapter
This name is also used for the 
scripts (.ext) directory. (See 
Location and Naming of the Service 
Manager Adapter Configuration File 
on page 114.)

(None)

*service-desk-application

A unique, logical name for the 
service desk system you are using. 
For example:
Service Manager 
or 
ServiceCenter

(None)

number-of-tickets The number of changes that the 
adapter processes at a time. 50

polling-schedules

The times of day that the adapter 
polls Service Manager for changes, 
formatted as a list of cron 
expressions separated by the new 
line character. 
For example: 
30 * * * * <new line> 0 * * * *

(None)
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polling-frequency
The frequency (in seconds) that the 
adapter polls Service Manager for 
changes.

If 
polling-schedules 
and 
polling-frequency 
are unspecified, 
then the default 
polling-frequency 
is 30 seconds, 
starting when 
you restart the 
PPM Server.

initial-load-state

The earliest creation date and time 
of changes the adapter retrieves 
from Service Manager, in the 
format: 
MM/dd/yy HH:mm:ss z
For example:
10/19/08 21:30:00 EST
After completion, the adapter does 
not retrieve any new or updated 
changes (per the polling-schedules 
and polling-frequency attributes) 
until this attribute is commented out.

(None)

Table 4-1. Service Manager adapter attributes (page 2 of 2)

Attribute Name 
(*Required) Description Default Value
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Configuring the Service Manager Adapter Connector Properties

Specify the properties for the connector section of the Service Manager adapter 
configuration file as described in Table 4-2. 

Table 4-2. Service Manager adapter connector properties (page 1 of 3)

Property Name
(*Required) Description Default 

Value

*idProperty
The property name of the ID field in 
the instance returned from the Service 
Manager Web service.

(None)

userQuery

A Service Manager query on the 
Change Management table (cm3r) 
that would work in the Service 
Manager query engine.

(None)

*lastUpdatedPropertyForQuery

The property name of the last-update 
field used to query the Service 
Manager Web service (the field name 
used in an expert search on the 
Service Manager client machine).

(None)

*creationDatePropertyForQuery
The property name of the 
creation-date field used to query the 
Service Manager Web service.

(None)

*lastUpdatedPropertyForResult

The property name of the last-update 
field in the instance returned from the 
Service Manager Web service (usually 
the field name exposed as API).

(None)

*creationDatePropertyForResult

The property name of the 
creation-date field in the instance 
returned from the Service Manager 
Web service.

(None)

*keyMethodName The name of the method for request 
keys (usually the ID field name). (None)
Integration of PPM Center with Service Manager or ServiceCenter 119



*timeZone

The Service Manager server time 
zone, used for converting the last 
updated time of a request from 
Service Manager. 
The format can be GMT+X or GMT–X, 
where X is the offset in hh:mm format 
from GMT. For example, GMT–07:00.
However, to handle Daylight Saving 
Time, use an area time zone instead 
of specifying a time relative to GMT.

(None)

*wsDateFormatPattern

The date format used in the Service 
Manager Web service answer. 
For available formats see:
http://java.sun.com/j2se/1.4.2/docs/
api/java/text/SimpleDateFormat.html

(None)

*queryDateFormatPattern

The date format used for querying the 
Service Manager system (as used in 
the UI expert search). 
For available formats see: 
http://java.sun.com/j2se/1.4.2/docs/
api/java/text/SimpleDateFormat.html

(None)

Table 4-2. Service Manager adapter connector properties (page 2 of 3)

Property Name
(*Required) Description Default 

Value
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*userName

The user name in the Service 
Manager system that PPM Center 
uses to connect to Service Manager.
This user must have full access to the 
Change Management module in 
Service Manager.

(None)

*password

The password in the Service Manager 
system that PPM Center uses to 
connect to Service Manager. 
This password should be encrypted 
using the PPM Center script 
kEncrypt.sh, which is located in 
the bin directory of the PPM Server. 
Encrypted passwords must be created 
in a CDATA section.

(None)

*serviceUrl

The Web service URL of Service 
Manager or ServiceCenter.
For Service Manager, the format is:
http://<Service_Manager_
Host>:<Port>/sc62server/PWS/
where <Service_Manager_Host> 
represents the host machine where 
Service Manager is running.
For ServiceCenter, the format is:
http://<ServiceCenter_Host>:<Port>/
sc61server/ws/
where <ServiceCenter_Host> 
represents the host machine on which 
ServiceCenter is running.

(None)

Table 4-2. Service Manager adapter connector properties (page 3 of 3)

Property Name
(*Required) Description Default 

Value
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Configuring the Service Manager Adapter Converter Property (Script)

The converter section of the Service Manager adapter configuration file 
contains the scripts property. The script file is written in the JavaScript 
language. It maps the fields from the Service Manager data model to the PPM 
Center data model, and filters the requests.

The scripts property is a script file name in the format:

scripts=<convert1>

This file must reside in the same directory as the adapter, namely:

<PPM_Home>/conf/sdi/<adapter name>.ext

where <adapter name> is as defined in Table 4-1 on page 117.

The conversion script is responsible for field mapping during the conversion of 
changes in the Service Manager data model to requests in the PPM Center data 
model, and for filtering the changes and requests. 

The script must contain the convert function and can contain the optional 
preFilter and postFilter functions, as follows: 

preFilter. The following function filters the changes before they are 
converted to the PPM Center data model, so that no unnecessary requests 
are converted:

preFilter(smChange)

For example, the following preFilter function specifies that Service 
Manager changes with a Low priority will not be converted and that all 
other requests will be converted:

Make sure that no line in a script exceeds 256 characters.

Multiple scripts are supported, using a comma-separated list, as in:

scripts=<convert1,convert2,...>

The adapter searches for these conversion script files in the adapter directory.
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function preFilter(smChange){
if (smChange.get("Request Urgency")==SM_PRIORITY_LOW)

return false;
else

return true;
}

convert. After identifying the PPM Center request attributes that are 
required for Service Manager changes, use the convert function of the 
conversion script to map fields of Service Manager changes to fields of 
PPM Center requests.

The following convert function uses the mapping you specify to convert 
the fields of the change in Service Manager to the fields of the request in 
PPM Center:

convert(smChange, ppmRFC)

postFilter. The following function filters the converted requests, so that 
only the desired requests will be imported into PPM Center:

postFilter(ppmRFC)

For example, the following postFilter function specifies that only PPM 
Center requests with a status of Approved will be sent to the PPM Server:

function postFilter(ppmRFC){
ppmStatus==ppmRFC.getField("status");
if (ppmStatus==STATUS_APPROVED)

return true;
else

return false;
}

MAC provides a default conversion script named convertChange.js in the 
<PPM_Home>/conf/sdi/serviceManager-adapter.ext directory.

Use the syntax described in the following sections for the conversion script 
APIs. 

smChange Object

The smChange object represents the Service Manager change. For the 
preFilter and convert script functions, use the following function to retrieve 
fields from the Service Manager change:

get(String fieldName);
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ppmRFC Object

The ppmRFC object represents the PPM Center request. For the convert and 
postFilter script functions, use the following functions to modify the PPM 
Center request fields:

Reference ID

You must use the following function to track the Service Manager change 
ID in the PPM Center request:

setRefId(String referenceId);

Time Stamp

You must use the following function to set the last update time in the PPM 
Center request:

/**
* Set the time stamp in long format—that is, the number of
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setUpdatedTimeStamp(long updatedTimeStamp);
/**
* Set the time stamp in the Java simple date format, which is
* described at the following location: 
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setUpdatedTimeStamp(String updatedTimeStamp, String format);

Status

Use the following function to change the status of the PPM Center request 
and allow the workflow of the request to advance:

setStatus(String newStatus)

To view or change the set of statuses provided with PPM Center, open the 
request type in the PPM Workbench, select the Request Status tab, and 
click Request Status. For more information, see the HP Demand 
Management Configuration Guide. 
124 Chapter 4



General Field

Use the following function to set the value of a general field in the PPM 
Center request:

setField (String fieldName, String value);

Date

Use the following function to set the value of a date field in the PPM 
Center request:

/**
* Set the date in long format—that is, the number of
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setDateValue(String fieldName, long date);
/**
* Set the date in the Java simple date format which is
* described in the following location:
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setDateValue(String fieldName, String date, String format);

Notes to be added upon creation of a PPM Center request

Use the following function to add a note upon creation of a PPM Center 
request:

addUserNoteOnCreate(String content, String addedBy,
long time;

Notes to be added upon update of a PPM Center request

Use the following function to add a note upon update of a PPM Center 
request:

addUserNoteOnUpdate(String content, String addedBy,
long time;

URL reference creation

If you have configured Service Manager to expose the ticket URL as the 
record.url attribute (see Configuring Browsing of Service Manager 
Changes from a URL on page 107), you can use the following function to 
create a URL reference to a Service Manager change:

addURLReference(String attachmentURL, String attachments);
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Configuring the Service Manager Adapter Sender Properties

Specify the properties for the sender section of the Service Manager adapter 
configuration file as described in Table 4-3. The sender controls creating RFCs 
in PPM Center with the converted data.

Table 4-3. Service Manager adapter sender properties (page 1 of 2)

Property Name 
(*Required) Description Default 

Value

*userName The user name in PPM Center by whose 
credentials requests are created. (None)

*password

The password of the userName.
This password should be encrypted using the 
PPM Center script kEncrypt.sh, which is 
located in the bin directory of the PPM Server. 
Encrypted passwords must be created in a 
CDATA section.

(None)

*requestType

The PPM Center request type that should be 
created for the converted changes.
For example:
MAC - Request For Change (RFC)

(None)

updateRequest

If set to true, enables updates made to 
Service Manager changes to be automatically 
sent to existing PPM Center requests.
HP recommends retaining the default value of 
false because usually, after Service Manager 
changes are converted to PPM Center 
requests, processing takes place entirely in 
PPM Center.

false

*ticketIdFieldName a

The field in PPM Center containing the Service 
Manager ticket ID. It is presented in the PPM 
Center request as the Ticket Id field in the 
Service Desk Info section.

(None)
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The sender is the last section of the adapter configuration file. Make sure the 
file ends with the following: 

</adapter>
</settings>

This completes the configuration of the Service Manager adapter configuration 
file.

If you want to establish bi-directional integration, proceed to Configuring the 
PPM Center Adapter Configuration File. Otherwise, go to Configuring 
server.conf Parameters on page 140.

*sdSystemFieldName a

The field in PPM Center containing the Service 
Manager system name. It is presented in the 
PPM Center request as the System Name field 
in the Service Desk Info section.

(None)

*staticFieldNames
(Applicable and 
required only for 
bi-directional 
integration.)

A list of Service Manager fields (separated by 
semicolons) that are not to be updated when 
changes are made to their mapped PPM Center 
fields. 
This list is used to prevent inappropriate update 
of Service Manager tickets for bi-directional 
integration. For example, to prevent a ticket 
from being updated when the last update time in 
PPM Center changes, specify:
REQD-SD_LAST_UPDATE

(None)

a. If PPM Center is integrated with multiple Service Manager servers, the combination of values in the 
ticketIdFieldName and sdSystemFieldName properties ensures that all the tickets from all the 
Service Manager servers are uniquely identified in PPM Center.

Table 4-3. Service Manager adapter sender properties (page 2 of 2)

Property Name 
(*Required) Description Default 

Value

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Configuring the PPM Center Adapter Configuration File

The PPM Center adapter configuration file is an XML file in PPM Center that 
enables bi-directional integration of PPM Center with Service Manager and 
converts PPM Center RFCs to Service Manager change updates. The 
configuration file consists of the following components, each with its own 
attributes or properties (see Figure 4-2 on page 102):

General settings for the adapter itself, such as its name.

The connector between PPM Center and the adapter.

The converter of RFCs in the PPM Center data model to change updates in 
the Service Manager data model. The converter calls the scripts that define 
the field mapping and filter functions.

The sender, which sends the converted and filtered requests to Service 
Manager. 

The following sections describe how to configure the PPM Center adapter 
configuration file and the scripts called by its converter, and how to modify 
copies of the provided files while preserving the originals. 

This procedure is optional. It establishes bi-directional integration. (See Introduction to 
Integration of PPM Center with Service Manager or ServiceCenter on page 99.) If you 
do not want to establish bi-directional integration at this time, proceed to Configuring 
server.conf Parameters on page 140.

In this section, references to HP Service Manager also apply to supported versions of 
HP ServiceCenter, except where distinctions between Service Manager and 
ServiceCenter are described as needed.

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Location, Naming, and Structure of PPM Center Adapter Configuration Files

Each PPM Center adapter configuration file must follow specific conventions 
for its location, naming, and structure, as described in the following sections.

Location and Naming of the PPM Center Adapter Configuration File

The adapter configuration files are located in the <PPM_Home>/conf/sdi 
directory of the PPM Server. This directory contains:

A configuration file for the adapter (or one for each adapter if there are 
multiple adapters). 

In this configuration file, you define a name for the adapter. The 
configuration file must have a .settings file extension.

A subdirectory (or one for each adapter configuration file if there are 
multiple files). 

The subdirectory contains the conversion scripts, which are called by the 
converter to map the fields between the tickets and requests and to filter 
them. The name of the subdirectory must be the same as the <adapter 
name> (for a description, see Structure of the PPM Center Adapter 
Configuration File on page 130 and Table 4-4 on page 132) followed by 
.ext. 

For example, if the adapter name is ppm-adapter, the <PPM_Home>/conf/
sdi directory must contain a subdirectory named ppm-adapter.ext to 
hold all the conversion script files for the adapter.
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Structure of the PPM Center Adapter Configuration File

MAC provides, as a template, a default PPM Center adapter configuration file 
named ppm-sm-adapter.settings1. The adapter file you configure and use 
must have a .settings file extension. 

Copy the default adapter file (to preserve the original), and rename the copy 
with a .settings file extension and, if desired, a different file name.

As detailed in subsequent sections, the adapter file has the following basic 
structure, including adapter attributes, and properties for its connector, 
converter, and sender:

<?xml version="1.0" encoding="UTF-8"?>
<settings>

<adapter adapter-name="<adapter name>">
<service-desk-application><SD application>

</service-desk-application>
<number-of-tickets><number of tickets></number-of-tickets>
<polling-schedules><schedule></polling-schedules>
<polling-frequency><frequency></polling-frequency>

<request-types>
<request-type level="1">
<polling-operation>

<connector>
<connector-type>PPMRequest</connector-type>

<properties>
sdSystemName=
requestType=
datePattern=
userName=
password=
sdSystemFieldName=
idProperty=
updateTimeField=
createTimeField=
requestStatusNames=

</properties>
</connector>

<converter>
<converter-type>scriptConverter</converter-type>

<properties>
scripts=<convert1,convert2,...>

</properties>
</converter>
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</polling-operation>
</request-type>
</request-types>

<sender>
<sender-type>serviceManagerSender</sender-type>

<properties>
userName=
password=
queryDateFormatPattern=
timeZone=
keyMethodName=
serviceUrl=
staticFieldNames=
idProperty=

</properties>
</sender>

</adapter>

</settings>

The following sections describe how to configure the adapter attributes, the 
connector properties, the converter property (scripts), and the sender 
properties.

Configuring the PPM Center Adapter Attributes

Specify the adapter attributes of the PPM Center adapter configuration file, 
such as the adapter name and the service desk application, as described in 
Table 4-4.

Do not delete or change the values provided for <connector-type>, 
<converter-type>, or <sender-type>. 
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Table 4-4. PPM Center adapter attributes

Attribute Name 
(*Required) Description Default Value

*adapter-name

A logical name that represents the 
adapter name on the client 
machine. For example:
ppm-adapter
This name is also used for the 
scripts (.ext) directory. (See 
Location and Naming of the PPM 
Center Adapter Configuration File 
on page 129.)

(None)

*service-desk-application

A unique, logical name for the PPM 
Center system you are using. 
For example:
PPM 

(None)

number-of-tickets The number of tickets that the 
adapter processes at a time. 50

polling-schedules

The times of day that the adapter 
polls PPM Center for changes, 
formatted as a list of cron 
expressions separated by the new 
line character. 
For example: 
30 * * * * <new line> 0 * * * *

(None)

polling-frequency
The frequency (in seconds) that the 
adapter polls PPM Center for 
changes.

If 
polling-schedules 
and 
polling-frequency 
are unspecified, 
then the default 
polling-frequency 
is 30 seconds, 
starting when 
you restart the 
PPM Server.
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Configuring the PPM Center Adapter Connector Properties

Specify the properties for the connector section of the PPM Center adapter 
configuration file as described in Table 4-5. 

Table 4-5. PPM Center adapter connector properties (page 1 of 2)

Property Name
(*Required) Description Default Value

*sdSystemName

The name of the adapter from which 
changes are imported into PPM Center as 
requests. Must be the same value as 
specified for the service-desk-application 
property in the Service Manager adapter 
(see Table 4-1 on page 117).
For example:
Service Manager 
or 
ServiceCenter

(None)

*requestType

The PPM Center request type that should 
be created for the converted changes.
For example:
MAC - Request For Change (RFC)

(None)

datePattern

The date format for the date field. Use the 
Java simple date format, which is 
described at:
http://java.sun.com/j2se/1.4.2/docs/api/
java/text/SimpleDateFormat.html

yyyy-MM-dd
HH:mm:ss

*userName The user name in PPM Center by whose 
credentials requests are created. (None)

*password

The password of the userName.
This password should be encrypted using 
the PPM Center script kEncrypt.sh, 
which is located in the bin directory of the 
PPM Server. Encrypted passwords must 
be created in a CDATA section.

(None)
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Configuring the PPM Center Adapter Converter Property (Script)

The converter section of the PPM Center adapter configuration file contains 
the scripts property. The script file is written in the JavaScript language. The 
script maps the fields from the PPM Center data model to the Service Manager 
data model, and filters the requests.

The scripts property is a script file name in the format:

scripts=<convert1>

This file must reside in the same directory as the adapter, namely:

<PPM_Home>/conf/sdi/<adapter name>.ext

where <adapter name> is as defined in Table 4-4 on page 132.

*sdSystemFieldName

The field in PPM Center containing the 
Service Manager or ServiceCenter system 
name. It is presented in the PPM Center 
request as the System Name field in the 
Service Desk Info section.

(None)

*idProperty
The property name of the ID field in the 
instance returned from the Service 
Manager Web service.

(None)

*updateTimeField
The field in PPM Center that represents 
the time the request was updated in PPM 
Center.

(None)

*createTimeField
The field in PPM Center that represents 
the time the request was created in PPM 
Center.

(None)

requestStatusNames

A list of PPM Center request statuses, 
separated by semicolons (;). Only 
requests with the statuses you specify are 
retrieved from PPM Center for processing. 
However, if you do not specify any 
statuses, all requests are retrieved.

(None)

Table 4-5. PPM Center adapter connector properties (page 2 of 2)

Property Name
(*Required) Description Default Value
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The conversion script is responsible for field mapping during the conversion of 
requests in the PPM Center data model to change updates in the Service 
Manager data model, and for filtering the requests and change updates. 

The script must contain the convert function and can contain the preFilter 
and postFilter functions, as follows: 

preFilter. The following function filters the changes before they are 
converted to the Service Manager data model, so that no unnecessary 
requests are converted:

preFilter(ppmRFC)

convert. After identifying the Service Manager change attributes that need 
to be updated from the PPM Center requests, use the convert function of 
the conversion script to map fields of PPM Center requests to fields of 
Service Manager changes.

The following convert function uses the mapping you specify to convert 
the fields of the request in PPM Center to the fields of the change in 
Service Manager:

convert(ppmRFC, smChange)

postFilter. The following function filters the converted change updates, so 
that only the desired updates will be applied to the corresponding change in 
Service Manager:

postFilter(smChange)

MAC provides a default conversion script named convertRequest.js in the 
<PPM_Home>/conf/sdi/ppm-sm-adapter.ext directory. 

Use the syntax described in the following sections for the conversion script 
APIs. 

Make sure that no line in a script exceeds 256 characters.

Multiple scripts are supported, using a comma-separated list, as in:

scripts=<convert1,convert2,...>

The adapter searches for these conversion script files in the adapter directory.
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ppmRFC Object

The ppmRFC object represents the PPM Center request. For the preFilter 
and convert script functions, use the following function to retrieve request 
fields from PPM Center:

get(String fieldName);

smChange Object

The smChange object represents the Service Manager ticket. For the convert 
and postFilter script functions, use the following functions to modify the 
ticket fields:

Reference ID

You must use the following function to track the Service Manager change 
ID in the PPM Center request:

setRefId(String referenceId);

Time Stamp

You must use the following function to set the last update time in the PPM 
Center request:

/**
* Set the time stamp in long format—that is, the number of 
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setUpdatedTimeStamp(long updatedTimeStamp);
/**
* Set the time stamp in the Java simple date format, which is 
* described at the following location: 
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setUpdatedTimeStamp(String updatedTimeStamp, String format);
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General Field

Use the following function to set a value of a general field in the PPM 
Center request:

setField (String fieldName, String value);

Date

Use the following function to set a value of a date field in the PPM Center 
request:

/**
* Set the date in long format—that is, the number of 
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setDateValue(String fieldName, long date);
/**
* Set the date in the Java simple date format which is
* described in the following location:
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setDateValue(String fieldName, String date, String format);
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Configuring the PPM Center Adapter Sender Properties

Specify the properties for the sender section of the PPM Center adapter 
configuration file as described in Table 4-6. The sender controls updating 
changes in Service Manager with the converted data.

Table 4-6. PPM Center adapter sender properties (page 1 of 2)

Property Name 
(*Required) Description Default 

Value

*userName

The user name in the Service Manager 
system that PPM Center uses to connect to 
Service Manager.
This user must have full access to the 
Change Management module in Service 
Manager.

(None)

*password

The password in the Service Manager 
system that PPM Center uses to connect to 
Service Manager. 
This password should be encrypted using the 
PPM Center script kEncrypt.sh, which is 
located in the bin directory of the PPM 
Server. Encrypted passwords must be 
created in a CDATA section.

(None)

*queryDateFormatPattern

The date format used for querying the 
Service Manager system (as used in the UI 
expert search). 
For available formats see: 
http://java.sun.com/j2se/1.4.2/docs/api/java/
text/SimpleDateFormat.html

(None)

*timeZone

The Service Manager server time zone, used 
for converting the last updated time of a 
request from Service Manager. 
The format can be GMT+X or GMT–X, where 
X is the offset in hh:mm format from GMT. 
For example, GMT–07:00.
However, to handle Daylight Saving Time, 
use an area time zone instead of specifying a 
time relative to GMT.

(None)
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The sender is the last section of the adapter configuration file. Make sure the 
file ends with the following: 

</adapter>
</settings>

*keyMethodName The name of the method for request keys 
(usually the ID field name). (None)

*serviceUrl

The Web service URL of Service Manager or 
ServiceCenter.
For Service Manager, the format is:
http://<Service_Manager_Host>:<Port>/
sc62server/PWS/
where <Service_Manager_Host> represents 
the host machine where Service Manager is 
running.
For ServiceCenter, the format is:
http://<ServiceCenter_Host>:<Port>/
sc61server/ws/
where <ServiceCenter_Host> represents the 
host machine on which ServiceCenter is 
running.

(None)

*staticFieldNames
(Applicable and required 
only for bi-directional 
integration.)

A list of PPM Center fields (separated by 
semicolons) that are not to be updated when 
changes are made to their mapped Service 
Manager fields. 
This list is used to prevent inappropriate 
update of PPM Center requests for 
bi-directional integration. For example, to 
prevent a request from being updated when 
the last update time in Service Manager 
changes, specify:
sysmodtime

(None)

idProperty
The property name of the ID field in the 
instance returned from the Service Manager 
Web service.

(None)

Table 4-6. PPM Center adapter sender properties (page 2 of 2)

Property Name 
(*Required) Description Default 

Value
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This completes the configuration of the PPM Center adapter file.

Configuring server.conf Parameters

Add and specify the parameters related to Service Manager or ServiceCenter 
integration to the PPM Center server.conf configuration file (for more 
information about the steps in this procedure, see the System Administration 
Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

3. Restart the PPM Server.

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.

Parameter Value

ENABLE_MAC_SERVICE Set this parameter to true. 

MAC_SERVICE_INTERVAL
Specify how often the MAC service is to be 
run, in seconds (the default is 900, which is 
15 minutes).

MAC_LOG_SEVERITY

Specify the level of logging to be used. 
When set to 0 (the default), only integration 
exceptions (errors) and a summary are 
logged. When set to 1, non-error events 
related to the processing of changes are 
also logged. See Error and Non-Error Log-
ging on page 141.
140 Chapter 4



Verifying that MAC Service Starts

Verify that the MAC Startup Service has started, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Administration > Open Workbench. 

The PPM Workbench opens.

3. From the shortcut bar, select Sys Admin > Server Tools. 

The Admin Tools window opens. 

4. From the drop-down list, select Service Controller Report. 

5. Click Submit. 

6. Review the report to verify that the MAC Startup Service is running.

7. If a date was specified in the initial-load-state Service Manager (or 
ServiceCenter) adapter attribute in order to retrieve existing Service 
Manager (or ServiceCenter) changes from that date forward, they will be 
retrieved, converted, and sent to PPM Center, but then no new Service 
Manager (or ServiceCenter) changes will be retrieved. In this case, to 
retrieve Service Manager (or ServiceCenter) changes on an ongoing basis:

a. Stop the PPM Server.

b. Comment out the initial-load-state Service Manager (or 
ServiceCenter) adapter attribute.

c. Restart the PPM Server.

d. Repeat step 1 through step 6 to verify that the MAC Startup Service is 
running.
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Error and Non-Error Logging

As described in the following sections, logging is essential for ensuring correct 
operation of the integration. You can specify two types of logging for Service 
Manager or ServiceCenter integration:

System-level logging using a summary logs table and a log details table. 
See System-Level Logging.

Configurable logging for conversion scripts. See Configurable Logging for 
Conversion Scripts on page 145.

System-Level Logging

System-level logging is the only way to administer the integration on an 
ongoing basis. HP recommends creating a portlet or a report to regularly query 
and display the logging tables and help you identify potential problems.

You can configure MAC to log only errors for integration exceptions and a 
summary, or to also log entries for non-error events related to the processing of 
changes. For information about setting the server.conf parameter that 
controls the level of logging (MAC_LOG_SEVERITY), see Configuring 
server.conf Parameters on page 140. 

Setting the MAC_LOG_SEVERITY parameter to 0 causes the summary logs table 
(SDI_SUMMARY_LOGS) to include only a summary of errors. Setting this 
parameter to 1 causes the summary logs table to also include information about 
tickets as they are being processed. 

The summary logs table maintains only one row for each unique combination 
of the TICKET_ID and ADAPTER_NAME columns. See Summary Logs Table 
on page 142. Each row is updated on an ongoing basis as status changes.

The log details table (SDI_LOG_DETAILS) includes details about the errors that 
have a value of Y in the MESSAGES column of the summary logs table. See 
Log Details Table on page 144. (The setting of the MAC_LOG_SEVERITY 
parameter in the server.conf file does not affect the contents of the log 
details table.) 
142 Chapter 4



Summary Logs Table

The columns in the summary logs table (SDI_SUMMARY_LOGS) that contain 
useful information are described in Table 4-7. 

Table 4-7. Summary logs table (SDI_SUMMARY_LOGS) (page 1 of 2)

Column Description

LOG_ID The primary key for this table.

TICKET_ID
The ticket ID imported using the connector. In some 
cases such as connection errors or authentication 
failures, the value is SUMMARY. 

STATUS

The current state of the ticket. Possible values are:
Retrieved/Not processed. The ticket was retrieved 
and has not been processed. 
preFilter Passed. The ticket passed the preFilter 
function and was sent to the convert function.
Rejected in preFilter. The ticket did not pass 
preFilter criteria. 
Ticket converted. The ticket passed the convert 
function and was sent to the postFilter function. 
postFilter Passed. The ticket passed the 
postFilter function and was sent to the sender 
function. 
Rejected in postFilter. The ticket did not pass the 
postFilter function. 
Error occurred in JavaScript. An exception occurred 
in the preFilter, convert, or postFilter 
function when processing the convert.js JavaScript 
file. 
Ticket processed. The ticket was created in the target 
system. 
Errors occurred when sending the ticket. An 
exception occurred and the ticket could not be sent to 
the sender. 

LAST_UPDATE_DATE The last time the ticket was updated in PPM Center.

COMPONENT The component that logged the message—the connector, 
converter, or sender. 
Integration of PPM Center with Service Manager or ServiceCenter 143



Log Details Table

The log details table (SDI_LOG_DETAILS) includes the details described in 
Table 4-8 for the errors that have a value of Y in the MESSAGES column of the 
summary logs table. 

ADAPTER_NAME The service desk name in the adapter settings file.

MESSAGES 
If the value is Y, further details for this log entry are 
provided in the log details table (SDI_LOG_DETAILS). If 
the value is N, no further details are provided.

IN_PROCESS If Y, processing of this ticket is complete. If N, processing 
of this ticket is not yet complete.

Table 4-7. Summary logs table (SDI_SUMMARY_LOGS) (page 2 of 2)

Column Description

Table 4-8. Log details table (SDI_LOG_DETAILS)

Column Description

LOG_DETAIL_ID The primary key for this table.

LOG_ID The foreign key to the entry in the SDI_SUMMARY_LOGS table.

DETAILS The detailed error message captured when the error occurred.
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Configurable Logging for Conversion Scripts

Configurable logging is useful for debugging your integration mapping. 
During testing, you can specify log messages that appear at key points in the 
conversion script to indicate correct or incorrect conversion. Before deploying 
the integration to production, you would typically want to comment out the 
messages for correct operation so they do not quickly accumulate in the logs.

If you want to view log messages describing the activity that occurs during the 
request conversion process, you can include logging objects in your conversion 
scripts. During the conversion process, you can view the log messages in the 
conversion script log files, located in the <PPM_Home>/script-logs directory. 
Each adapter logs messages in a separate log file. The names of the log files are 
based on the names of the adapters for which they log errors.

A logging object can be included within any of the script functions. Its syntax 
should be as follows:

logger.<type of message>("<log message>");

The following message types can be used:

info. Records all processing activity that is performed.

warn. Records warning messages.

error. Records error messages.

For example, you can include a logging object such as:

logger.info("Processing ticket " +
serviceCenterRFC.get("header.changeNumber"));

If you want the conversion script log files to display a list of all service desk 
application fields, you can include the following logging object in your 
conversion script:

logger.info(BeanUtils.describe(ticket));

If you use this logging object, make sure the following line is included at the 
beginning of the conversion script:

importPackage(Packages.org.apache.commons.beanutils);

Logging is also controlled by the severity specified in the PPM Center 
logging.conf file.
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5 Integration of PPM Center with Remedy 
Introduction to Integration of PPM Center with Remedy 

For an overview of the integration of PPM Center with the BMC Remedy 
Action Request System, see Integration of PPM Center with Service Desk 
Applications on page 22. 

The integration is enabled by a configurable Remedy adapter file in PPM 
Center along with the request types and workflows provided by MAC, so that 
PPM Center acts as a single repository for application-related requests for 
change (RFCs). The adapter converts changes (tickets) in Remedy to requests 
for change (RFCs), and then imports those RFCs into PPM Center for 
processing. 

A separate adapter file is required for each mapping between a Remedy change 
and a PPM Center request type. MAC provides one default Remedy adapter 
file.

The integration runs as a service in the PPM Server. As described later, the 
configuration of an adapter file controls various aspects of its import process. 

This chapter describes how to configure the Remedy adapter in PPM Center 
and the Remedy application for integration. It is intended for Remedy 
administrators or for PPM Center system administrators who are also familiar 
with Remedy. 

For information about the supported version of Remedy, see Versions of 
Service Desk Applications Supported for Integration with PPM Center 
on page 21.
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For information about the MAC - Request For Change (RFC) request type in 
PPM Center that is used to establish integration of PPM Center with Remedy, 
see MAC - Request For Change (RFC) Request Type on page 40.

For references to more information about Remedy, see Remedy Documentation 
on page 29.

Conversion of Remedy Changes to PPM Center Requests for Change

Figure 5-1 depicts the flow for converting a change in Remedy to a MAC 
request for change (RFC), and importing the RFC into PPM Center.

Figure 5-1. Using the Remedy adapter to import changes from Remedy into PPM 
Center

Integration of PPM Center with Remedy is supported only when PPM Center is 
running on Windows. For information on the Windows versions that PPM Center can 
use, see the System Requirements and Compatibility Matrix. 

No software needs to be installed on the Remedy server to integrate PPM Center and 
Remedy. However, see Versions of Service Desk Applications Supported for 
Integration with PPM Center on page 21.
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The Remedy adapter consists of the following three components:

Connector. Collects changes from the Remedy system.

Converter. Uses field mapping to convert the changes from the Remedy 
data model in which they were created to RFCs for the PPM Center data 
model.

The converter also contains two optional filters to control which changes 
are imported into PPM Center. The preFilter filters out categories of 
changes you specify in the Remedy data model before they are converted. 
After the Remedy changes are converted to RFCs, the postFilter filters out 
categories of requests you specify before they are presented to the sender.

Sender. Using the RFC data from the converter, creates the RFCs in PPM 
Center.

Overview of Configuring the Remedy Integration

Before configuring the integration, you must identify the Remedy data 
attributes that will be integrated with PPM Center, including which of the 
attributes of Remedy changes to send to PPM Center.

Before you can begin importing changes from Remedy into PPM Center, you 
must configure Remedy and configure the Remedy adapter in PPM Center to 
enable integration. The procedures are summarized as follows: 

Copy particular files from the Remedy installation directory to the PPM 
Server.

Configure the Remedy adapter configuration file on the PPM Server. MAC 
provides a default Remedy adapter configuration file.

Configure the required server.conf parameters in PPM Center.

Restart the PPM Server in normal mode and verify that the MAC service 
has started.

Configure logging of errors and events.
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Copying Files from Remedy to PPM Center

To connect to Remedy, the integration requires copying particular files from 
the Remedy installation directory to the PPM Server, as follows: 

1. Copy the following .jar files from the Remedy installation directory to 
<PPM_Home>\server\<PPM_Server_Name>\deploy\itg.war\WEB-INF\
lib:

arapi50.jar 

arutil50.jar 

where

2. Create a new directory named RemedyDLLs under the <PPM_Home>\
conf\sdi directory on the PPM Server.

3. Copy the following .dll files from the Remedy installation directory to 
the RemedyDLLs directory:

arapi50.dll 

arjni50.dll 

arrpc50.dll 

arutl50.dll 

4. Set the PATH environment variable to point to the RemedyDLLs directory.

<PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/
PPMServer.

<PPM_Server_Name> represents the value specified for the KINTANA_
SERVER_NAME parameter in the server.conf file 
during installation (not necessarily the actual host 
name of the server).
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Configuring the Remedy Adapter Configuration File

The Remedy adapter configuration file is an XML file in PPM Center that 
enables integration of Remedy with PPM Center and converts Remedy 
changes to PPM Center requests. The configuration file consists of the 
following components, each with its own attributes or properties (see 
Figure 5-1 on page 148):

General settings for the adapter itself, such as its name and the name of the 
Remedy application in which the changes (tickets) are created.

The connector between Remedy and the adapter.

The converter of changes in the Remedy data model to generic requests in 
the PPM Center data model. The converter calls the scripts that define the 
field mapping and filter functions.

The PPM Center sender, which sends the converted and filtered requests to 
PPM Center. 

The following sections describe how to configure the Remedy adapter 
configuration file and the scripts called by its converter, and how to modify 
copies of the provided files while preserving the originals. 

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>\sdi-persistency directory and the <PPM_Home>\conf\sdi 
directory among all the servers in the cluster.
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Location, Naming, and Structure of Remedy Adapter Configuration Files

Each Remedy adapter configuration file must follow specific conventions for 
its location, naming, and structure, as described in the following sections.

Location and Naming of the Remedy Adapter Configuration File

The adapter configuration files are located in the <PPM_Home>\conf\sdi 
directory of the PPM Server. This directory contains:

A configuration file for the adapter (or one for each adapter if there are 
multiple adapters). 

In this configuration file, you define a name for the adapter. The 
configuration file must have a .settings file extension.

A subdirectory (or one for each adapter configuration file if there are 
multiple files). 

The subdirectory contains the conversion scripts, which are called by the 
converter to map the fields between the tickets and requests and to filter 
them. The name of the subdirectory must be the same as the <adapter 
name> (for a description, see Structure of the Remedy Adapter 
Configuration File on page 152 and Table 5-1 on page 154) followed by 
.ext. 

For example, if the adapter name is remedy-adapter, the  
<PPM_Home>\conf\sdi directory must contain a subdirectory named 
remedy-adapter.ext to hold all the conversion script files for the adapter.

Structure of the Remedy Adapter Configuration File

MAC provides, as a template, a default Remedy adapter configuration file 
named remedy-adapter.settings1. The adapter file you configure and use 
must have a .settings file extension. 

Copy the default adapter file (to preserve the original), and rename the copy 
with a .settings file extension and, if desired, a different file name.

As detailed in subsequent sections, the adapter file has the following basic 
structure, including adapter attributes, and properties for its connector, 
converter, and sender:
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<?xml version="1.0" encoding="UTF-8"?>
<settings>

<adapter adapter-name="<adapter name>">
<service-desk-application><SD application>

</service-desk-application>
<number-of-tickets><number of tickets></number-of-tickets>
<polling-schedules><schedule></polling-schedules>
<polling-frequency><frequency></polling-frequency>
<initial-load-state><date></initial-load-state>

<request-types>
<request-type level="1">
<polling-operation>

<connector>
<connector-type>remedy</connector-type>

<properties>
serverName=
serverTcpPort=
serverRpcNum=
userName=
userPassword=
schemaName=
fieldNames=

</properties>
</connector>

<converter>
<converter-type>scriptConverter</converter-type>

<properties>
scripts=<convert1,convert2,...>

</properties>
</converter>

</polling-operation>
</request-type>
</request-types>

<sender>
<sender-type>PPMSender</sender-type>

<properties>
userName=
password=>
requestType=
updateRequest=
ticketIdFieldName=
sdSystemFieldName=

</properties>
</sender>

</adapter>

</settings>
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The following sections describe how to configure the adapter attributes, the 
connector properties, the converter property (scripts), and the sender 
properties.

Configuring the Remedy Adapter Attributes

Specify the adapter attributes of the Remedy adapter configuration file, such as 
the adapter name and the service desk application, as described in Table 5-1.

Do not delete or change the values provided for <connector-type>, 
<converter-type>, or <sender-type>. 

Table 5-1. Remedy adapter attributes (page 1 of 2)

Attribute Name 
(*Required) Description Default Value

*adapter-name

A logical name that represents the 
adapter name on the client 
machine. For example:
remedy-adapter
This name is also used for the 
scripts (.ext) directory. (See 
Location and Naming of the 
Remedy Adapter Configuration File 
on page 152.)

(None)

*service-desk-application

A unique, logical name for the 
service desk system you are using. 
For example:
Remedy AR System 

(None)

number-of-tickets The number of tickets that the 
adapter processes at a time. 50
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polling-schedules

The times of day that the adapter 
polls Remedy for changes, 
formatted as a list of cron 
expressions separated by the new 
line character. 
For example: 
30 * * * * <new line> 0 * * * *

(None)

polling-frequency The frequency (in seconds) that the 
adapter polls Remedy for changes.

If 
polling-schedules 
and 
polling-frequency 
are unspecified, 
then the default 
polling-frequency 
is 30 seconds, 
starting when 
you restart the 
PPM Server.

initial-load-state

The earliest creation date and time 
of changes the adapter retrieves 
from Remedy, in the format: 
MM/dd/yy HH:mm:ss z
For example:
10/19/08 21:30:00 EST
After completion, the adapter does 
not retrieve any new or updated 
changes (per the polling-schedules 
and polling-frequency attributes) 
until this attribute is commented out.

(None)

Table 5-1. Remedy adapter attributes (page 2 of 2)

Attribute Name 
(*Required) Description Default Value
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Configuring the Remedy Adapter Connector Properties

Specify the properties for the connector section of the adapter configuration 
file as described in Table 5-2. 

Table 5-2. Remedy adapter connector properties

Property Name
(*Required) Description Default 

Value

*serverName The name of the Remedy server. (None)

serverTcpPort The TCP port of the Remedy server. 0

serverRpcNum The RPC number of the Remedy server. 0

*userName

The user name in the Remedy system that 
PPM Center uses to connect to Remedy.
This user must have full access to the Change 
Management module in Remedy.

(None)

*userPassword

The password in the Remedy system that PPM 
Center uses to connect to Remedy. 
This password should be encrypted using the 
PPM Center script kEncrypt.sh, which is 
located in the bin directory of the PPM Server. 
Encrypted passwords must be created in a 
CDATA section.

(None)

*schemaName
The name of the schema containing the 
Remedy changes. 
Do not change the default value.

CHG:Change

*fieldNames
A comma-separated list of the fields in the 
Remedy changes to retrieve.
Use * to collect all the fields.

(None)
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Configuring the Remedy Adapter Converter Property (Script)

The converter section of the Remedy adapter configuration file contains the 
scripts property. The script file is written in the JavaScript language. The 
script maps the fields from the Remedy data model to the PPM Center data 
model, and filters the requests.

The scripts property is a script file name in the format:

scripts=<convert1>

This file must reside in the same directory as the adapter, namely:

<PPM_Home>\conf\sdi\<adapter name>.ext

where <adapter name> is as defined in Table 5-1 on page 154.

The conversion script is responsible for field mapping during the conversion of 
changes in the Remedy data model to generic requests in the PPM Center data 
model, and for filtering the changes and requests. 

The script must contain the convert function and can contain the optional 
preFilter and postFilter functions, as follows: 

preFilter. The following function filters the changes before they are 
converted to the PPM Center data model, so that no unnecessary requests 
are converted:

preFilter(remedyTicket)

For example, the following preFilter function specifies that Remedy 
changes with a Low priority will not be converted and that all other 
requests will be converted:

Make sure that no line in a script exceeds 256 characters.

Multiple scripts are supported, using a comma-separated list, as in:

scripts=<convert1,convert2,...>

The adapter searches for these conversion script files in the adapter directory.
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function preFilter(remedyTicket){
if (remedyTicket.get("Request Urgency")==ARS_PRIORITY_

LOW)
return false;

else
return true;

}

convert. After identifying the PPM Center request attributes that are 
required for Remedy changes, use the convert function of the conversion 
script to map fields of Remedy changes to fields of PPM Center requests.

The following convert function uses the mapping you specify to convert 
the fields of the change in Remedy to the fields of the request in PPM 
Center:

convert(remedyTicket, ppmRFC)

postFilter. The following function filters the converted requests, so that 
only the desired requests will be imported into PPM Center:

postFilter(ppmRFC)

For example, the following postFilter function specifies that only PPM 
Center requests with a status of Approved will be sent to the PPM Server:

function postFilter(ppmRFC){
ppmStatus==ppmRFC.getField("status");
if (ppmStatus==STATUS_APPROVED)

return true;
else

return false;
}

MAC provides a default conversion script named convert.js in the  
<PPM_Home>\conf\sdi\remedy-adapter.ext directory. 

Use the syntax described in the following sections for the conversion script 
APIs. 

remedyTicket Object

The remedyTicket object represents the Remedy change. For the preFilter 
and convert script functions, use the following function to retrieve fields from 
the Remedy ticket:

get(String fieldName);
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ppmRFC Object

The ppmRFC object represents the PPM Center request. For the convert and 
postFilter script functions, use the following functions to modify the PPM 
Center request fields:

Reference ID

You must use the following function to track the Remedy change ID in the 
PPM Center request:

setRefId(String referenceId);

Time Stamp

You must use the following function to set the last update time in the PPM 
Center request:

/**
* Set the time stamp in long format—that is, the number of 
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setUpdatedTimeStamp(long updatedTimeStamp);
/**
* Set the time stamp in the Java simple date format, which is 
* described at the following location: 
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setUpdatedTimeStamp(String updatedTimeStamp, String format);

Status

Use the following function to change the status of the PPM Center request 
and allow the workflow of the request to advance:

setStatus(String newStatus)

To view or change the set of statuses provided with PPM Center, open the 
request type in the PPM Workbench, select the Request Status tab, and 
click Request Status. For more information, see the HP Demand 
Management Configuration Guide. 
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General Field

Use the following function to set the value of a general field in the PPM 
Center request:

setField (String fieldName, String value);

Date

Use the following function to set the value of a date field in the PPM 
Center request:

/**
* Set the date in long format—that is, the number of
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setDateValue(String fieldName, long date);
/**
* Set the date in the Java simple date format which is
* described in the following location:
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setDateValue(String fieldName, String date, String format);

Notes to be added upon creation of a PPM Center request

Use the following function to add a note upon creation of a PPM Center 
request:

addUserNoteOnCreate(String content, String addedBy,
long time;

Notes to be added upon update of a PPM Center request

Use the following function to add a note upon update of a PPM Center 
request:

addUserNoteOnUpdate(String content, String addedBy,
long time;
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Configuring the Remedy Adapter Sender Properties

Specify the properties for the sender section of the adapter configuration file as 
described in Table 5-3. The sender controls creating RFCs in PPM Center with 
the converted data.

Table 5-3. Remedy adapter sender properties (page 1 of 2)

Property Name 
(*Required) Description Default 

Value

*userName The user name in PPM Center by whose 
credentials requests are created. (None)

*password

The password of the userName.
This password should be encrypted using the 
PPM Center script kEncrypt.sh, which is 
located in the bin directory of the PPM Server. 
Encrypted passwords must be created in a 
CDATA section.

(None)

*requestType

The PPM Center request type that should be 
created for the converted changes.
For example:
MAC - Request For Change (RFC)

(None)

updateRequest

If set to true, enables updates made to 
Remedy changes to be automatically sent to 
existing PPM Center requests.
HP recommends retaining the default value of 
false because usually, after Remedy changes 
are converted to PPM Center requests, 
processing takes place entirely in PPM Center.

false
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The sender is the last section of the adapter configuration file. Make sure the 
file ends with the following: 

</adapter>
</settings>

This completes the configuration of the Remedy adapter configuration file.

*ticketIdFieldName a

The field in PPM Center containing the Remedy 
ticket ID. It is presented in the PPM Center 
request as the Ticket Id field in the Service 
Desk Info section.

(None)

*sdSystemFieldName a

The field in PPM Center containing the Remedy 
system name. It is presented in the PPM Center 
request as the System Name field in the 
Service Desk Info section.

(None)

a. If PPM Center is integrated with multiple Remedy servers, the combination of values in the 
ticketIdFieldName and sdSystemFieldName properties ensures that all the tickets from all the 
Remedy servers are uniquely identified in PPM Center.

Table 5-3. Remedy adapter sender properties (page 2 of 2)

Property Name 
(*Required) Description Default 

Value

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>\sdi-persistency directory and the <PPM_Home>\conf\sdi 
directory among all the servers in the cluster.
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Configuring server.conf Parameters

Add and specify the parameters related to Remedy integration to the PPM 
Center server.conf configuration file (for more information about the steps 
in this procedure, see the System Administration Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

3. Restart the PPM Server.

Parameter Value

ENABLE_MAC_SERVICE Set this parameter to true. 

MAC_SERVICE_INTERVAL
Specify how often the MAC service is to be 
run, in seconds (the default is 900, which is 
15 minutes).

MAC_LOG_SEVERITY

Specify the level of logging to be used. 
When set to 0 (the default), only integration 
exceptions (errors) and a summary are 
logged. When set to 1, non-error events 
related to the processing of changes are 
also logged. See Error and Non-Error Log-
ging on page 165.
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Verifying that MAC Service Starts

Verify that the MAC Startup Service has started, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Administration > Open Workbench. 

The PPM Workbench opens.

3. From the shortcut bar, select Sys Admin > Server Tools. 

The Admin Tools window opens. 

4. From the drop-down list, select Service Controller Report. 

5. Click Submit. 

6. Review the report to verify that the MAC Startup Service is running.

7. If a date was specified in the initial-load-state Remedy adapter 
attribute in order to retrieve existing Remedy changes from that date 
forward, they will be retrieved, converted, and sent to PPM Center, but 
then no new Remedy changes will be retrieved. In this case, to retrieve 
Remedy changes on an ongoing basis:

a. Stop the PPM Server.

b. Comment out the initial-load-state Remedy adapter attribute.

c. Restart the PPM Server.

d. Repeat step 1 through step 6 to verify that the MAC Startup Service is 
running.
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Error and Non-Error Logging

As described in the following sections, logging is essential for ensuring correct 
operation of the integration. You can specify two types of logging:

System-level logging using a summary logs table and a log details table. 
See System-Level Logging.

Configurable logging for conversion scripts. See Configurable Logging for 
Conversion Scripts on page 168.

System-Level Logging

System-level logging is the only way to administer the integration on an 
ongoing basis. HP recommends creating a portlet or a report to regularly query 
and display the logging tables and help you identify potential problems.

You can configure MAC to log only errors for integration exceptions and a 
summary, or to also log entries for non-error events related to the processing of 
changes. For information about setting the server.conf parameter that 
controls the level of logging (MAC_LOG_SEVERITY), see Configuring 
server.conf Parameters on page 163. 

Setting the MAC_LOG_SEVERITY parameter to 0 causes the summary logs table 
(SDI_SUMMARY_LOGS) to include only a summary of errors. Setting this 
parameter to 1 causes the summary logs table to also include information about 
tickets as they are being processed. 

The summary logs table maintains only one row for each unique combination 
of the TICKET_ID and ADAPTER_NAME columns. See Summary Logs Table 
on page 166. Each row is updated on an ongoing basis as status changes.

The log details table (SDI_LOG_DETAILS) includes details about the errors that 
have a value of Y in the MESSAGES column of the summary logs table. See 
Log Details Table on page 167. (The setting of the MAC_LOG_SEVERITY 
parameter in the server.conf file does not affect the contents of the log 
details table.) 
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Summary Logs Table

The columns in the summary logs table (SDI_SUMMARY_LOGS) that contain 
useful information are described in Table 5-4. 

Table 5-4. Summary logs table (SDI_SUMMARY_LOGS) (page 1 of 2)

Column Description

LOG_ID The primary key for this table.

TICKET_ID
The ticket ID imported using the connector. In some 
cases such as connection errors or authentication 
failures, the value is SUMMARY. 

STATUS

The current state of the ticket. Possible values are:
Retrieved/Not processed. The ticket was retrieved 
and has not been processed. 
preFilter Passed. The ticket passed the preFilter 
function and was sent to the convert function.
Rejected in preFilter. The ticket did not pass 
preFilter criteria. 
Ticket converted. The ticket passed the convert 
function and was sent to the postFilter function. 
postFilter Passed. The ticket passed the 
postFilter function and was sent to the sender 
function. 
Rejected in postFilter. The ticket did not pass the 
postFilter function. 
Error occurred in JavaScript. An exception occurred 
in the preFilter, convert, or postFilter 
function when processing the convert.js JavaScript 
file. 
Ticket processed. The ticket was created in the target 
system. 
Errors occurred when sending the ticket. An 
exception occurred and the ticket could not be sent to 
the sender. 

LAST_UPDATE_DATE The last time the ticket was updated in PPM Center.

COMPONENT The component that logged the message—the connector, 
converter, or sender. 
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Log Details Table

The log details table (SDI_LOG_DETAILS) includes the details described in 
Table 5-5 for the errors that have a value of Y in the MESSAGES column of the 
summary logs table. 

ADAPTER_NAME The service desk name in the adapter settings file.

MESSAGES 
If the value is Y, further details for this log entry are 
provided in the log details table (SDI_LOG_DETAILS). If 
the value is N, no further details are provided.

IN_PROCESS If Y, processing of this ticket is complete. If N, processing 
of this ticket is not yet complete.

Table 5-4. Summary logs table (SDI_SUMMARY_LOGS) (page 2 of 2)

Column Description

Table 5-5. Log details table (SDI_LOG_DETAILS)

Column Description

LOG_DETAIL_ID The primary key for this table.

LOG_ID The foreign key to the entry in the SDI_SUMMARY_LOGS table.

DETAILS The detailed error message captured when the error occurred.
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Configurable Logging for Conversion Scripts

Configurable logging is useful for debugging your integration mapping. 
During testing, you can specify log messages that appear at key points in the 
conversion script to indicate correct or incorrect conversion. Before deploying 
the integration to production, you would typically want to comment out the 
messages for correct operation so they do not quickly accumulate in the logs.

If you want to view log messages describing the activity that occurs during the 
request conversion process, you can include logging objects in your conversion 
scripts. During the conversion process, you can view the log messages in the 
conversion script log files, located in the <PPM_Home>\script-logs directory. 
Each adapter logs messages in a separate log file. The names of the log files are 
based on the names of the adapters for which they log errors.

A logging object can be included within any of the script functions. Its syntax 
should be as follows:

logger.<type of message>("<log message>");

The following message types can be used:
info. Records all processing activity that is performed.
warn. Records warning messages.
error. Records error messages.

For example, you can include a logging object such as:

logger.info("Processing ticket " + remedyRFC.get
("ChangeID+"));

If you want the conversion script log files to display a list of all service desk 
application fields, you can include the following logging object in your 
conversion script:

logger.info(BeanUtils.describe(ticket));

If you use this logging object, make sure the following line is included at the 
beginning of the conversion script:

importPackage(Packages.org.apache.commons.beanutils);

Logging is also controlled by the severity specified in the PPM Center 
logging.conf file.
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6 Integration of PPM Center with Mercury 
Application Mapping 
Introduction to Integration of PPM Center with Mercury 
Application Mapping 

Mercury Application Mapping consists of a business-service-oriented data 
model with built-in discovery of configuration items (CIs) and their 
dependencies, visualization and mapping of business services, and tracking of 
configuration changes. When you integrate PPM Center with Mercury 
Application Mapping, you can run Impact Analysis Reports from change 
requests in PPM Center, to determine which components of a system will be 
affected by a software change, and to what extent. Impact analysis becomes an 
integral part of the workflow when you process a change request. The 
integration assists IT managers and Change Advisory Boards in deciding 
whether a change request should be approved for development or deployment. 

You can perform the following impact analysis tasks from a PPM Center 
request: 

Run impact analysis. 

View Impact Analysis Reports.

Compare different Impact Analysis Reports to detect changes in the 
production system.

Impact analysis shows you which components of your production system will 
be affected (impacted) when you deploy a software change, and to what extent.
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For example, your software change might involve upgrading a database server. 
Before you can perform the upgrade, you need to stop the server. In some cases 
this could prevent users from accessing crucial services, or even cause a crash 
of your production system. Impact analysis determines the effect on the entire 
system of stopping the server, and gives you a report showing the components 
that will be impacted. This enables you to plan the change with minimal 
disturbance to your operations.

For more information about the benefits of this integration, see Integration of 
PPM Center with HP Universal CMDB and/or Mercury Application Mapping 
on page 24.

For information about the versions supported for integration, see Versions of 
Mercury Application Mapping Supported for Integration with PPM Center 
on page 21.

For references to more information about Mercury Application Mapping, see 
Mercury Application Mapping Documentation on page 29.

Using Impact Analysis in a Change Request Lifecycle

Impact analysis is useful at various stages in the lifecycle of a change request. 
This means that you typically want to generate an Impact Analysis Report at 
several points in time as the request is processed.

Since a software change might be developed and deployed over a lengthy 
period of time, it is useful to have workflow steps that generate an Impact 
Analysis Report at the following stages in the lifecycle of the change request:

Before you approve or develop the change. Before you approve or 
develop the change, it is useful to forecast the effect that introducing the 
change will have on your production system. You describe the intended 
change, specify the components that you think will be affected, and run 
impact analysis to forecast the effect of the change. 

No software needs to be installed on the Mercury Application Mapping server to 
integrate PPM Center and Mercury Application Mapping. However, see Versions of 
Mercury Application Mapping Supported for Integration with PPM Center on page 21.
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The resulting report gives you an indication of how your system will cope 
with the change after it has been developed and deployed, and helps you 
decide whether to approve the change for development.

After the change is approved for deployment to a production system, 
but before you deploy the change. While the software change is being 
developed and then evaluated for quality, modifications may occur in your 
system infrastructure. For example, servers might be added or removed, or 
applications might be changed. As a result, the original impact analysis 
may no longer give an accurate indication of what will happen when you 
introduce the change. So after the change has been developed, evaluated, 
and approved for deployment, you perform another impact analysis to give 
you an up-to-date picture. 

You then run the Mercury Application Mapping comparison feature to 
compare the two Impact Analysis Reports and show which components 
have undergone changes since the previous report was generated. This 
allows you to ensure that any changes that may have been made to the 
system while you were developing the software change will not have an 
adverse effect on the system when you deploy the change.

PPM Center Components for the Integration

As described in Using the Integration on page 176, the integration uses the 
following entities for impact analysis:

The MAC - Request for Change workflow, which calls a subworkflow that 
calls the MAC - Impact & Resource Assessment Sub WF subworkflow, 
which includes steps that access the MAM impact analysis functions. See 
MAC - Request For Change Workflow on page 49.

The associated MAC - Request for Change (RFC) request type, integrating 
with Mercury Application Mapping. See MAC - Request For Change 
(RFC) Request Type on page 40.

The Impact Analysis section in the request. See MAC - Request For 
Change (RFC) Request Type on page 40, in particular Table 3-2 
on page 43.
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Configuring Mercury Application Mapping for the Integration

Perform the procedures in this section to configure Mercury Application 
Mapping for the integration.

Configuring Views and Creating a PPM Center User and Password

Configure MAM views and create a PPM Center user and password in 
Mercury Application Mapping. See the Mercury Application Mapping 
documentation, listed in Mercury Application Mapping Documentation 
on page 29.

Enabling Impact Analysis in the appilogConfig.properties File

Verify that impact analysis is enabled in Mercury Application Mapping as 
follows:

1. In Mercury Application Mapping, navigate to the following file:

<MAM_Home>/root/lib/server/appilogConfig.properties 

where <MAM_Home> represents the directory where Mercury Application 
Mapping is installed.

2. To enable impact analysis, set the parameter values in this file as shown in 
the following table: 

3. Navigate to http://<MAM_Home>:8080/jmx-console, click the 
service=View System link, and in the window that opens, click the Invoke 
button for the reloadServerConfiguration option.

appilogConfig.properties Parameter Value

impact.analysis.disabled false 

impact.analysis.read.only true 

impact.analysis.allow.ci.edit true 
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Configuring PPM Center for the Integration

Before beginning to configure the integration as described in the following 
sections, make sure that MAC has been installed and initially configured as 
described in Chapter 2, Installing and Setting Up MAC Software, on page 31.

Establishing Server Connections for Supported Versions

Make sure that the HTTP port is open between the PPM Server and Mercury 
Application Mapping machines. 

Verify that a supported version of Mercury Application Mapping is installed 
and running (see Versions of Mercury Application Mapping Supported for 
Integration with PPM Center on page 21).
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Copying .jar Files from Mercury Application Mapping to PPM Center

Copy required .jar files from Mercury Application Mapping to PPM Center 
as follows:

1. Stop the PPM Server.

2. In Mercury Application Mapping, navigate to the following directory:

<MAM_Home>/j2f/AppServer/webapps/site.war/statis/mamJars 

3. Copy the following files from the directory specified in step 2 to the  
<PPM_Home>/server/<PPM_Server_Name>/deploy/itg.war/WEB-INF/
lib directory in PPM Center:

AllClasses.jar 

hacapi.jar 

logworkaround.jar 

cmdb_client.jar (located in the CMDB subdirectory of mamJars)

cmdb_server.jar (located in the CMDB subdirectory of mamJars)

cmdb_shared.jar (located in the CMDB subdirectory of mamJars)

where

<PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/
PPMServer.

<PPM_Server_Name> represents the value specified for the KINTANA_
SERVER_NAME parameter in the server.conf file 
during installation (not necessarily the actual host 
name of the server).
174 Chapter 6



Specifying server.conf Parameters in PPM Center

Add and specify the parameters related to Mercury Application Mapping 
integration to the PPM Center server.conf configuration file (for more 
information about the steps in this procedure, see the System Administration 
Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

3. Restart the PPM Server.

Parameter Value

MAM_MACHINE_URL

The URL of the Mercury Application 
Mapping server:
http://<MAM_Host>:8080/webapp/ 
where <MAM_Host> represents the host 
machine on which Mercury Application 
Mapping is running.

MAM_MACHINE_VERSION

Specify 6.2 for all supported versions of 
Mercury Application Mapping (see 
Versions of Mercury Application Mapping 
Supported for Integration with PPM 
Center on page 21).

MAM_MACHINE_USER The Mercury Application Mapping user 
name, for example, admin.

MAM_MACHINE_PASSWORD

The Mercury Application Mapping user 
password.
This password must be encrypted as 
described in Encrypting the Password 
Specified as a server.conf Parameter.
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Encrypting the Password Specified as a server.conf Parameter

The password that you assigned to the MAM_MACHINE_PASSWORD parameter 
must be encrypted, as follows:

1. Navigate to the <PPM_Home>/bin directory.

2. Run the kEncrypt.sh utility.

3. Specify the password you want to encrypt.

The utility encrypts the password and displays the encrypted text, as in the 
following example that shows how the password value of Administrator is 
encrypted:

$ ./kEncrypt.sh 

Enter value to encrypt:

Administrator 

--- Algorithm ----------------------------------------------
El Gamal (public key file: D:/ITG_MAM_INTG/security/public_
key.txt)

--- Plain text ---------------------------------------------
Administrator

--- Encrypted text -----------------------------------------
#!#1lr(107I7i+?nQJ0/Ehd5k{IMNmw$8bF4nmrjLQ$=I/{hLV0-Sq
DZON{Opp d}N 4*bu?t/1Jk&MjZYY3h1Zt$c.09Oh?n5V01+yc7l
vn95L-0cS+b<qMQ.f+`d)bPmoN&(gU>+M8+6+7gVPq:~6#!#

4. Copy the text in the Encrypted text section and paste it as the value for 
MAM_MACHINE_PASSWORD in the server.conf file, making sure that you do 
not copy any carriage returns into the file. In the example of step 3, the 
parameter in the server.conf file would appear as follows:

com.kintana.core.server.MAM_MACHINE_PASSWORD=
#!#1lr(107I7i+?nQJ0/Ehd5k{IMNmw$8bF4nmrjLQ$=I/{hLV0-Sq
DZON{Opp d}N 4*bu?t/1Jk&MjZYY3h1Zt$c.09Oh?n5V01+yc7l
vn95L-0cS+b<qM_Q.f+`d)bPmoN&(gU>+M8+6+7gVPq:~6#!#
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Using the Integration 

This section describes how to use the workflow steps that allow you to access 
the Mercury Application Mapping impact analysis capabilities.

The impact analysis workflow steps allow you to run the Mercury Application 
Mapping impact analysis functions from within a PPM Center workflow. 
These functions include generating Impact Analysis Reports and viewing the 
differences between reports generated at different times.

The Configuration Management Database (CMDB) in Mercury Application 
Mapping contains information about all your configuration items (servers, 
applications, hosts, and so on) and their relationships. Configuration items 
(CIs) can vary widely in complexity, size, and type, from an entire system 
(including all hardware, software, and documentation) to a single module or 
minor hardware component.

For example, the CMDB contains information about which CIs are affected 
when other CIs stop functioning or have operational problems.

You generally perform impact analysis as follows:

Select the CIs that you suspect might be affected by the planned software 
change.

Run impact analysis on the selected CIs. Impact analysis analyzes the 
relationships among the selected CIs in the CMDB, and generates a report 
showing the CIs that will be affected by the planned change.

Run impact analysis at additional points in the workflow, and compare the 
reports generated by the different runs.

HP recommends using CI names in Mercury Application Mapping that will be 
meaningful to you in PPM Center.
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You establish the impact analysis steps at various places in your workflow 
where it is useful to know the impact that your change will have on your 
system. For example, you might want to perform impact analysis at the 
following points:

Before approving a change, to forecast the effect that the change will have 
on your system.

After the change has been created, in case your system infrastructure has 
changed since the previous impact analysis was performed.

By default, the MAC - Request For Change workflow step 8 (see 
MAC - Request For Change Workflow on page 49) calls the MAC - Change 
Review and Approval Sub WF subworkflow (see MAC - Change Review and 
Approval Sub WF Subworkflow on page 56). 

Step 4 of this subworkflow in turn calls the MAC - Impact & Resource 
Assessment Sub WF subworkflow (see MAC - Impact & Resource Assessment 
Sub WF Subworkflow on page 58). In this subworkflow, if the Automatic 
method is selected in step 2, Impact Analysis Mode, the subworkflow uses the 
following steps for impact analysis:

3. Select CIs. In this step, the user selects the CIs (for example, servers, 
applications, and hosts) in Mercury Application Mapping, and indicates 
that the CIs have been selected.

4. Run Impact Analysis. This step runs the Mercury Application Mapping 
impact analysis function.

5. Review Impact Analysis. After the Run Impact Analysis step, the 
workflow automatically advances to this step, where the user can view the 
Impact Analysis Report.

These steps are described in detail in the following sections.

Also, the MAC - Request For Change workflow step 31, Delete Impact 
Analysis RFC, causes Mercury Application Mapping to delete the RFCs it 
created each time the status of the PPM Center request became Ready for 
Impact Analysis. 
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Select CIs Subworkflow Step

In this step, the user selects the CIs that will be part of the change. This is the 
first stage in performing the impact analysis. When the MAC - Impact & 
Resource Assessment Sub WF subworkflow advances to this step, the top of 
the request looks similar to Figure 6-1.

Figure 6-1. Top of example request when at Select CIs subworkflow step

The request includes an Impact Analysis section (see Figure 6-2), where you 
select the CIs on which you want to perform impact analysis. The CI Selection 
button is enabled when the request is at the appropriate workflow step.

Figure 6-2. Impact Analysis section of a request before selection of CIs

Click CI Selection to display the Mercury Application Mapping window for 
selecting CIs (see the example in Figure 6-3). The window opens in either 
Normal or Read-Only mode, depending on your user credentials. Normal 
mode allows you to select CIs, remove CIs, and save the list of selected CIs. 
Read-only mode allows you to view the list of selected CIs, but not to make 
any changes to the list.

The Launch HP Release Control button or the Launch HP Change Control 
Management button appears if PPM Center is also integrated with HP Release 
Control or HP Change Control Management, as described in Chapter 8, 
Integration of PPM Center with Release Control or Change Control 
Management, on page 263.
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Figure 6-3. Example Mercury Application Mapping window to select CIs

In this example, IPs 192.168.121.0 and 192.168.137.0 have been selected for 
impact analysis.

After you select the CIs and save the selection, the request shows the number 
of selected CIs, as in Figure 6-4.

Figure 6-4. Impact Analysis section of a request after selection of CIs

You can now either:

Click CI Selection again to view or make changes to the list of selected CIs.

Click Ready for Impact Analysis as an available action for the Select CIs 
step at the top of the request to continue to the Run Impact Analysis step, 
which performs impact analysis on the selected CIs.

For details about how to use the CI Selection window, see the Mercury Application 
Mapping documentation (listed in Mercury Application Mapping Documentation 
on page 29).
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Run Impact Analysis Subworkflow Step

This step runs impact analysis on the CIs that were selected in the Select CIs 
step. It is positioned in the subworkflow after the CIs have been selected.

Clicking Ready for Impact Analysis in the Select CIs step (see Figure 6-1 
on page 179) causes the MAC - Impact & Resource Assessment Sub WF 
subworkflow to advance to the Run Impact Analysis step. This runs the 
Mercury Application Mapping impact analysis on the selected CIs and 
generates an Impact Analysis Report that shows all the impacted CIs and the 
severity of each impact.

After Mercury Application Mapping has completed the impact analysis, the 
workflow automatically advances to the Review Impact Analysis step.

Review Impact Analysis Subworkflow Step

In this step, the Change Advisory Board (CAB) reviewer evaluates the request, 
the list of selected CIs, and the Impact Analysis Report, and decides whether to 
approve or reject the change. He can also compare two reports. 

Each time an impact analysis is run, a new Impact Analysis Report is attached 
to the request under Impact Analysis Results in its Impact Analysis section, and 
you can compare any two reports run at various times.

An example of the Impact Analysis section of the request with access to two 
reports is shown in Figure 6-5, with its fields and buttons described in 
Table 6-1.

Figure 6-5. Impact Analysis section of a request after running two 
Impact Analysis Reports
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Table 6-1. Impact Analysis section of request

Field, Heading, or Button Description

Configuration Items Selection

The number of configuration items (CIs) on which 
the Impact Analysis Report was based. the list of 
CIs is displayed in the Selected CIs tab in the 
Impact Analysis Report.

CI Selection button
Displays the Mercury Application Mapping window 
for selecting CIs (see the example in Figure 6-3 
on page 180).

Last Impact Analysis Report 
Severity

The highest severity among the CIs in the most 
recent listed Impact Analysis Report.

Impact Analysis Results Heading above the reports that were generated 
after running impact analyses.

Open button

Click to open the window for the Mercury 
Application Mapping Impact Analysis Report having 
the adjacent name. Figure 6-7 on page 184 shows 
an example. 

Compare button Click to compare two Impact Analysis Reports. See 
Comparing Impact Analysis Reports on page 187.

Launch HP Change Control 
Management button

Click to open HP Change Control Management. 
The Change Advisory Board uses HP Change 
Control Management to determine whether or not 
the release should go to production. For details, 
see Chapter 8, Integration of PPM Center with 
Release Control or Change Control Management, 
on page 263 and the HP Change Control 
Management User’s Guide. 
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For information about reviewing and comparing Impact Analysis Reports, see 
Reviewing Impact Analysis Reports on page 184 and Comparing Impact 
Analysis Reports on page 187.

At this Review Impact Analysis subworkflow step, the top of the request is as 
shown in Figure 6-6.

Figure 6-6. Top of example request at Review Impact Analysis step

The CAB reviewer clicks one of the following buttons:

Completed if he now knows whether to accept or reject the change.

Redo CI Selection if he needs to generate and evaluate more Impact 
Analysis Reports based on a different set of CIs. 

When the review of the reports is complete, the MAC - Impact & Resource 
Assessment Sub WF subworkflow returns to the MAC - Change Review and 
Approval Sub WF Subworkflow, where it proceeds to step 5, CAB Approval, 
where the change advisory board can approve or reject the change.
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Reviewing Impact Analysis Reports

Figure 6-7 shows an example Impact Analysis Report.

Figure 6-7. Example Impact Analysis Report

The Severity field in the upper left of the Impact Analysis Report shows the 
highest severity of this report.

The Impact Analysis Report shows the impacted CIs and the severity of each 
CI. It contains the following tabs:

Impacted CIs by View. A list of affected CIs in preconfigured views. The 
Mercury Application Mapping user creates views for different types of CIs 
(for example, SAM App, Finance App, and so forth).
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Impacted CIs by CIT. A list of affected CIs in a CIT (Configuration Item 
Type) view. Each CI has a type, which indicates whether it is a host, a 
router, or a database (for example, Oracle® or NT). Each CIT that contains 
at least one CI is displayed in the report, along with the list of CIs with their 
types.

Selected CIs. A list of the CIs on which the impact analysis report was 
based.

Filtering Results in an Impact Analysis Report

To filter an Impact Analysis Report to include only CIs of specific CITs:

1. In the report, click the Filter icon at the upper right of the report, below the 
Selected CIs tab (see Figure 6-7 on page 184).

The Filter by CIT window opens.

2. Move CIs as necessary between the CITs not in the result box and the CITs 
in the result box, using the left and right arrows for individual CIs and the 
double left and right arrows for all CIs. CIs whose CIT is in the CITs not in 
the result box are excluded from the report.

In the Select CIs workflow step, if you selected items that are not CIs, for 
example, map views, these items also appear in the Selected CIs tab, even 
though impact analysis was not run on them.
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Modifying the Default Parameters of the Filter

A PPM Center administrator can change the default filters for an Impact 
Analysis Report by changing the default parameters of the filter as defined in 
the ImpactFilter.xml file, located in the <PPM_Home>/conf directory of 
PPM Center. 

The default format of the ImpactFilter.xml file is as follows:

<?xml version="1.0" encoding="UTF-8"?>
<ImpactAnalysis>

<filter type="CIT" enabled="true">
<item name="nt">nt</item>
<item name="host">host</item>

</filter>
</ImpactAnalysis>

To modify the default parameters of the filter in the ImpactFilter.xml file:

1. In <filter type="CIT" enabled=>, specify:

"false" to display all CIT instances in the Impact Analysis Report

"true" to display only the CIT instances as defined in <item name=>

2. In <item name=>, specify the name of the CIT whose instances you want 
to appear in the report. If <filter type="CIT" enabled=> is set to true, 
then the report displays only the CITs defined here.

In the example ImpactFilter.xml file above, only instances of nt and 
host appear in the Impact Analysis Report.

When an administrator modifies the ImpactFilter.xml file, the changes take effect 
in the report immediately, without having to restart the PPM Server.
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Comparing Impact Analysis Reports

Each time you run an impact analysis, a new Impact Analysis Report is created 
and added to the list in the request, as in Figure 6-8. To compare two reports, 
select the two reports you want to compare and click Compare. 

Figure 6-8. Impact analysis results with two reports to be compared

Mercury Application Mapping compares the reports and generates the Impact 
Analysis Comparison Report, as in the example in Figure 6-9. You can 
compare only two Impact Analysis Reports in one Impact Analysis 
Comparison Report.

Figure 6-9. Example Impact Analysis Comparison Report
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The State column indicates one of the following conditions for each CI:

Added, if the CI appears in the later report and not the earlier one.

Deleted, if the CI appears in the earlier report and not the later one.

Changed, if the severity of the CI is different in the two reports.
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7 Integration of PPM Center with Quality 
Center 
Introduction to Integration of PPM Center with Quality Center 

Integrating PPM Center with Quality Center enables you to create Quality 
Center requirements and defects while using PPM Center. This allows users of 
both applications to participate in the processing of defects, change requests, 
and release requests. 

In PPM Center, a request type is a template, and when you create a request, 
you must select a request type. With integration, creating the request also 
automatically creates a defect or requirement in the Quality Center project to 
which the PPM Center request type is mapped as part of configuring the 
integration. For example, a PPM Center request of type Defect could create a 
defect in Quality Center project A, whereas a PPM Center request of type 
RequestForChange could create a requirement in Quality Center project B. 

When an IT manager or business liaison enters a change request or creates a 
release comprising a group of change requests in PPM Center, PPM 
Center–Quality Center integration causes a requirement to be created in 
Quality Center. This informs QA personnel that they should begin the QA 
process.

PPM Center–Quality Center integration allows ongoing synchronization 
between fields such as status fields that have been mapped in a request for 
change in PPM Center and the corresponding defect or requirement in Quality 
Center.

Upon completion of the QA process, the IT manager or business liaison is 
notified via the PPM Dashboard and can complete the deployment process.
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A software tool with wizards is provided to simplify the integration process, 
including mapping fields in PPM Center requests to fields in Quality Center 
projects.

One PPM Server can work with multiple Quality Center projects, even projects 
on multiple Quality Center servers. 

For more information about the benefits of this integration, see Integration of 
PPM Center with HP Quality Center on page 25 and Benefits and 
Functionality of the Integration.

For information about versions supported for integration, see Versions of HP 
Quality Center Supported for Integration with PPM Center on page 22. 

For references to more information about HP Quality Center, see HP Quality 
Center Documentation on page 30.

Benefits and Functionality of the Integration

Integrating PPM Center and Quality Center provides the following benefits to 
users of each application:

Data sharing. The integration allows data sharing between PPM Center 
and Quality Center. Business managers and IT personnel using PPM 
Center gain visibility into how a project is affected by both the quality 
control process and the parameters that are collected in Quality Center. 
They can use Quality Center capabilities when creating requests for 
changes.

Inclusion of Quality Center data in the workflow. The PPM Center 
workflow is a well-defined process that allows IT managers to plan, track, 
and deploy software enhancements. Integration allows customers to build 
their own workflows and steps in PPM Center while using fields and data 
from Quality Center. The Quality Center defect resolution capabilities 
become part of the workflow. This makes the quality process an integral 
and formal part of the IT processes.

No software needs to be installed on the Quality Center server to integrate PPM 
Center and Quality Center. However, see Versions of HP Quality Center Supported 
for Integration with PPM Center on page 22.
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QA-dependent workflow progression. Progress from one step in the 
workflow to the next can be made dependent on progress by the QA team. 
PPM Center shows the IT manager how a project is affected by the quality 
defects that are collected in Quality Center. The IT manager can view the 
information from Quality Center and decide whether a defect has been 
resolved or an enhancement can be deployed. Drill-down capabilities 
between PPM Center and Quality Center provide more detailed data than 
each application provides separately.

Direct activation of processes, and creation of Quality Center 
requirements and defects from PPM Center. Processes can be activated 
by PPM Center—creating a request in PPM Center also creates a defect or 
requirement in Quality Center when the relevant step in the PPM Center 
workflow is activated. When you create a new request in PPM Center of a 
type that is synchronized with Quality Center, you can select the Quality 
Center server on which a corresponding requirement or defect gets created.

Synchronization of mapped field values between PPM Center and 
Quality Center. When fields are mapped between a PPM Center request 
type and a Quality Center defect or requirement, changing the value of a 
mapped field in one application can automatically change the value of the 
corresponding field in the other application. For example, when you 
change a status of a defect to Fixed in PPM Center, one of the provided 
execution steps changes the status in the corresponding Quality Center 
project to Fixed. 

Users can specify that one of the following occurs for a pair of mapped 
fields:

o Changing the field in Quality Center automatically changes the field in 
PPM Center to the same value, that is, Quality Center is dominant for 
the mapped pair.

o Changing the field in PPM Center automatically changes the field in 
Quality Center to the same value, that is, PPM Center is dominant for 
the mapped pair.

o Changing the field in either application automatically changes it in the 
other, that is, the mapping is bi-directional.
Integration of PPM Center with Quality Center 191



For synchronization of defects:

o Developers can use PPM Center to manage the defect-fixing process, 
while QA personnel continue to use Quality Center.

o Project managers and IT managers can view all the defects in the 
system, whether they originated in PPM Center or in Quality Center. 
This helps the managers to decide on content for the next release or 
new requirements and enhancements.

o QA personnel can use Quality Center to manage defects created 
through PPM Center.

Request hierarchy synchronization. The hierarchical structure of 
requirements in Quality Center can be synchronized with the structure of 
the corresponding requests in PPM Center.

Synchronization of the PPM Center Notes field. The integration allows 
you to synchronize the PPM Center Notes to be added on save field with a 
field in Quality Center. When you update the content of the field in a PPM 
Center request, the corresponding field is updated in Quality Center.

MAC - Defect Template with Quality Center Integration Request Type

The PPM Center request type provided for the Quality Center integration is the 
MAC - Defect Template with Quality Center Integration request type. It uses 
only the MAC - Defect Template with Quality Center Integration workflow, 
and you cannot choose a different workflow. This prevents you from 
inadvertently using a workflow that is not enabled for integration.

The integration also uses the general purpose MAC - Release Management 
request type (see MAC - Release Management Request Type on page 77).

Figure 7-1 shows the Create New MAC - Defect Template with Quality Center 
Integration page that appears when you create a request and select the 
MAC - Defect Template with Quality Center Integration request type. 

Although you can create new request types from scratch, HP recommends that you 
use the provided request type as a template to create them. In the PPM Workbench, 
you can copy the provided request type and modify the copy. If you create your own 
request types to integrate PPM Center and Quality Center, make sure you use 
workflows that are enabled for integration.
You can also create a new request type with a customized request header type.
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Table 7-1 describes the fields in the Defect Template with Quality Center 
Integration request, including some fields that do not appear until the request is 
created or until other conditions are met.

Figure 7-1. MAC - Defect Template with Quality Center Integration request
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Table 7-1. MAC - Defect Template with Quality Center Integration request fields 
(page 1 of 2)

Field Name (*Required) Description

Summary section

Request No. (Added after the request is created.) The number of 
the request.

Created On (Added after the request is created.) The date the 
request was created.

*Summary Summary description of the request.

Department The department to which the user belongs.

Created By The user who created the request.

*Severity The severity of the defect.

Assigned To The developer assigned to work on the defect.

Detected in Version Version of the application in which the defect was 
detected.

Assigned Group The group responsible for addressing the defect.

Defect Priority The priority of the defect.

Application The application in which the defect was discovered.

Reproducible Whether the defect is reproducible.

Request Status The status of the request.

Quality Center Defect Information section a

*Quality Center Instance The Quality Center instance that will receive the 
new PPM Center request.

*Quality Center Domain The Quality Center domain of the working project.

*Quality Center Project The Quality Center project that is linked with this 
request type.

Detected in Quality Center by The user in Quality Center who detected the defect.

Defect Number (Added after the defect is created in Quality 
Center.) The defect number in Quality Center.
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Quality Center Defect Status (Added after the defect is created in Quality 
Center.) The status of the defect in Quality Center.

Quality Center Message

(Read only; added after the defect is created in 
Quality Center.) Message indicating whether the 
last update to the request was successfully 
synchronized in the Quality Center defect, or an 
error message if synchronization failed.

Quality Center Attachments The URL of the attached requirement document.

Planned vs. Actual section

Planned Closing Version The version of the application targeted to have the 
defect fix.

Closed in Version The version of the application that has the defect 
fix.

Estimated Fix Time (days) The original estimate of the number of days it would 
take to fix the defect.

Actual Fix Time (days) The actual number of days it took to fix the defect.

Closed on The date the defect was closed in Quality Center.

Defect Information section

Detailed Description Detailed description of the defect.

Developer Comments Developer comments regarding the defect.

a. Fields in the Quality Center Defect Information section remain visible by default but are not used if 
PPM Center is not integrated with HP Quality Center.

Table 7-1. MAC - Defect Template with Quality Center Integration request fields 
(page 2 of 2)

Field Name (*Required) Description

The administrator can remove the Quality Center Defect Information section from 
the request type by removing the Quality Center Defect Information field group from 
the MAC - Defect Template with Quality Center Integration request header type. 
See the HP Demand Management Configuration Guide for details about request 
header types and field groups.
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To submit a MAC - Defect Template with Quality Center Integration request:

1. Log on to PPM Center.

2. From the menu bar, select Demand Management > Create a Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
MAC - Defect Template with Quality Center Integration and click Create. 

The Create New MAC - Defect Template with Quality Center Integration 
page appears, displaying the appropriate release request fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the request can be entered and stored. Typically, when creating a request, 
you do not need to add a note to it. However, add a note if you want to 
convey additional information to the reviewers and processors of the 
request.

In the References section, add any references to the request. It can be 
useful to reference a Web-accessible file or attach a document or file from 
a local machine to the release request. For more information about adding 
references, see the HP Demand Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The request is submitted. The Request Creation Confirmed page appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
see the detail page of the newly generated request. 

PPM Center can be configured to allow you to save the request before it is 
submitted. To have this feature enabled, see your application administrator.
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When the request is submitted, it is assigned an initial status, such as New. It is 
then routed along the MAC - Defect Template with Quality Center Integration 
workflow (see MAC - Defect Template with Quality Center Integration 
Workflow on page 198).

Request Header Types

By default, when you create a new request type from a provided one, the new 
request type uses the same request header type as the provided request type 
uses.

When creating a new request type, you can:

Use the supplied request header type without changing it.

Copy the request header type, customize the copy, and use it in the new 
request type.

Create a completely new request header type.

If you create a new request header type, add the required integration fields by 
selecting the appropriate field group, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Administration > Open Workbench. 

The PPM Workbench opens.

3. From the shortcut bar, select Demand Mgmt > Request Header Types. 

The Request Header Type Workbench opens. 

4. In the Request Header Type Workbench, click New Request Header Type. 

The Request Header Type window opens.

5. Click Field Groups. 

The Field Groups window lists the available field groups.

Your request header type must include the Quality Center fields that appear in the 
provided request header type. If you customize a request header type, make sure you 
do not delete the Quality Center fields.
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6. Select the appropriate field group:

For a defect header, select the Quality Center Defect Information field 
group.

For a request for change header, select the Quality Center Info field 
group.

MAC - Defect Template with Quality Center Integration Workflow

For integration of PPM Center with Quality Center, MAC provides the MAC - 
Defect Template with Quality Center Integration workflow, which includes 
execution steps to create a defect or requirement in Quality Center. You can 
use this workflow as a template for creating your own workflows.

Although you can create new workflows from scratch, HP recommends that 
you create them from this template. To create a new workflow, you use the 
PPM Workbench to create a copy of a provided workflow, and then modify the 
copy (add, delete, or change its steps) to suit your needs.

The integration also uses the general purpose MAC - Release Request 
workflow to create a release entity that includes several requests for change. 
This workflow can be used for ITIL purposes whether or not PPM Center is 
integrated with other applications. For more information, see MAC - Release 
Request Workflow on page 83.

The MAC - Defect Template with Quality Center Integration workflow is used 
to create a defect and to track how the defect is resolved. See Figure 7-2 and 
workflow step 5, Defect Verification.
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Figure 7-2. MAC - Defect Template with Quality Center Integration workflow

When a request of type MAC - Defect Template with Quality Center 
Integration is created in PPM Center, the first step in the workflow creates a 
defect in Quality Center. Subsequent steps cause the defect status in Quality 
Center to change to Open, Reopen, Fixed or Closed, depending on the stage in 
the PPM Center workflow.

Types of Workflow Steps

As with any PPM Center workflow, the MAC - Defect Template with Quality 
Center Integration workflow can contain the following types of steps:

Decision steps. Steps that require action from the user in order to proceed. 
When the user reaches the decision step, he sees what his choices are. Each 
choice causes the workflow to proceed in a different manner. For example, 
at one decision step in a workflow, a project manager might be offered the 
choice of either deploying a package or sending it back to QA for more 
testing.
Integration of PPM Center with Quality Center 199



Condition steps. Steps that determine the direction that the workflow 
takes.

Execution steps. Steps that are automated through PPM Center. For 
example, an execution step might create a requirement or defect in Quality 
Center, execute a script, or run a build.

MAC provides two execution steps that can be used in PPM Center to build a 
workflow for integration of PPM Center with Quality Center. The execution 
steps create a defect or a requirement in Quality Center.

PPM Center-Quality Center Integration Tool

Integration requires installing the PPM Center-Quality Center Integration Tool 
on any Windows machine that can open HTTP connections to the PPM Server 
and to the Quality Center server. This tool enables Quality Center projects for 
integration and maps PPM Center fields to Quality Center fields.

When the user enables a Quality Center project for integration using the PPM 
Center-Quality Center Integration Tool, the tool performs one of the following 
actions:

If the project is new, the tool creates Quality Center lists and adds Quality 
Center workflow scripts to the user’s existing scripts.

If the project already exists, the tool updates some of the Quality Center 
lists so that they contain the same values as they would for a new project.

The lists and Quality Center scripts create a Quality Center project that can 
work as is with the provided PPM Center components.

As described in the following sections, the integration tool changes the value 
lists and workflow enforcement in a Quality Center project to enable it for 
integration.
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Changes to Value Lists

For a new project, the integration tool adds two new value lists and adds a new 
value to an existing default value list, as follows:

A new Requirement Status list is added. It contains the following values: 

o New

o Cancelled

o Closed

o 1-Requirements Setup Completed

o 2-Test Plan Setup Completed

o 3-Test Lab Setup Completed

o 4-Running Tests in Quality Center

o 5-Test Execution Completed

o 6-Running Sanity Tests in Quality Center

o 7-Sanity Testing Completed

A new Test Level list is added. It includes the following values:

o Functional

o Integration

o Regression

o Sanity

A value of Deleted is added to the Bug Status list.

For an existing project, these lists are updated or added as necessary to contain 
the same values as they would for a new project.
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Workflow Enforcement

The PPM Center-Quality Center Integration Tool will update the Quality 
Center project workflow to enforce the following constraints on Quality Center 
entities:

Defect. The user can make only the following status changes:

o Fixed to Closed

o Rejected to Closed

o Fixed to Reopen

Requirement. The user can make only the following status changes: 

o New to 1-Requirements Setup Completed

o 1-Requirements Setup Completed to 2-Test Plan Setup Completed

o 2-Test Plan Setup Completed to 3-Test Lab Setup Completed

o 4-Running Tests in Quality Center to 5-Test Execution Completed

o 6-Running Sanity Tests in Quality Center to 7-Sanity Testing 
Completed
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Overview of Installation and Configuration Process

The procedures for configuring PPM Center and Quality Center for integration 
are described in detail in the following sections, and are summarized as 
follows:

Install the PPM Center-Quality Center Integration Tool. This tool enables a 
Quality Center project for integration and maps PPM Center fields to 
Quality Center fields in an XML mapping.

Configure integration of a Quality Center project by:

o Using the PPM Center-Quality Center Integration Tool to enable a 
Quality Center project for integration.

o Using the PPM Center-Quality Center Integration Tool to create a 
mapping between PPM Center fields and Quality Center fields.

o Mapping the Notes field in an existing project.

o Using the PPM Center-Quality Center Integration Tool to deploy the 
mapping to PPM Center and Quality Center.

o Configuring a new project if you want to integrate both existing and 
new defects in a Quality Center project.

Configure PPM Center for integration, including specifying server.conf 
parameters.

As necessary, use the request type and workflow provided as templates in 
MAC to create your own PPM Center request types and workflows enabled 
for integration of PPM Center with Quality Center.

Configure request hierarchy synchronization, if desired.
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Installing the PPM Center-Quality Center Integration Tool

Integration requires installing the PPM Center-Quality Center Integration Tool 
on a Windows machine that can open HTTP connections to the PPM Server 
and to the Quality Center server.

To install this tool:

1. Copy the PPM Center-Quality Center Integration Tool setup.exe file to a 
Windows machine that can open HTTP connections to the PPM Server and 
to the Quality Center server. This file is located in the PPM Server at: 

<PPM_Home>/integration/mac/ppmqcintegrationtool

where <PPM_Home> represents the path where your PPM Center instance is 
installed. For example: xyzserver/E/PPMServer. 

2. Double-click the setup.exe file to launch the InstallShield wizard.

By default, the tool gets installed in the C:/Program Files/
Hewlett-Packard/PPM Center-Quality Center Integration Tool 
directory.

3. Follow the instructions in the wizard. When the installation completes, do 
not launch the PPM Center-Quality Center Integration Tool yet.

Proceed to Configuring a Quality Center Project for the Integration 
on page 204.

Uninstalling the Integration Tool

If you want to uninstall the PPM Center-Quality Center Integration Tool (for 
example, to be able to run it only from another Windows machine), select 
Start > Settings > Control Panel > Add/Remove Programs and follow the 
instructions on the screen.

You use the tool to create an initial mapping between PPM Center fields and 
Quality Center fields (or to revise an existing mapping). Before you uninstall 
the tool, remember to use it to deploy the mapping to both PPM Center and 
Quality Center simultaneously. 
204 Chapter 7



Configuring a Quality Center Project for the Integration

Before beginning this configuration, verify that the ENABLE_WEB_SERVICES 
parameter in the PPM Center server.conf configuration file is set to true to 
enable use of Web services with PPM Center (for more information about the 
steps in this procedure, see the System Administration Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./kConfig.sh 

3. Restart the PPM Server. 

As documented in the following sections, you establish PPM Center–Quality 
Center integration independently for each Quality Center project as needed, 
using wizards in the PPM Center-Quality Center Integration Tool to: 

Enable a Quality Center project for integration.

Create the XML mapping file between PPM Center and Quality Center 
fields. 

Deploy this mapping file to PPM Center and Quality Center.

You might also need to manually map the Notes field in a PPM Center request 
to the Quality Center project.

Enabling a Quality Center Project for the Integration

Use the PPM Center-Quality Center Integration Tool to enable a Quality 
Center project for the integration as described in this section.

HP strongly recommends that you enable a project only once, otherwise problems 
might occur in the integration. There is no reason to enable a project twice. You can 
use the integration tool to change the configuration of a project at any time.
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To enable a Quality Center project for integration:

1. From the Windows Start menu, select All Programs > Hewlett-Packard > 
PPM Center-Quality Center Integration Tool. 

The main PPM Center-Quality Center Integration Tool window opens.

2. Select File > PPM Center Settings. 

The PPM Center Settings window opens.
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3. In the Host field, type the URL of the PPM Server.

4. In the Administrator User Name and Administrator Password fields, type 
the PPM Center user name and password.

5. Click Test Connection to test the connection with PPM Center.

6. If a message appears stating that connection was successful, click OK to 
close the PPM Center Settings window, otherwise resolve the connection 
issue.

7. In the main PPM Center-Quality Center Integration Tool window, select 
Action > Enable Project. 

The Enable Quality Center Project wizard opens.

8. Click Next to continue.

If the PPM Server is installed in a WAN, use its IP address, for example  
http://192.60.28.01:8080, rather than its host name, for example  
http://ppmhost:8080. 
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9. In the Host field, type the URL of the Quality Center server.

10. Click Next to continue.

11. In the User Name and Password fields, specify the user name and password 
of the Quality Center project administrator. 
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12. Click Test Connection to test the connection with Quality Center.

13. If a message appears stating that connection was successful, click OK on 
the message, then click Next. Otherwise resolve the connection issue.

14. Select a Quality Center domain and project, and specify whether you want 
to map Quality Center defects, requirements, or both. 

If you are enabling defects but not requirements for integration, skip to 
step 17 on page 211.
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15. Click Next to continue.

If you are enabling requirements for integration, the following window 
appears.

You can use this window to:

Request notification by email when a PPM Center request creates a 
new Quality Center requirement.

Request notification by email when a PPM Center request updates a 
field in an existing Quality Center requirement.

Synchronize the PPM Center request hierarchy with the Quality Center 
requirement hierarchy. For information about this synchronization, see 
Request Hierarchy Synchronization on page 243.

16. Select the desired checkboxes. 
210 Chapter 7



17. Click Next to continue.

The wizard displays the user-defined fields in the PPM Center project that 
will be added to the Quality Center project to enable mapping the Quality 
Center fields to PPM Center fields, for defects, requirements, or both, as 
specified in step 14 on page 209.

Prior to version 7.0, PPM Center was known as Mercury IT Governance Center or 
ITG. In PPM Center version 7.5, field names in Quality Center and in the 
integration tool in the context of Quality Center still use ITG when referring to PPM 
Center.
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18. Click Next to continue.

The listed fields are added to the Quality Center project, and the Quality 
Center workflow script is updated to support integration with PPM Center.

19. Click Finish to complete enabling the project for integration and close the 
wizard.

If the Quality Center project already contains one or more fields with the same 
names, a dialog box asks you whether you want to change the names of the 
added fields. If you select Yes, the added fields will be given different names. If 
you select No, the procedure to enable the project for integration is aborted.

If the Quality Center project does not have a workflow script in its repository, a 
dialog box asks you whether you want to create a new one. If you select Yes, a 
new script with support for the integration is added to the Quality Center 
repository. If you select No, the script file is not created. 
If the project is not new and its script files have been previously customized, 
select No and manually merge the customized scripts with the scripts that the 
wizard adds automatically, which are located in the installation directory of the 
PPM Center-Quality Center Integration Tool.
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Creating the Mapping Between PPM Center and Quality Center Fields

After you enable a Quality Center project for the integration, you use the PPM 
Center-Quality Center Integration Tool to map a particular PPM Center 
request type to a Quality Center defect or requirement and to specify the 
desired mapping between the PPM Center fields and the Quality Center fields.

Create the mapping as follows:

1. In the left pane of the PPM Center-Quality Center Integration Tool, expand 
the tree until the child node at the lowest level (defect, requirement, or 
both) is visible.

For information about the provided default mappings, see Default Quality 
Center–PPM Center Field Mappings on page 252.
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2. Click the child node you want to map and select Action > Add Mapping (or 
right-click the node you want to map and click Add Mapping).

The Map Fields wizard opens.

3. Click Next to continue.

4. In the User Name and Password fields, type the user name and password of 
the Quality Center administrator.
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5. Click Next to continue.

The PPM Center Request Type field appears with a drop-down list.

6. Click the arrow of the drop-down list to display a list of all the PPM Center 
request types that can be mapped to a Quality Center defect or requirement 
(depending on which you selected in step 2 on page 214).

As provided, the only PPM Center request type available to map to a 
Quality Center defect is the MAC - Defect Template with Quality Center 
Integration request type.

As provided, the only PPM Center request types available to map to a 
Quality Center requirement are:

MAC - Release Management

MAC - Request For Change (RFC)

(REFERENCE) Software Change

7. Select the request type in PPM Center that is to be mapped to the Quality 
Center defect or requirement.
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8. If you are mapping the request type to a defect, but not if you are mapping 
the request type to a requirement, the window includes the Default Mapping 
checkbox. 

If this is the first mapping you are creating from a PPM Center request type 
to a Quality Center defect for the project, the checkbox is selected and 
disabled so that you cannot clear it. 

If this is not the first such mapping, the checkbox is cleared and enabled; 
select it if you want the request type you are now mapping to become the 
default PPM Center request type for Quality Center defects for the project. 

9. Click Next to continue.

From the integration tool, the wizard displays the default mapping between 
the Quality Center fields and PPM Center fields for the request type you 
selected. In this Map Fields window, the fields map either a PPM Center 
request type for defects to a Quality Center defect, or a PPM Center request 
type for changes to a Quality Center requirement.

The Quality Center Field column displays the DB field name (the name of 
the column in the database) in parentheses.

The PPM Center Field column displays the PPM Center token in 
parentheses.
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The Override column specifies which field, if any, is the dominant field for 
a pair. The Override column can have one of the following values for any 
pair of mapped fields (row):

When set to QC, changing the value of the Quality Center field causes 
the same change to be applied to the mapped PPM Center field. That is, 
the Quality Center field is dominant. If the value in the PPM Center 
field is changed, the value in the Quality Center field is not affected.

When set to PPM, changing the value of the PPM Center field causes 
the same change to be applied to the mapped Quality Center field. That 
is, the PPM Center field is dominant. If the value in the Quality Center 
field is changed, the value in the PPM Center field is not affected.

When set to BIDIRECTIONAL, changing the value of the field in either 
PPM Center or Quality Center causes the same change to be applied to 
the mapped field in the other application.

10. If you want to change which field, if any, is dominant for a field mapping, 
click the value in the Override column for the field mapping of interest, and 
select another value from the list that appears.

11. If you want to add a pair of fields to the mapping:

a. Click Add. 

The Add Field window opens.

b. In Quality Center Field and PPM Center Field, select the fields you want 
to map to each other.

c. Click OK. 

The pair of fields is added to the mapping and appears in the list.

If the mapped fields in a pair have different sets of valid values, you must resolve 
the differences so that a change to one field can update the other. See Resolving 
Lists of Valid Values on page 220.
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12. If you want to remove a pair of fields from the mapping:

a. Click a line to select the pair.

b. Click Remove. 

c. When the application asks whether you want to delete the selected line 
or lines, click Yes. 

13. Click Next to continue.
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14. Click Finish to save the mapping and close the wizard.

The new mapping is displayed in the PPM Center-Quality Center 
Integration Tool. (In the example, expand the defect list.)

15. By default, a local copy of the mapping file (ITGQCIntegration.xml) is 
saved in the Windows directory in which you installed the PPM 
Center-Quality Center Integration Tool. As discussed later, you will use 
the tool to deploy the mapping file to the PPM Server and the Quality 
Center server. Then the integration can operate without any dependency on 
the local Windows machine.

If you want to save the XML file elsewhere, select File > Save To and 
specify the location.

If you want to open an XML file stored in another location, click 
File > Open. 

16. Click File > Exit to close the PPM Center-Quality Center Integration Tool.
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Resolving Lists of Valid Values

This section describes how to resolve differences between the sets of valid 
values for a pair of mapped fields, so that a change to one field correctly 
updates the other.

To open the mapping file and access the Map Value Lists window:

1. Open the mapping file as described in Viewing and Changing a Mapping 
on page 231. 

2. Select the row for the pair of fields of interest and click Map Value Lists. 

The Map Value Lists window opens, displaying the lists of valid values for 
each field in the pair.

Resolve the differences between the sets of valid values based on which of the 
following three cases applies.

Case One

If you created a new user-defined field in Quality Center and mapped it to a 
PPM Center field that has a list of values, create a new Quality Center list of 
valid values from the PPM Center list, as follows:

1. Select the Create a new list in Quality Center... option in the Map Values 
List window.

2. In the List Name field, specify a name for the list or accept the default.

3. Click OK. 

A new Quality Center value list containing the PPM Center values is 
created and associated with the Quality Center field.

Some field pairs are automatically mapped and their mappings cannot be 
changed.
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Case Two

If the fields in the pair have different sets of values and some records in the 
Quality Center project already use the current list values, but from now on you 
want to use the values that appear in the PPM Center list, add the PPM Center 
values to the Quality Center list, as follows:

1. Select the Add the PPM Center values to the existing Quality Center list 
option in the Map Values List window.

2. Click OK. 

The Quality Center value list now includes the PPM Center values as well 
as the original Quality Center values.

Case Three

If both fields in the pair already have lists of values that you need to map or 
remap, do so as follows:

1. Select the Map Values option in the Map Values List window.

2. Select a value in the Quality Center list, select the value in the PPM Center 
list to which you want to map it, and click the right-arrow button. 

The pair of mapped values appears in the right pane of the Map Value Lists 
window. For example, if the value representing lowest impact in the 
Quality Center field is Enhancement and the value representing lowest 
impact in the PPM Center field is 1-Low, map the two values as shown in 
the following figure: 
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Between the QC and PPM columns in the right pane, the mapping displays:

--> if the Override column for the pair of fields is set to QC. 

<-- if the Override column for the pair of fields is set to PPM. 

<--> if the Override column for the pair of fields is set to 
BIDIRECTIONAL. 

3. Repeat step 2 for all the values that require mapping. 

You must map all the values in the Quality Center list if Quality Center 
is dominant for that field pair, as indicated by QC in the Override 
column in the Map Fields window and by --> between the QC and PPM 
columns in the right pane of the Map Value Lists window. 

Similarly, you must map all the values in the PPM Center list if PPM 
Center is dominant for that field pair, as indicated by PPM in the 
Override column in the Map Fields window and by <-- between the QC 
and PPM columns in the right pane of the Map Value Lists window. 

You must map all the values in both lists if neither field of the pair is 
dominant, as indicated by BIDIRECTIONAL in the Override column in 
the Map Fields window and by <--> between the QC and PPM columns 
in the right pane of the Map Value Lists window.

If you map two or more values in one list to one value in the other list, you 
must select a checkbox in the Default column to indicate which mapping 
prevails. 
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Consider the example in the following figure, where the two value lists are 
of different lengths and the mapping is BIDIRECTIONAL. 

In this example, you must:

a. Map two or more values in one list to a single value in the other list. 
Here, both the values Critical and Urgent for the field in Quality Center 
have been mapped to a value of Urgent for the field in PPM Center.

b. Select the appropriate Default checkbox to eliminate ambiguity as to 
which pair will be used to map the values. In this example, if the field 
in PPM Center changes to a value of Urgent, the value of the field in 
Quality Center becomes Critical, based on the selected Default pair of 
values. If the second checkbox, for which the PPM Center value is also 
Urgent, had been chosen as the default instead, when the field in PPM 
Center changes to a value of Urgent, the value of the field in Quality 
Center would become Urgent. 

4. Click OK. 

The PPM Center values and Quality Center values for the field become 
mapped as you have specified.
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Mapping the Notes Field in PPM Center to an Existing Project

When you enable a new Quality Center project for integration, the integration 
tool attempts to create new fields in the Quality Center project to correspond to 
the Notes to be added on save field for the PPM Center request. When you 
update the content of this field in a PPM Center request, the corresponding 
field is updated in Quality Center. 

When you enable a new project, the new fields are named as follows:

For a defect, the added field in the Defects table is called BG_USER_<XX>, 
for example BG_USER_25. 

For a requirement, the added field in the Requirements table is called RQ_
USER_<XX>, for example RQ_USER_26. 

Since the Quality Center fields are memo fields and there can be no more than 
three user-defined memo fields per table, the attempt to map Notes to memo 
fields may fail. If it fails, you cannot use the integration tool to map the Notes 
to be added on save field. Instead, you must add the memo fields to the project 
manually, and edit the XML mapping file by adding one of the following to the 
appropriate mapping file, using the example:

For defects:

<param name="BUG_ITG_NOTES">BG_USER_25</param>

For requirements:

<param name="REQ_ITG_NOTES">RQ_USER_26</param>

If you enable an existing project that already includes some user-defined memo fields, 
the added fields may have different names.
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Deploying the Mapping File to PPM Center and Quality Center

After you have completed the mapping, use the PPM Center-Quality Center 
Integration Tool to deploy the XML mapping file (ITGQCIntegration.xml) 
to PPM Center and to Quality Center.

To deploy the XML mapping file to PPM Center and Quality Center:

1. Verify that the PPM Center server.conf parameters are as specified in 
Specifying server.conf Parameters in PPM Center on page 227. Set the 
ENABLE_QUALITY_CENTER_INTEGRATION parameter to true. 

2. In the main window of the PPM Center-Quality Center Integration Tool, 
select File > Deploy to Centers. 

The Deploy Configuration File to Centers window opens, listing the URLs 
of the PPM Center and Quality Center servers to which the mapping file 
will be deployed.

At certain times, you might need to manually edit or back up the XML mapping file. 
When you created the XML mapping file, it was stored either in the directory in which 
you installed the integration tool or in another directory that you specified (see step 15 
on page 219). If you do not know where the file is located, check the Windows 
registry. The path in the registry is HKEY_LOCAL_MACHINE\SOFTWARE\
Hewlett-Packard\PPM Center-Quality Center Integration Tool. 
Remember to redeploy the mapping file to both PPM Center and Quality Center.
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3. Click Deploy. 

The tool starts the deployment process. If any errors occur during 
deployment, a message is displayed in the window.

4. When the deployment completes, a message indicating that deployment 
completed successfully is added to the Deploy Configuration File to 
Centers window.

5. Click OK to close the window.

On the PPM Server, the mapping file is deployed to the <PPM_Home>/conf 
directory, where <PPM_Home> represents the path where the PPM Center 
instance is installed. 

On the Quality Center server (or servers), the mapping file is deployed to the 
<QC_Home>/repository/sa/DomsInfo/BTO directory, where <QC_Home> 
represents the path where Quality Center is installed.

For information about changing and otherwise maintaining existing mappings, 
see Managing Existing Mappings on page 229.

This completes creating and deploying the mapping file. To configure PPM 
Center for the integration, proceed to Configuring PPM Center for the 
Integration.
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Configuring PPM Center for the Integration

Before beginning to configure the integration as described in the following 
sections, make sure that MAC has been installed and initially configured as 
described in Chapter 2, Installing and Setting Up MAC Software, on page 31.

Establishing Server Connections for Supported Versions

Make sure that the HTTP port is open between the PPM Server and Quality 
Center machines. 

Verify that a supported version of Quality Center is installed and running (see 
Versions of HP Quality Center Supported for Integration with PPM Center 
on page 22).

Specifying server.conf Parameters in PPM Center

Add and specify (or, if present, just specify) the parameters related to Quality 
Center integration to the PPM Center server.conf configuration file (for 
more information about the steps in this procedure, see the System 
Administration Guide and Reference):

1. Stop the PPM Server.
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2. Run the script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

3. Restart the PPM Server.

For information about using the integration, see Using the Integration of PPM 
Center with Quality Center on page 237.

Parameter Value

ENABLE_QUALITY_
CENTER_INTEGRATION

Set this parameter to false if an XML 
mapping file has not been generated and 
deployed to PPM Center and Quality Center.
Set this parameter to true if an XML 
mapping file has been generated and 
deployed to PPM Center and Quality Center, 
so that integration can be enabled. If a 
mapping file has not been deployed and you 
set this parameter to true, the PPM Server 
will not restart.
This parameter controls whether PPM 
Center attempts to send information to 
Quality Center. (Even if it is set to false, 
Quality Center sends information to PPM 
Center.)

BASE_URL
(already present in 
server.conf)

The URL of the PPM Server. By default, 
contains the host name of the PPM Server, 
for example,  http://ppmhost:8080. 
However, if the PPM Server is installed in a 
WAN, use its IP address rather than the host 
name, for example, http://
192.60.80.01:8080. 

ENABLE_QUALITY_
CENTER_METRICS_SYNC

Always set this parameter to false. It 
does not apply to MAC.
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Managing Existing Mappings

After you have configured PPM Center and Quality Center for integration, you 
can use the integration tool to make changes to the configuration.

You can change the configuration for a request type mapping or for an entire 
Quality Center project. When you change a mapping for a project, the changes 
apply to all the request types mapped to the project. For example, if you delete 
the mapping for a project, the mapping for all of the project’s mapped request 
types is also deleted.

As described in the following sections, you can:

Delete a mapping

Disable a mapping

Re-enable a previously disabled mapping

View and change a mapping

Change the default request type

Enable and disable request hierarchy synchronization

Enable and disable email notification on requirement creation

Enable and disable email notification on requirement update

Remember to redeploy the mapping file to PPM Center and Quality Center after any 
mapping revision described in the following sections. See Deploying the Mapping File 
to PPM Center and Quality Center on page 225.
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Deleting a Mapping

When you delete a mapping, the connection between the corresponding fields 
in PPM Center and Quality Center is removed, and updating a field in one 
application no longer causes an update in the other. 

To delete a mapping:

1. Right-click the project or request type of interest and select Delete 
Mapping. 

The tool asks whether you want to delete the mapping.

2. Click Yes. 

If you later want the applications to update each other, you will need to create a new 
mapping.
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Disabling and Re-Enabling a Mapping

When you disable a mapping, it is not deleted, but creating a request in PPM 
Center does not create a defect or requirement in the Quality Center project, 
and creating a defect in Quality Center does not create a request in PPM 
Center. In addition, updating a field in one application does not update the field 
to which it is mapped in the other.

To disable the mapping between a request type and a defect or requirement:

1. Right-click the project or request type of interest and select Disable 
Mapping. 

The tool asks whether you want to disable the mapping.

2. Click Yes. 

To enable a mapping that was previously disabled, right-click the project or 
request type and select Enable Mapping. 
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Viewing and Changing a Mapping

To view a mapping and make changes to the mapping:

1. Right-click the request type of interest and select Mappings. 

The Map Fields window opens.
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2. If the Mapping tab is not already selected, select it to display the mapping.

3. Use this tab to change the mapping in the same way you created the 
original mapping. See Creating the Mapping Between PPM Center and 
Quality Center Fields on page 213.

Changing the Default Request Type for a Quality Center Defect

To change the default request type used to create a request in PPM Center 
when you create a defect in Quality Center, right-click the request type you 
want to use as the default, and select Make Default. 
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Enabling and Disabling Request Hierarchy Synchronization

You can enable or disable the request hierarchy synchronization between a 
PPM Center request and a Quality Center requirement.

To enable the synchronization:

1. Right-click requirement. 

2. If the Synchronize Request Hierarchy option is not selected (has no check 
mark), click it to select the option. 

To disable the synchronization:

1. Right-click requirement. 

2. If the Synchronize Request Hierarchy option is selected (has a check mark), 
click it to clear the option. 

For information about request hierarchy synchronization, see Request 
Hierarchy Synchronization on page 243.
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Enabling and Disabling Email Notification on Requirement Creation

You can enable or disable sending an automatic email notification when a 
requirement is created by the integration.

To enable the email notification for requirement creation:

1. Right-click requirement. 

2. If the Notify When Created option is not selected (has no check mark), click 
it to select the option. 

To disable the email notification for requirement creation:

1. Right-click requirement. 

2. If the Notify When Created option is selected (has a check mark), click it to 
clear the option. 
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Enabling and Disabling Email Notification on Requirement Update

You can enable or disable sending an automatic email notification when a 
requirement is updated by the integration.

You can enable or disable sending an automatic email notification when a 
requirement is created by the integration.

To enable the email notification for requirement update:

1. Right-click requirement. 

2. If the Notify When Update option is not selected (has no check mark), click 
it to select the option. 

To disable the email notification for requirement update:

1. Right-click requirement. 

2. If the Notify When Update option is selected (has a check mark), click it to 
clear the option. 
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Using the Integration of PPM Center with Quality Center
This section describes how the request types and workflows provided in MAC 
support integration of PPM Center with Quality Center.

Steps in PPM Center Workflows that Involve Integration with Quality Center

Several workflows and subworkflows provided in MAC have steps that are 
related to the integration of PPM Center with Quality Center, as follows:

The MAC - Request For Change workflow (see MAC - Request For 
Change Workflow on page 49) calls the following subworkflows at the 
indicated steps:

o At step 17, the MAC - Request For Change workflow calls the Plan 
Tests Sub WF (see MAC - Plan Tests Sub WF Subworkflow 
on page 61).

In this subworkflow, step 1, Quality Process Mode, determines whether 
the test planning will be done manually or using integration of PPM 
Center with Quality Center. If integration is to be used, the following 
additional subworkflow steps relate to the integration:

Step 4, Quality Process Entry

Step 5, Generate Requirement in Quality Center

Step 6. Quality Center Failure

Step 7, Quality Center Requirements Setup

Step 8, Quality Center Test Plan Setup

Step 9, Quality Center Test Lab Setup

o At step 22, the MAC - Request For Change workflow calls the Deploy 
and Test Changes Sub WF (see MAC - Deploy and Test Changes 
Sub WF Subworkflow on page 63).

In this subworkflow, step 3, Quality Process Mode, determines whether 
the testing will be done manually or using integration of PPM Center 
with Quality Center. If integration is to be used, the following 
additional subworkflow step relates to the integration:

Step 5, Quality Center Test Execution
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The MAC - Defect Template with Quality Center Integration workflow 
generates a defect or requirement in Quality Center as soon as a request of 
the associated type is created. See MAC - Defect Template with Quality 
Center Integration Workflow on page 198.

The MAC - Release Request workflow (see MAC - Release Request 
Workflow on page 83), includes the following steps that relate to 
integration of PPM Center with Quality Center for the release management 
process:

o Step 3, Integrate with Quality Center?

o Step 4, Quality Process Entry

o Step 5, Create Release Requirement in Quality Center

o Step 6, Quality Center Failure

Configuring Request Types and Workflows for the Integration

This section provides guidelines on how to build request types and workflows 
that support the integration of PPM Center with Quality Center.

To enable integration between PPM Center requests and Quality Center 
projects, you must ensure that the request types and projects have the necessary 
matching fields and that the workflows use steps that support integration. 

MAC provides request types and workflows that use Quality Center 
capabilities, and the workflows include the required steps. You can create 
integration-enabled request types and workflows in any of the following ways:

By using the PPM Workbench to copy the provided MAC request types 
and workflows, which already contain the components required for 
integration, and changing the copies as needed. This is often the easiest 
approach.

By creating new request types and workflows that incorporate the 
components required for integration.

By customizing your existing PPM Center request types and workflows by 
adding the components required for integration.
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After you configure the required request types and workflows, you use the 
PPM Center-Quality Center Integration Tool to map the PPM Center fields and 
their valid values to the Quality Center fields and their valid values (see 
Creating the Mapping Between PPM Center and Quality Center Fields 
on page 213).

For detailed information about configuring request types and workflows, see 
the HP Demand Management Configuration Guide as necessary.

Configuring Request Types

The guidelines to configure a request type for integration are as follows:

Make sure the request header type for the request type includes the Quality 
Center Info field group. Only request types with this field group can be 
mapped to Quality Center defects or requirements. See Request Header 
Types on page 197.

Decide which request type to map to each Quality Center project, then 
make sure that the request type and project have the required mapping of 
corresponding fields.

Make sure that each pair of mapped fields includes the required valid 
values. For example, if a Quality Center field contains a lookup list, make 
sure that the corresponding field in the PPM Center request accepts those 
values. If you update a field in one application with a value that is not valid 
in the other application, the field in that other application will not be 
updated. 

For details, see Resolving Lists of Valid Values on page 220.

By default, the Quality Center Info field group is included in the MAC - Request 
For Change (RFC) request type and in the MAC - Release Management request 
type, but not in the MAC - Defect Template with Quality Center Integration request 
type.

Quality Center workflows can limit the changes a user can make to a field. For 
example, a script might specify that at a certain point in the Quality Center 
workflow, the user cannot change the status from Open to Closed.
If you update a PPM Center field with a value that is valid in the corresponding 
Quality Center field, the Quality Center field will be updated, even if it should not 
be updated according to the Quality Center workflow script.
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Configuring Workflows

The guidelines to configure a workflow for integration are as follows (refer to 
the HP Demand Management Configuration Guide for details as necessary):

Make sure the workflow includes execution steps and decision steps that 
enable the integration of PPM Center with Quality Center. The workflows 
provided by MAC include such steps. 

If you need to customize a workflow to create a defect or a requirement, 
HP recommends using the execution steps that are included in the MAC - 
Defect Template with Quality Center Integration workflow, instead of 
building the steps yourself. To create defects or requirements in Quality 
Center, your workflow must include one of the following execution steps 
that uses the stated special command:

o To create defects, the MAC - Create QC Defect execution step with the 
ksc_create_defect_in_QC special command.

o To create requirements, the MAC - Create QC Requirement execution 
step with the ksc_create_requirement_in_QC special command.

In the Properties tab of the workflow execution step, specify a value in the 
Request Status field that is valid for Quality Center, for example, 
1-Requirements Setup Completed when creating a requirement.

Once an execution step has created a requirement or defect in Quality 
Center, every time the PPM Center request status changes, the Quality 
Center requirement or defect status also changes if the same PPM Center 
status exists in its list. For example, if the PPM Center request status 
changes to Open, the Quality Center requirement or defect status will also 
change to Open, as long as Open is one of the values allowed in the status 
field of the requirement or defect.

For more information about configuring workflow steps, see the HP 
Demand Management Configuration Guide. 

A PPM Center decision step that depends on Quality Center (that is, a PPM 
Center request that is supposed to be updated by a Quality Center status change) 
can have its status changed in Quality Center only by a user who has 
Administrator rights.
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When a PPM Center request is integrated with a Quality Center project, 
you can use a change in the Quality Center status to cause the PPM Center 
request to advance through an active decision step to the next step in the 
associated PPM Center workflow. For example, when the QA manager sets 
the status of a Quality Center project to indicate that test planning is 
complete, the corresponding request in PPM Center can automatically 
advance from the step in the associated workflow awaiting that 
notification.

Conversely, whenever the status of a PPM Center request changes, PPM 
Center notifies Quality Center, and (assuming the new status is valid in 
Quality Center), Quality Center users can take appropriate action such as 
starting tests.

To enable this functionality, you must design the workflow decision steps 
such that the following three items have the same values:

o The Quality Center status that will trigger the advancement in the PPM 
Center workflow.

o The transition name (which is specified as the Meaning field of the 
validation value for the workflow step source) for the active decision 
step in the PPM Center workflow.

HP recommends that you give the Meaning field of the transition a 
value that is unique to this transition, that is, a value that does not exist 
anywhere else in the workflow. When this value becomes assigned to 
the ITG Status field in Quality Center, the PPM Center workflow 
advances if the value matches a valid transition in an active workflow 
step. If the workflow has more than one active step and the Meaning is 
not unique, the workflow could advance to an unintended step.

After Quality Center sends an update to PPM Center, Quality Center waits for a 
response, and the Quality Center record remains locked until Quality Center 
receives the response. Meanwhile, if PPM Center advances to the next workflow 
step and attempts, for example, to update (synchronize) Quality Center with a 
new request status, Quality Center rejects the update since the record is locked.
Therefore, a PPM Center workflow should not contain successive steps such that 
the first causes a PPM Center request to advance based on a change in Quality 
Center status, and the second causes PPM Center to attempt to update Quality 
Center. Make sure there is an intervening step between two such steps.
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o The Request Status field in the destination step in the PPM Center 
workflow

If the Quality Center status does not appear in the list of valid request status 
values in PPM Center, PPM Center sends an error message to Quality 
Center, the Quality Center status reverts to its previous value, and the PPM 
Center workflow does not advance.

For example, in the following portion of the MAC - Plan Tests Sub WF 
subworkflow, the transition from step 7 to step 8 is called 1-Requirements 
Setup Completed. 

If you double-click step 8 (the destination step), the Properties tab of the 
Workflow Step window shows that the value in the Request Status field is 
also 1-Requirements Setup Completed. 
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All three items—the Quality Center status, the transition, and the Request 
Status field of the destination step—have the same value. Therefore, if the 
QA team changes the Quality Center status to 1-Requirements Setup 
Completed when step 7 is active, the workflow will advance to step 8. 

If you need to change the value of the Request Status field of the 
destination step, in the Properties tab of the Workflow Step window for 
that step, specify the new value in the Request Status field and click OK. 

If you need to change the Meaning field that defines the transition name, 
right-click the preceding decision step and select Edit Source; in the 
Validation section of the Decision window, click Open; click the validation 
value (row) of interest and click Edit; specify the new value in the Meaning 
field; and click OK to close all open windows. For more detailed 
information, see the HP Demand Management Configuration Guide. 
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Request Hierarchy Synchronization

The integration of PPM Center with Quality Center allows you to synchronize 
the hierarchies of requests in PPM Center and requirements in Quality Center, 
as in the following example sequence:

1. A PPM Center request named Request A is created.

2. With integration, a corresponding Requirement A is automatically created 
in Quality Center.

3. A PPM Center request named Request B is created with a reference to 
Request A indicating that Request A is the parent of Request B.

4. A corresponding Requirement B is automatically created in Quality Center. 
If request hierarchy synchronization is implemented, since Request B is the 
child of Request A, Requirement B is automatically created as the child of 
Requirement A.

If you later delete the relationship (the reference) between Request A and 
Request B in PPM Center, the relationship between Requirement A and 
Requirement B is automatically deleted in Quality Center. Instead of being a 
child of Requirement A, Requirement B becomes a child of the Quality Center 
default root requirement for PPM Center requests.

If you synchronize hierarchies, any changes you make to the hierarchy in PPM 
Center are automatically reflected in the hierarchy of the Quality Center 
project. Thus, changes you make to a Quality Center project can be overridden 
later by updates to the corresponding PPM Center request.

PPM Center allows a request to have multiple parents, but Quality Center 
limits a requirement to only one parent. If a PPM Center request has multiple 
parents, Quality Center does not duplicate that hierarchy in the project, and 
PPM Center displays a message indicating a problem with hierarchy 
synchronization.

If Requirement A does not exist in Quality Center, creating a reference in PPM 
Center from Request B to Request A has no effect on Quality Center.
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Enabling Request Hierarchy Synchronization

Synchronization between the PPM Center request type and the Quality Center 
project must be enabled as follows, depending on whether or not a mapping 
has been created:

If a mapping has not been created between the Quality Center requirement 
and the PPM Center request type, as you use the PPM Center-Quality 
Center Integration Tool to enable the project for integration, select the 
checkbox in the Request Hierarchy section in the Enable Quality Center 
Project wizard. See step 15 on page 210.

If a mapping has been created, in the PPM Center-Quality Center 
Integration Tool, right-click the request type and select Synchronize 
Request Hierarchy. 

Example of Request Hierarchy Synchronization

The following screen shows a Quality Center requirement called 
Req. Hierarchy with three requirements. 

Each requirement is mapped to a PPM Center request of type MAC - Request 
For Change (RFC). The request numbers in PPM Center are shown in the ITG 
Request Id column. When created, the RFC Summary fields of the requests 
were specified as Parent Requirement, Child Requirement, and Grand-child 
Requirement to indicate their intended hierarchy (first in PPM Center and then 
automatically as requirements in Quality Center) after the relationships among 
the requests are established in PPM Center.

When you open a request, you can add a different request in the References 
section and specify the relationship of the reference request to the request you 
opened. For example, the reference request can be a child or a parent of the 
open request.
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For the example, you could use any one of the following methods to establish 
the relationships among requests, which would then automatically synchronize 
the relationships among the associated Quality Center requirements:

Open request 30002 and make it the parent of request 30003, and then open 
request 30003 and make it the parent of request 30004. 

Open request 30003 and make it the child of request 30002, and then open 
request 30004 and make it the child of request 30003. 

Open only request 30003 and make it both the child of request 30002 and 
the parent of request 30004. This method is slightly quicker and is used in 
the following procedure.

In PPM Center, create the relationships between the requests as follows:

1. Select and open the request for which you want to define one or more 
relationships.

In the example, open request 30003.
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2. In the Reference Additions section of the request, in the New Reference 
drop-down list, select Request (Existing). 
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3. Click Add. 

The Add Reference: Request window opens.
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4. Specify data about the request to be related to the open request, and click 
Search. 

In this example, type 30002 in the Request # field and click Search. 

If the search is successful, the following window opens.

The window allows you to select from the search results which requests 
will be references (in the example, 30002 is the only request found using 
the specified search criteria), and to select an option to specify the 
relationship the reference request (or requests) will have to the open 
request (30003 in the example).

5. In the Request Search Results section, select the checkbox for the request 
that is to be made a reference.

6. In the upper section of this window, select the option for the relationship 
you want this reference request to have to the open request. 

In this example, select Parent of this Request because you want reference 
request 30002 to be the parent of open request 30003.
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7. Click Add. 

The reference request and its relationship are added to the References to be 
added on Save text box in the open request.
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8. Repeat step 2 on page 246 through step 7 (or step 3 on page 247 through 
step 7) as necessary to create parent and child relationships with additional 
requests.

In this example, follow step 3 through step 7, but in step 4 type 30004 in 
the Request # field to make that request the one to reference, and in step 6 
select Child of this Request because you want reference request 30004 to be 
the child of open request 30003.
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9. Click Save. 

The reference requests with which you have defined relationships are listed 
in the References section, Requests subsection of the open request. 
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In Quality Center, you now see the requirements (rows) reorganized and 
indented to reflect the relationship hierarchy you specified among the PPM 
Center requests.

Default Quality Center–PPM Center Field Mappings

This section lists the default field mappings that are available when 
integrating:

The Requirements Module in Quality Center with the MAC - Request for 
Change (RFC) request type in PPM Center (see Default Field Mappings 
for Quality Center Requirements).

The Defects Module in Quality Center with the MAC - Defect Template 
with Quality Center Integration request type in PPM Center (see Default 
Field Mappings for Quality Center Defects on page 256).
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Default Field Mappings for Quality Center Requirements

This section summarizes the default field mappings for the integration between 
the Requirements Module in Quality Center and the MAC - Request for 
Change (RFC) request type in PPM Center. It includes the following tables:

Table 7-2 describes the default requirement mappings that can be 
modified. The Override column indicates which field is dominant by 
default—PPM Center (if set to PPM), Quality Center (if set to QC), or 
neither (if set to BIDIRECTIONAL). For more information, see step 9 
on page 216.

Table 7-3 on page 255 describes the fields that were added to Quality 
Center requirements to support integration with PPM Center requests. 
These fields should not be modified (except for their Labels, as desired).

Table 7-4 on page 255 describes the fields that were added to PPM Center 
requests to support integration with Quality Center requirements. These 
fields should not be modified (except for their Field Prompts, as desired).

Table 7-2. Requirements mapping you can modify (page 1 of 2)

Quality Center Field Name,
Database ID, 
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override

Priority
RQ_REQ_PRIORITY
Enumeration 

RFC Priority
PRIORITY_CODE
Drop-down list 

PPM

Author b

RQ_REQ_AUTHOR
User list 

Created By
CREATED_BY
User list 

PPM
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ITG Request Status c, d

RQ_USER_XX e

Enumeration 

RFC Status c

STATUS_ID
List 

PPM c

Quality Center Status d

KNTA_QC_REQUIREMENT_STATUS
Text (300) 

QC d

Name
RQ_REQ_NAME
Text (255) 

RFC Summary
DESCRIPTION
Text (200)

PPM

ITG Request Description
RQ_USER_XX e

Memo

RFC Description
RFC_DESCRIPTION
Text (1800)

PPM

Assigned To
RQ_USER_XX e

User list

Quality Center Assigned To User
KNTA_QC_ASSIGNED_TO
Quality Center user list (uses a special 
validation that retrieves the Quality 
Center user list for a specific project).

PPM

a. The listed PPM Center database IDs are as seen in the PPM Workbench. The exact database IDs are 
displayed by the integration tool.

b. The Author field in Quality Center displays the name of the user who created the request in PPM Center. 
Quality Center can accept any name, but PPM Center cannot. If you configure this field to be 
bi-directionally updateable and a user selects a user name in Quality Center that does not exist in PPM 
Center, the operation will fail. User name lists must therefore be synchronized. 

c. When the RFC Status field is updated in PPM Center, the new status is sent to Quality Center. If the new 
status matches one of the requirement statuses in Quality Center, the ITG Request Status field in Quality 
Center is updated; if not, the update is ignored by Quality Center. 

d. When the status of a requirement is updated in Quality Center, the Quality Center Status field in PPM 
Center is correspondingly updated if the value sent by Quality Center is a valid workflow step transition in 
PPM Center.

e. The Quality Center fields with the database ID of RQ_USER_XX are user fields that are added to Quality 
Center when using the integration tool to enable a project. The value of XX is determined when the user 
field is added to Quality Center.

Table 7-2. Requirements mapping you can modify (page 2 of 2)

Quality Center Field Name,
Database ID, 
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Table 7-3 describes the fields that were added to Quality Center requirements 
to support integration with PPM Center requests. These fields should not be 
modified (except for their Labels, as desired).

Table 7-4 describes the fields that were added to PPM Center requests to 
support integration with Quality Center requirements. These fields should not 
be modified (except for their Field Prompts, as desired).

Table 7-3. Fields added to Quality Center requirements to support integration with PPM Center 
requests

Field Name Field Database ID Field Type Description

ITG Server RQ_USER_XX Text (120) User field containing the PPM Center URL.

ITG Request Type RQ_USER_XX Text (40)
User field containing the PPM Center request 
type of the corresponding PPM Center request. 
Used for field mapping.

ITG Notes RQ_USER_XX Memo

Quality Center memo field. Stores PPM Center 
notes. Always overridden by PPM Center. 
Added to Quality Center if the user chooses to 
synchronize the Notes field.

ITG Updates RQ_USER_XX Text (120)
User field for integration messages. Shows last 
operation success/error message in case of 
failure.

ITG Request ID RQ_REQUEST_ID Integer System field containing PPM Center request ID.
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Table 7-4. Fields added to PPM Center requests to support integration with Quality Center 
requirements

Field Name Field Database ID Field Type Description

Quality Center Instance KNTA_QC_INSTANCE
List retrieved 
from the XML 
mapping file.

Quality Center 
instance URL.

Quality Center Domain KNTA_QC_DOMAIN
List retrieved 
from the XML 
mapping file.

Quality Center 
domain.

Quality Center Project KNTA_QC_PROJECT
List retrieved 
from the XML 
mapping file.

Quality Center project.

Quality Center Assigned 
To User KNTA_QC_ASSIGNED_TO Not applicable.

Obsolete field that is 
not used for MAC. Do 
not use.

Quality Center 
Requirement No. KNTA_QC_REQUIREMENT_NO Numeric Text 

(10 digits)
Quality Center 
requirement ID.

Quality Center Status KNTA_QC_REQUIREMENT_
STATUS Text (300) Quality Center 

requirement status.

Quality Center Message KNTA_QC_REQUIREMENT_
INT_MSG Text (300)

Integration messages. 
Shows last operation 
success/error 
message.

Quality Center 
Attachments

KNTA_QC_REQUIREMENT_
ATT_URL URL

URL for Quality 
Center attachments 
page.

Quality Center 
Dashboard Subject

KNTA_QC_DASHBOARD_
SUBJECT Not applicable.

Obsolete field that is 
not used for MAC. Do 
not use.

Quality Center 
Requirements coverage

KNTA_QC_REQUIREMENT_
COVERAGE Not applicable.

Obsolete field that is 
not used for MAC. Do 
not use.

Quality Center Open 
Defects KNTA_QC_OPEN_DEFECTS Not applicable.

Obsolete field that is 
not used for MAC. Do 
not use.
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Default Field Mappings for Quality Center Defects

This section summarizes the default field mappings for the integration between 
the Defects Module in Quality Center and the MAC - Defect Template with 
Quality Center Integration request type in PPM Center. It includes the 
following tables:

Table 7-5 describes the default defect mappings that can be modified. The 
Override column indicates which field is dominant by default—PPM 
Center (if set to PPM), Quality Center (if set to QC), or neither (if set to 
BIDIRECTIONAL). For more information, see step 9 on page 216.

Table 7-6 on page 260 describes the fields that were added to Quality 
Center defects to support integration with PPM Center requests. These 
fields should not be modified (except for their Labels, as desired).

Table 7-7 on page 261 describes the fields that were added to PPM Center 
requests to support integration with Quality Center defects. These fields 
should not be modified (except for their Field Prompts, as desired).

Table 7-5. Defect mappings you can modify (page 1 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override

Reproducible
BG_REPRODUCIBLE
Y/N

Reproducible
REPRODUCIBLE
Y/N

QC

Project
BG_PROJECT
List

Application
APPLICATION_CODE
List

QC

Actual Fix Time
BG_ACTUAL_FIX_TIME
Date

Actual Fix Time (days)
ACTUAL_FIX_TIME
Date

QC
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Closed in Version
BG_CLOSING_VERSION
List

Closed in Version
CLOSING_VERSION
Text (40)

QC

Severity
BG_SEVERITY
Enumeration

Severity
SEVERITY
Drop-down list

BIDIRECTIONAL

Closing Date
BG_CLOSING_DATE
Date

Closed on
CLOSING_DATE
Date

QC

Detected in Version
BG_DETECTION_VERSION
List

Detected in Version
DETECTION_VERSION
Text (40)

BIDIRECTIONAL

Planned Closing Version
BG_PLANNED_CLOSING_VER
List

Planned Closing Version
PLANNED_CLOSING_VER
List

BIDIRECTIONAL

Estimated Fix Time
BG_ESTIMATED_FIX_TIME
Number

Estimated Fix Time (days)
ESTIMATED_FIX_TIME
Numeric Text (10 digits)

BIDIRECTIONAL

Comments
BG_DEV_COMMENTS
Memo

Developer Comments
DEV_COMMENTS
Text (1800)

PPM

Detected on Date
BG_DETECTION_DATE
Date

Created On
CREATION_DATE
Date

PPM

Priority
BG_PRIORITY
Enumeration

Priority
DEFECT_PRIORITY_CODE
Drop-down list

BIDIRECTIONAL

Table 7-5. Defect mappings you can modify (page 2 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Description
BG_DESCRIPTION
Memo

Detailed Description
DEFECT_DESCRIPTION
Text (1800)

BIDIRECTIONAL

Detected By
BG_DETECTED_BY
Quality Center users list

Detected in Quality Center by
QC_DETECTED_BY
Text (40)

QC

Status b, c

BG_STATUS
Enumeration

Request Status b

STATUS_ID
List

PPM b

Quality Center Defect Status c

KNTA_QC_DEFECT_STATUS
Text (300)

QC c

Summary
BG_SUMMARY
Text (255)

Summary
DESCRIPTION
Text (200)

BIDIRECTIONAL 

a. The listed PPM Center database IDs are as seen in the PPM Workbench. The exact database IDs are 
displayed by the integration tool.

b. When the Request Status field is updated in PPM Center, the new status is sent to Quality Center. If the 
new status matches one of the defect statuses in Quality Center, the Status field in Quality Center is 
updated; if not, the update is ignored by Quality Center. 

c. When the status of a defect is updated in Quality Center, the Quality Center Defect Status field in PPM 
Center is correspondingly updated if the value sent by Quality Center is a valid workflow step transition in 
PPM Center.

Table 7-5. Defect mappings you can modify (page 3 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Table 7-6 describes the fields that were added to Quality Center defects to 
support integration with PPM Center requests. These fields should not be 
modified (except for their Labels, as desired).

Table 7-6. Fields added to Quality Center defects to support integration with PPM Center requests

Field Name Field Database ID Field Type Description

ITG Server BG_USER_XX a Text (120) User field containing PPM Center URL.

ITG Request Type BG_USER_XX a Text (40)
User field containing the PPM Center request 
type of the corresponding PPM Center request. 
Used for field mapping.

ITG Notes BG_USER_XX a Memo

Quality Center memo field. Stores PPM Center 
notes. Always overridden by PPM Center. 
Added to Quality Center if the user chooses to 
synchronize the Notes field.

ITG Request ID BG_REQUEST_ID Integer System field containing PPM Center request ID.

a. The Quality Center fields with the database ID of BG_USER_XX are user fields that are added to Quality Center when using 
the integration tool to enable a project. The value of XX is determined when the user field is added to Quality Center.
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Table 7-7 describes the fields that were added to PPM Center requests to 
support integration with Quality Center defects. These fields should not be 
modified (except for their Field Prompts, as desired).

Table 7-7. Fields added to PPM Center requests to support integration with Quality Center defects

Field Name Field Database ID Field Type Description

Quality Center Instance KNTA_QC_DEFECT_
INSTANCE

List retrieved 
from the XML 
mapping file.

Quality Center instance 
URL.

Quality Center Domain KNTA_QC_DEFECT_
DOMAIN

List retrieved 
from the XML 
mapping file.

Quality Center domain.

Quality Center Project KNTA_QC_DEFECT_
PROJECT

List retrieved 
from the XML 
mapping file.

Quality Center project.

Detected in Quality Center by QC_DETECTED BY Text (40) The Quality Center user 
who detected the defect.

Defect Number KNTA_QC_DEFECT_NO Numeric Text 
(10 digits) Quality Center defect ID.

Quality Center Defect Status KNTA_QC_DEFECT_
STATUS Text (300) Quality Center defect 

status.

Quality Center Message KNTA_QC_DEFECT_
INT_MSG Text (300)

Integration messages. 
Shows last operation 
success/error message.

Quality Center Attachments KNTA_QC_DEFECT_
ATT_URL URL URL for Quality Center 

attachments page.

Quality Center Assigned To 
User

KNTA_QC_DEFECT_
ASSIGNED_TO List

Obsolete field that is not 
used for MAC. Do not 
use.
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8 Integration of PPM Center with Release 
Control or Change Control Management 
Introduction to Integration of PPM Center with Release Control 
or Change Control Management 

Integrating PPM Center with HP Change Control Management or its successor 
product, HP Release Control, enables you to link directly from a change 
request in PPM Center to its impact analysis data in HP Change Control 
Management or HP Release Control. Based on the information provided in HP 
Change Control Management or HP Release Control, you can then decide 
whether to approve or reject the deployment of the change request. 

For more information about the benefits of this integration, see Integration of 
PPM Center with HP Release Control or HP Change Control Management 
on page 26. 

For information about the versions supported for integration, see Versions of 
HP Release Control and HP Change Control Management Supported for 
Integration with PPM Center on page 22. 

In this chapter, references to HP Release Control (the successor product to HP 
Change Control Management) also apply to supported versions of HP Change 
Control Management, except where distinctions between Release Control and 
Change Control Management are described as needed.

No software needs to be installed on the HP Release Control or Change Control 
Management server to integrate PPM Center with HP Release Control or Change 
Control Management. However, see Versions of HP Release Control and HP Change 
Control Management Supported for Integration with PPM Center on page 22.
263



For references to more information about HP Release Control or HP Change 
Control Management, see HP Release Control Documentation on page 30 or 
HP Change Control Management Documentation on page 30.

Configuring HP Release Control for the Integration

Configuring HP Release Control for integration involves:

Configuring the PPM Center Web Services adapter in HP Release Control 

Configuring the JavaScript files in HP Release Control

Before beginning this configuration, verify that the ENABLE_WEB_SERVICES 
parameter in the PPM Center server.conf configuration file is set to true to 
enable use of Web services with PPM Center (for more information about the 
steps in this procedure, see the System Administration Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./kConfig.sh 

3. Restart the PPM Server. 

Configuring the PPM Center Web Services Adapter

To establish integration, you must configure the PPM Center Web Services 
adapter in HP Release Control to convert PPM Center change requests to 
generic requests that HP Release Control can process, as follows:

1. Configure the PPM Center Web Services connector settings as described in 
the HP Release Control Installation and Configuration Guide or the HP 
Change Control Management Installation and Configuration Guide. 

Before version 7.0, PPM Center was known as Mercury IT Governance Center or 
ITG. HP Release Control and HP Change Control Management software and 
documentation might still refer to PPM Center as IT Governance Center or ITG.
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2. In the itg-ws-adapter.settings file, under <request-type 
level="1">, set the requestTypeName to the name of the PPM Center 
request type representing a PPM Center request, for example, 
MAC - Release Management. 

3. In the itg-ws-adapter.settings file, under <request-type 
level="2">, set the requestTypeName to the name of the PPM Center 
request type representing a PPM Center change, for example, 
MAC - Request for Change (RFC), and set the parentRequestTypeName to 
the value of the requestTypeName in step 2. 

Configuring the JavaScript Files

Configure the JavaScript files in HP Release Control or HP Change Control 
Management for the integration with PPM Center. 

Refer to documentation for HP Release Control or HP Change Control 
Management, and contact HP Release Control Support as necessary.

Configuring PPM Center for the Integration

Before beginning to configure the integration as described in this section, make 
sure that MAC has been installed and initially configured as described in 
Chapter 2, Installing and Setting Up MAC Software, on page 31.

Establishing Server Connections for Supported Versions

Make sure that the HTTP port is open between the PPM Server and the 
HP Release Control or HP Change Control Management machines.

Verify that a supported version of HP Release Control or HP Change Control 
Management is installed and running (see Versions of HP Release Control and 
HP Change Control Management Supported for Integration with PPM Center 
on page 22).

If PPM Center is (or will be) integrated with HP Universal CMDB or Mercury 
Application Mapping as well, additional configuration steps may be required in HP 
Release Control or HP Change Control Management before configuring the 
JavaScript.
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Specifying the server.conf Parameters in PPM Center

To be able to open HP Release Control from PPM Center as part of the 
integration, you add a parameter to the PPM Center server.conf 
configuration file and specify it. 

Add and specify the parameter related to Release Control integration to the 
PPM Center server.conf configuration file (for more information about the 
steps in this procedure, see the System Administration Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./kConfig.sh 

Set the parameter and value as shown in the following table. (All parameter 
names begin with com.kintana.core.server. but that is not shown in 
the table.)

3. Verify that the ENABLE_WEB_SERVICES parameter in the server.conf file 
is set to true. 

4. Restart the PPM Server.

Parameter Value

CCM_MACHINE_URL

The URL of the Change Control Management or 
Release Control server:
http://<CCM_Host>:<Port>/ccm/ 
where <CCM_Host> represents the host machine 
on which Change Control Management or 
Release Control is running.
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Using the Integration of PPM Center with Release Control

MAC provides the MAC - Releases portlet to facilitate the release request 
process (see MAC - Releases Portlet on page 90). If PPM Center and HP 
Release Control are integrated, for each release request you can click the Click 
to View link in the View Impact column in the portlet to log in to HP Release 
Control. When you log in, HP Release Control displays the Overview tab and 
other tabs. The information displayed for the selected change request includes, 
for example:

The “service desk application” from which the request originated. From the 
perspective of HP Release Control, PPM Center is a service desk 
application in this context. 

On the Request Details tab, the request ID number of the original change 
request, with a link to open it in PPM Center.

On the Request Details tab, the planned and actual start and end times for 
execution of the request. 

On the Overview tab, the number of configuration items (CIs) and 
applications that are affected by the request, with links that access the 
Impact Analysis tab, where details of the affected CIs and applications are 
displayed.

On the Collaboration tab, the communication among users regarding action 
items.

If PPM Center is integrated with HP Release Control or HP Change Control 
Management and with HP Universal CMDB or Mercury Application Mapping, 
you can click the Launch HP Release Control button or the Launch HP Change 
Control Management button in a PPM Center request to access HP Release 
Control or Change Control Management. Figure 8-1 shows example of a 
section of a request where PPM Center is integrated with HP Change Control 
Management and Mercury Application Mapping.
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Figure 8-1. Impact Analysis section of a PPM Center request for integration with 
Change Control Management and Mercury Application Mapping
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A Integration of PPM Center with 
Universal CMDB 
Introduction to Integration of PPM Center with Universal CMDB

HP Universal CMDB consists of a business-service-oriented data model with 
built-in discovery of configuration items (CIs) and their dependencies, 
visualization and mapping of business services, and tracking of configuration 
changes. When you integrate PPM Center with Universal CMDB, you can 
select CIs and run impact analysis reports from change requests in PPM 
Center, to determine which components of a system will be affected by a 
software change, and to what extent. The integration assists IT managers and 
Change Advisory Boards in deciding whether a change request should be 
approved for development or deployment. 

For example, your software change might involve upgrading a database server. 
Before you can perform the upgrade, you need to stop the server. In some cases 
this could prevent users from accessing crucial services, or even cause a crash 
of your production system. Impact analysis determines the effect on the entire 
system of stopping the server, and gives you a report showing the components 
that will be impacted. This enables you to plan the change with minimal 
disturbance to your operations.

Establishing and using integration of PPM Center with HP Universal CMDB does not 
require installing or using the MAC software.
However, if SP2 has been specifically installed on an earlier release of PPM Center 
version 7.5, and if integration of PPM Center with Service Manager or ServiceCenter 
was previously established, you must regenerate the Web service stubs for that 
integration as described in Generating Web Service Stubs on page 112.
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For more information about the benefits of this integration, see Integration of 
PPM Center with HP Universal CMDB and/or Mercury Application Mapping 
on page 24.

For information about the versions supported for integration, see Version of 
HP Universal CMDB Supported for Integration with PPM Center on page 21.

For references to more information about HP Universal CMDB, see HP 
Universal CMDB Documentation on page 29.

Using Impact Analysis in a Change Request Lifecycle

Since a software change might be developed and deployed over a lengthy 
period of time, you might want to generate an Impact Analysis Report at the 
following stages in the lifecycle of the change request:

Before you approve or develop the change. Before you approve or 
develop the change, it is useful to forecast the effect that introducing the 
change will have on your production system. You describe the intended 
change, specify the components that you think will be affected, and run 
impact analysis to forecast the effect of the change. 

The resulting report gives you an indication of how your system will cope 
with the change after it has been developed and deployed, and helps you 
decide whether to approve the change for development.

After the change is approved for deployment to a production system, 
but before you deploy the change. While the software change is being 
developed and then evaluated for quality, modifications may occur in your 
system infrastructure. For example, servers might be added or removed, or 

No software needs to be installed on the HP Universal CMDB server to integrate PPM 
Center and HP Universal CMDB. However, see Version of HP Universal CMDB 
Supported for Integration with PPM Center on page 21. 

Integrations of PPM Center with both Mercury Application Mapping and its successor 
product, HP Universal CMDB, can coexist without interfering with each other. Data 
obtained from the integration with Mercury Application Mapping is not migrated or 
converted for use by the integration with HP Universal CMDB. For information about 
the integration of PPM Center with Mercury Application Mapping, see Chapter 6, 
Integration of PPM Center with Mercury Application Mapping, on page 169.
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applications might be changed. As a result, the original impact analysis 
may no longer give an accurate indication of what will happen when you 
introduce the change. So after the change has been developed, evaluated, 
and approved for deployment, you perform another impact analysis to give 
you an up-to-date picture. 

Configuring Universal CMDB for the Integration

To configure Universal CMDB for the integration, configure views in 
Universal CMDB and create a PPM Center user and password in Universal 
CMDB. See the Universal CMDB documentation, listed in HP Universal 
CMDB Documentation on page 29.

Configuring PPM Center for the Integration

Perform the procedures in this section to configure PPM Center for the 
integration.

Specifying server.conf Parameters in PPM Center

Add and specify the parameters related to Mercury Application Mapping 
integration to the PPM Center server.conf configuration file (for more 
information about the steps in this procedure, see the System Administration 
Guide and Reference):

1. Stop the PPM Server.

2. Run the script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)
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Parameter Value

UCMDB_SERVER_URL

The URL of the Universal CMDB server:
http://<UCMDB_Host>:<port>/
ucmdb/ 
where <UCMDB_Host> represents the 
host machine on which Universal CMDB is 
running.

UCMDB_GATEWAY_URL

The URL of the Probe Gateway 
component of the Discovery and 
Dependency Mapping (DDM) Probe. The 
Probe Gateway provides communication 
(HTTP or HTTPS) between the Probe 
Manager and the Universal CMDB user for 
processes such as downloading tasks and 
returning task results. 
The value for <UCMDB_Host>:<port> is 
usually the same as for the UCMBD_
SERVER_URL parameter.
http://<UCMDB_Host>:<port>/mam/
gateway? 

UCMDB_USER The Universal CMDB user name, for 
example, admin.

UCMDB_PASSWORD

The Universal CMDB user password.
This password must be encrypted as 
described in Encrypting the Password 
Specified as a server.conf Parameter.

UCMDB_SERVER_VERSION

Specify 7.5 or 7.50 as the version of 
Universal CMDB being used on the 
Universal CMDB server (see Version of 
HP Universal CMDB Supported for 
Integration with PPM Center on page 21).

UCMDB_MAX_CI_NUMBER

The maximum number of CIs a request is 
allowed to have. Valid values are from 1 to 
100. If a value greater than 100 is 
specified, the PPM Server will not restart 
and displays an error message. The 
default is 20.
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3. Restart the PPM Server.

Encrypting the Password Specified as a server.conf Parameter

The password that you assigned to the UCMDB_PASSWORD parameter must be 
encrypted, as follows:

1. Navigate to the <PPM_Home>/bin/ucmdb directory.

2. Run the kEncryptUcmdbPassword.sh utility.

3. Specify the password you want to encrypt.

The utility encrypts the password and displays the encrypted text.

4. Copy the text in the Encrypted text section on the screen and paste it as 
the value for UCMDB_PASSWORD in the server.conf file, making sure that 
you do not copy any carriage returns into the file. 

Configuring a Request Type

The integration requires configuring a request type with the Universal CMDB 
Impact Analysis field group, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Administration > Open Workbench.

The PPM Workbench opens.

3. From the shortcut bar, select Demand Mgmt > Request Types. 

The Request Types Workbench opens.

4. Select the request type to which you will add the Universal CMDB Impact 
Analysis field group.

If PPM Center has already been integrated with Mercury Application Mapping, 
you can optionally select a request type that includes the MAM Impact Analysis 
field group. Integrations of PPM Center with both Mercury Application Mapping 
and Universal CMDB can coexist without interfering with each other.
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5. Open the request type and its request header type.

6. Click Field Groups. 

7. In the Field Groups window, scroll down and select the checkbox to enable 
the Universal CMDB Impact Analysis field group.

8. Click OK to add the Universal CMDB Impact Analysis field group to the 
request header type.

9. Expand Universal CMDB Impact Analysis in the Prompt column on the 
Fields tab in the request header type.

10. Select the CI List field, and click Edit. 

11. On the Attributes tab, select No for the Display Only option and select Yes 
for the Display option. 

12. Select the Security tab and edit field-level security for the CI List field as 
needed.

13. Click OK to save and close the Edit window and click OK to save and close 
the Request Header Type window.

14. Return to the request type, which now has the Universal CMDB Impact 
Analysis section and its CI List field, based on the changes you made to the 
request header type.

15. Use the Layout tab to reposition the Universal CMDB Impact Analysis 
section on the request type, as desired.

The field group is different from the CMDB Application field group near the top of 
the Field Groups window.

On the Status Dependencies tab for the CI List field, leave the Required, 
Reconfirm, and Clear options set to No. 
You can change the Visible and Editable options as desired.
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Database Tables Added for Universal CMDB

The following database tables are added in PPM Center to support integration 
with Universal CMDB:

kcrt_fg_ucmdb 

knta_ucmdb_ci_sets 

knta_ucmdb_ci_entries 

Using the Integration 

The Configuration Management Database (CMDB) in Universal CMDB 
contains information about all your CIs (servers, applications, hosts, and so on) 
and their relationships. CIs can vary widely in complexity, size, and type, from 
an entire system (including all hardware, software, and documentation) to a 
single module or minor hardware component.

For example, the CMDB contains information about which CIs are affected 
when other CIs stop functioning or have operational problems.

You generally perform impact analysis as follows:

Select the CIs that you suspect might be affected by the planned software 
change.

Run impact analysis on the selected CIs. Impact analysis analyzes the 
relationships among the selected CIs in the CMDB, and generates a report 
showing the CIs that will be affected by the planned change.

Run impact analysis at additional points, such as:

o Before approving a change, to forecast the effect that the change will 
have on your system.

o After the change has been created, in case your system infrastructure 
has changed since the previous impact analysis was performed.

HP recommends using CI names in Universal CMDB that will be meaningful to 
you in PPM Center.
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Selecting CIs in Universal CMDB and Adding Them to a Request

To select the desired CIs in Universal CMDB to add to the request:

1. Log on to PPM Center.

2. From the menu bar, select Demand Management > Create a Request. 

3. Create a request using the request type that you modified to include the 
Universal CMDB Impact Analysis field group.

4. In the Universal CMDB Impact Analysis section of the new request, click 
Select Configuration Items. 

The CI selector applet from Universal CMDB launches, with Browse and 
Search tabs.
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5. Use the tabs to select the desired CIs for the request.

To use the Browse tab, select a view such as Network Topology from 
the View list.

Expand the view as desired. You can select multiple items in the tree by 
using Ctrl + click or Shift + click. 

To use the Search tab, complete the Search for field to limit the search 
results, and select a CI Type. 

6. Click OK to add the selected CIs to the request, under the Impacted 
Configuration Items heading in the Universal CMDB Impact Analysis 
section. The added CIs are shaded in color. Duplicate CIs are not added. 
CIs selected using the Search tab in the Universal CMDB applet do not 
show data for the View Name, View Type, View Tree Name, and View TQL 
Name columns, because the same CI can exist in multiple views.

If adding the CIs to the request would exceed the maximum number 
allowed by the UCMDB_MAC_CI_NUMBER parameter in the server.conf file, 
none of the selected CIs are added.
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When you select and add CIs in Universal CMDB to the PPM Center 
request, the CIs are never changed or deleted in Universal CMDB.

7. As necessary, click the Delete icon to the left of any CI you want to delete.

The Delete icon becomes an undo icon to allow you to undo the pending 
deletion.

8. After the desired CIs are listed in the request, click Submit (or Save for an 
existing request) to add the list of CIs to the request.
278 Appendix A



Generating Impact Analysis Reports

To generate an Impact Analysis Report for the CIs that have been added to a 
request:

1. Click the Launch HP Universal CMDB Impact Analysis button in the 
Universal CMDB Impact Analysis section of the request.

An Impact Analysis Report is generated in Universal CMDB.

2. Save the report in the desired format (for example, PDF or XML) at the 
desired file locations.

3. If desired, add the report to the request as a reference. To do so, in the 
Reference Additions section of the request, select the Attachment option in 
the New Reference field, click Add, and complete the Add Document 
dialog.

The Launch HP Release Control button or the Launch HP Change Control 
Management button appears if PPM Center is also integrated with HP Release 
Control or HP Change Control Management, as described in Chapter 8, 
Integration of PPM Center with Release Control or Change Control 
Management, on page 263.

If a request with a list of CIs is copied, the list of CIs is not copied to the new request.

The CIs in a request are available as part of standard Web services for a request. The 
token is REQ_VP_KNTA_UCMDB_CI_LIST. The value of the field represented by this 
token is a comma-separated list of CI IDs.
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adapter configuration files

PPM Center for bi-directional Service 
Manager or ServiceCenter integration, 
128

Remedy, 151
Service Manager, 113

B
bi-directional integration of PPM Center with 

Service Manager or ServiceCenter, 99
BMC Remedy integration with PPM Center

See Remedy: integration with PPM Center.

C
CCM

See Change Control Management.
Change Control Management

documentation, 30
integration with PPM Center, 26, 263

configuring, 264
using, 267

version supported for integration, 22
change management, ITIL

portlets, 69
adding, 69
MAC - My RFCs, 69
MAC - Open RFCs, 70
MAC - RFCs By Category, 71

MAC - RFCs By Reason for Change, 
72

MAC - RFCs By Status, 73
reports, 74

MAC - Change Summary Report, 74
MAC - Forward Schedule of Changes 

for RFC Report, 75
request types

MAC - Defect Template with Quality 
Center Integration, 192

MAC - Request For Change (RFC), 40
workflows

MAC - Change Migration workflow, 
68

MAC - Defect Template with Quality 
Center Integration workflow, 198

MAC - Request For Change workflow, 
49

CIs
See configuration items.

commands
special for integrations

See special commands: integrations 
using MAC.

configuration items
in Mercury Application Mapping, 169, 177
in Universal CMDB, 269, 275

configuring
contact user data for integrations using 

MAC, 33
CRT - Priority - Enabled validation for 

integrations using MAC, 35
281



integration of PPM Center with Change 
Control Management, 264

integration of PPM Center with Mercury 
Application Mapping, 172

integration of PPM Center with Quality 
Center, 203

integration of PPM Center with Release 
Control, 264

integration of PPM Center with Remedy, 
149

integration of PPM Center with Service 
Manager, 103

integration of PPM Center with 
ServiceCenter, 103

integration of PPM Center with Universal 
CMDB, 271

MAC-related entities in PPM Center, 33
PPM Center adapter file for bi-directional 

integration of PPM Center with Service 
Manager or ServiceCenter, 128

Remedy adapter file, 151
security groups for integrations using 

MAC, 36
Service Manager adapter file, 113
validation CRT - Priority - Enabled for 

integrations using MAC, 35
workflow security for integrations using 

MAC, 37
contact user data configuration for integrations 

using MAC, 33
CRT - Priority - Enabled validation 

configuration for integrations using MAC, 
35

D
documentation

related to integrations using MAC, 28

E
entities

MAC-related, 39

errors
logging for integration with Remedy, 165
logging for integration with Service 

Manager or ServiceCenter, 142
events

logging for integration with Remedy, 165
logging for integration with Service 

Manager or ServiceCenter, 142

H
hierarchy synchronization of Quality Center 

requirements with PPM Center requests, 
244

I
impact analysis

See Mercury Application Mapping.
See Universal CMDB.

installing
MAC

procedure, 32
system requirements, 31

integrating
PPM Center with Change Control 

Management using MAC
See Change Control Management: 

integration with PPM Center.
PPM Center with Mercury Application 

Mapping using MAC
See Mercury Application Mapping: 

integration with PPM Center.
PPM Center with Quality Center using 

MAC
See Quality Center: integration with 

PPM Center.
PPM Center with Release Control using 

MAC
See Release Control: integration with 

PPM Center.
PPM Center with Remedy using MAC

See Remedy: integration with PPM 
Center.
282



PPM Center with service desk applications 
using MAC
See service desk application integration 

with PPM Center.
PPM Center with Service Manager using 

MAC
See Service Manager: integration with 

PPM Center.
PPM Center with ServiceCenter using 

MAC
See ServiceCenter: integration with 

PPM Center.
PPM Center with Universal CMDB

See Universal CMDB: integration with 
PPM Center.

integration tool, PPM Center-Quality Center
See PPM Center-Quality Center Integration 

Tool.
integrations

with other products using MAC
See name of specific product that 

integrates with PPM Center.
ITIL Change Management, 17

See also change management, ITIL.
roles, 18

ITIL Release Management, 19
See also release management, ITIL.
roles, 20

K
kConfig.sh script, 140, 163, 175, 205, 228, 

264, 266, 271

L
logging

errors and events for Remedy integration, 
165

errors and events for Service Manager or 
ServiceCenter integration, 142

M
MAC, 13
MAC - Change Migration workflow, 68
MAC - Change Review and Approval Sub WF 

subworkflow, 56
MAC - Change Summary Report, 74
MAC - Defect Template with Quality Center 

Integration request type, 192
MAC - Defect Template with Quality Center 

Integration workflow, 198
MAC - Deploy and Test Changes Sub WF 

subworkflow, 63
MAC - Deployed Releases portlet, 88
MAC - Forward Schedule of Changes for RFC 

Report, 75
MAC - Forward Schedule of Releases Report, 

94
MAC - Impact & Resource Assessment Sub 

WF subworkflow, 58
MAC - Infrastructure Changes Sub WF 

subworkflow, 60
MAC - My Releases portlet, 89
MAC - My RFCs portlet, 69
MAC - Non Release Sub WF subworkflow, 65
MAC - Open Releases portlet, 90
MAC - Open RFCs portlet, 70
MAC - Plan Tests Sub WF subworkflow, 61
MAC - Release Content Report, 95
MAC - Release Distribution Sub WF 

subworkflow, 87
MAC - Release Distribution workflow, 87
MAC - Release Management request type, 77
MAC - Release Request workflow, 83
MAC - Release Sub WF subworkflow, 67
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MAC - Release Summary Report, 96
MAC - Releases By Category portlet, 91
MAC - Releases By Type portlet, 92
MAC - Releases portlet, 90
MAC - Request For Change (RFC) request 

type, 40
MAC - Request For Change workflow, 49
MAC - RFC - Urgent Change Management Sub 

WF subworkflow, 55
MAC - RFCs By Category portlet, 71
MAC - RFCs By Reason for Change portlet, 72
MAC - RFCs By Status portlet, 73
MAC - RFCs per Release portlet, 93
MAC integrations

See name of specific product that integrates 
with PPM Center.

MAM
See Mercury Application Mapping.

Managing Application Change
See MAC entries.

mapping of PPM Center and Quality Center 
fields, 191
creating, 213
defaults, 253
deploying, 225
managing, 229
Notes field in PPM Center, 224

Mercury Application Mapping
documentation, 29
integration with PPM Center, 24, 169

configuring, 172
using, 177

special commands for integration, 97
versions supported for integration, 21

N
Notes field in PPM Center, mapping to Quality 

Center, 224

P
portlets

change management, 69
MAC - Deployed Releases, 88
MAC - My Releases, 89
MAC - My RFCs, 69
MAC - Open Releases, 90
MAC - Open RFCs, 70
MAC - Releases, 90
MAC - Releases By Category, 91
MAC - Releases By Type, 92
MAC - RFCs By Category, 71
MAC - RFCs By Reason for Change, 72
MAC - RFCs By Status, 73
MAC - RFCs per Release, 93
modifying MAC-related, 40
release management, 87

PPM Center
documentation related to integrations using 

MAC, 28
integration with Change Control 

Management
See Change Control Management: 

integration with PPM Center.
integration with Mercury Application 

Mapping
See Mercury Application Mapping: 

integration with PPM Center.
integration with Quality Center

See Quality Center: integration with 
PPM Center.

integration with Release Control
See Release Control: integration with 

PPM Center.
integration with Remedy

See Remedy: integration with PPM 
Center.

integration with Service Manager
See Service Manager: integration with 

PPM Center.
integration with ServiceCenter

See ServiceCenter: integration with 
PPM Center.
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integration with Universal CMDB
See Universal CMDB: integration with 

PPM Center.
PPM Center adapter file for bi-directional 

Service Manager or ServiceCenter 
integration, configuring, 128

PPM Center-Quality Center Integration Tool, 
200, 204
creating a field mapping, 213
default field mappings, 253
deploying a field mapping, 225
enabling a Quality Center project for 

integration, 205
managing existing mappings, 229
version supported for integration, 22

priority validation configuration for 
integrations using MAC, 35

Q
QC

See Quality Center.
Quality Center

documentation, 30
enabling a project for integration with PPM 

Center, 205
integration with PPM Center, 25, 189

See also PPM Center-Quality Center 
Integration Tool.

configuring, 203
using, 237

special commands for integration, 97
synchronization of requirements hierarchy 

with PPM Center requests hierarchy, 
244

versions supported for integration, 22

R
Release Control

documentation, 30
integration with PPM Center, 26, 263

configuring, 264
using, 267

version supported for integration, 22

release management, ITIL
portlets, 87

adding, 87
MAC - Deployed Releases, 88
MAC - My Releases, 89
MAC - Open Releases, 90
MAC - Releases, 90
MAC - Releases By Category, 91
MAC - Releases By Type, 92
MAC - RFCs per Release, 93

reports, 93
MAC - Forward Schedule of Releases 

Report, 94
MAC - Release Content Report, 95
MAC - Release Summary Report, 96

request type
MAC - Release Management, 77

workflows
MAC - Release Distribution workflow, 

87
MAC - Release Request workflow, 83

Remedy
adapter file, configuring, 151
documentation, 29
integration with PPM Center, 22, 147

configuring, 149
logging of errors and events, 165
version supported for integration, 21

reports
change management, 74
MAC - Change Summary Report, 74
MAC - Forward Schedule of Changes for 

RFC Report, 75
MAC - Forward Schedule of Releases 

Report, 94
MAC - Release Content Report, 95
MAC - Release Summary Report, 96
modifying MAC-related, 40
release management, 93

Request For Change, 40
request hierarchy synchronization for 

integration of PPM Center with Quality 
Center, 244
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request types
MAC - Defect Template with Quality 

Center Integration, 192
MAC - Release Management, 77
MAC - Request For Change (RFC), 40
modifying MAC-related, 40

requirements, system
See system requirements.

RFC, 40
roles

ITIL Change Management, 18
ITIL Release Management, 20

S
scripts

kConfig.sh, 140, 163, 175, 205, 228, 264, 
266, 271

setServerMode.sh, 32, 37
security group configuration for integrations 

using MAC, 36
service desk application integration with PPM 

Center, 22
See also Remedy.
See also Service Manager.
See also ServiceCenter.

Service Manager
adapter file, configuring, 113
documentation, 28
integration with PPM Center, 22, 99

configuring, 103
logging of errors and events, 142
version supported for integration, 21

ServiceCenter
documentation, 28
integration with PPM Center, 22, 99

configuring, 103
logging of errors and events, 142
versions supported for integration, 21

setServerMode.sh script, 32, 37

special commands
integrations using MAC, 97

Mercury Application Mapping and 
PPM Center, 97

Quality Center and PPM Center, 97
modifying MAC-related, 40

stubs, Web services
generating for integration with Service 

Manager or ServiceCenter, 112
subworkflows

See workflows.
supported versions of products integrating with 

PPM Center, 20
system requirements

installing MAC, 31

U
Universal CMDB

documentation, 29
integration with PPM Center, 24, 269

configuring, 271
using, 275

version supported for integration, 21
Universal Configuration Management 

Database
See Universal CMDB.

V
validation configuration for integrations using 

MAC, 35
versions of products supported for integration 

with PPM Center, 20

W
Web services

stubs for integration with Service Manager 
or ServiceCenter, 112

workflow security configuration for 
integrations using MAC, 37
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workflows
MAC - Change Migration workflow, 68
MAC - Change Review and Approval Sub 

WF subworkflow, 56
MAC - Defect Template with Quality 

Center Integration workflow, 198
MAC - Deploy and Test Changes Sub WF 

subworkflow, 63
MAC - Impact & Resource Assessment 

Sub WF subworkflow, 58
MAC - Infrastructure Changes Sub WF 

subworkflow, 60
MAC - Non Release Sub WF subworkflow, 

65
MAC - Plan Tests Sub WF subworkflow, 

61
MAC - Release Distribution Sub WF 

subworkflow, 87
MAC - Release Distribution workflow, 87
MAC - Release Request workflow, 83
MAC - Release Sub WF subworkflow, 67
MAC - Request For Change workflow, 49
MAC - RFC - Urgent Change Management 

Sub WF subworkflow, 55
modifying MAC-related, 40
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